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END USER LICENSE AGREEMENT

READ THIS END USER LICENSE AGREEMENT (“AGREEMENT”) BEFORE DOWNLOADING, INSTALLING, OR USING THE SOFTWARE. BY DOWNLOADING,
INSTALLING, OR USING THE SOFTWARE OR OTHERWISE EXPRESSING YOUR AGREEMENT TO THE TERMS CONTAINED HEREIN, YOU (AS CUSTOMER
OR IF YOU ARE NOT THE CUSTOMER, AS A REPRESENTATIVE/AGENT AUTHORIZED TO BIND THE CUSTOMER) CONSENT TO BE BOUND BY THIS
AGREEMENT. IF YOU DO NOT OR CANNOT AGREE TO THE TERMS CONTAINED HEREIN, THEN (A) DO NOT DOWNLOAD, INSTALL, OR USE THE SOFTWARE,
AND (B) YOU MAY CONTACT JUNIPER NETWORKS REGARDING LICENSE TERMS.

1. The Parties. The parties to this Agreement are (i) Juniper Networks, Inc. (if the Customer’s principal office is located in the Americas) or Juniper Networks
(Cayman) Limited (if the Customer’s principal office is located outside the Americas) (such applicable entity being referred to herein as “Juniper”), and (ii)
the person or organization that originally purchased from Juniper or an authorized Juniper reseller the applicable license(s) for use of the Software (“Customer”)
(collectively, the “Parties”).

2. The Software. In this Agreement, “Software” means the program modules and features of the Juniper or Juniper-supplied software, for which Customer
has paid the applicable license or support fees to Juniper or an authorized Juniper reseller, or which was embedded by Juniper in equipment which Customer
purchased from Juniper or an authorized Juniper reseller. “Software” also includes updates, upgrades and new releases of such software. “Embedded
Software” means Software which Juniper has embedded in or loaded onto the Juniper equipment and any updates, upgrades, additions or replacements
which are subsequently embedded in or loaded onto the equipment.

3. License Grant. Subject to payment of the applicable fees and the limitations and restrictions set forth herein, Juniper grants to Customer a non-exclusive
and non-transferable license, without right to sublicense, to use the Software, in executable form only, subject to the following use restrictions:

a. Customer shall use Embedded Software solely as embedded in, and for execution on, Juniper equipment originally purchased by Customer from Juniper
or an authorized Juniper reseller.

b. Customer shall use the Software on a single hardware chassis having a single processing unit, or as many chassis or processing units for which Customer
has paid the applicable license fees; provided, however, with respect to the Steel-Belted Radius or Odyssey Access Client software only, Customer shall use
such Software on a single computer containing a single physical random access memory space and containing any number of processors. Use of the
Steel-Belted Radius or IMS AAA software on multiple computers or virtual machines (e.g., Solaris zones) requires multiple licenses, regardless of whether
such computers or virtualizations are physically contained on a single chassis.

c. Product purchase documents, paper or electronic user documentation, and/or the particular licenses purchased by Customer may specify limits to
Customer’s use of the Software. Such limits may restrict use to a maximum number of seats, registered endpoints, concurrent users, sessions, calls,
connections, subscribers, clusters, nodes, realms, devices, links, ports or transactions, or require the purchase of separate licenses to use particular features,
functionalities, services, applications, operations, or capabilities, or provide throughput, performance, configuration, bandwidth, interface, processing,
temporal, or geographical limits. In addition, such limits may restrict the use of the Software to managing certain kinds of networks or require the Software
to be used only in conjunction with other specific Software. Customer’s use of the Software shall be subject to all such limitations and purchase of all applicable
licenses.

d. For any trial copy of the Software, Customer’s right to use the Software expires 30 days after download, installation or use of the Software. Customer
may operate the Software after the 30-day trial period only if Customer pays for a license to do so. Customer may not extend or create an additional trial
period by re-installing the Software after the 30-day trial period.

e. The Global Enterprise Edition of the Steel-Belted Radius software may be used by Customer only to manage access to Customer’s enterprise network.
Specifically, service provider customers are expressly prohibited from using the Global Enterprise Edition of the Steel-Belted Radius software to support any
commercial network access services.

The foregoing license is not transferable or assignable by Customer. No license is granted herein to any user who did not originally purchase the applicable
license(s) for the Software from Juniper or an authorized Juniper reseller.

4. Use Prohibitions. Notwithstanding the foregoing, the license provided herein does not permit the Customer to, and Customer agrees not to and shall
not: (a) modify, unbundle, reverse engineer, or create derivative works based on the Software; (b) make unauthorized copies of the Software (except as
necessary for backup purposes); (c) rent, sell, transfer, or grant any rights in and to any copy of the Software, in any form, to any third party; (d) remove
any proprietary notices, labels, or marks on or in any copy of the Software or any product in which the Software is embedded; (e) distribute any copy of
the Software to any third party, including as may be embedded in Juniper equipment sold in the secondhand market; (f) use any ‘locked’ or key-restricted
feature, function, service, application, operation, or capability without first purchasing the applicable license(s) and obtaining a valid key from Juniper, even
if such feature, function, service, application, operation, or capability is enabled without a key; (g) distribute any key for the Software provided by Juniper
to any third party; (h) use the Software in any manner that extends or is broader than the uses purchased by Customer from Juniper or an authorized Juniper
reseller; (i) use Embedded Software on non-Juniper equipment; (j) use Embedded Software (or make it available for use) on Juniper equipment that the
Customer did not originally purchase from Juniper or an authorized Juniper reseller; (k) disclose the results of testing or benchmarking of the Software to
any third party without the prior written consent of Juniper; or (l) use the Software in any manner other than as expressly provided herein.

5. Audit. Customer shall maintain accurate records as necessary to verify compliance with this Agreement. Upon request by Juniper, Customer shall furnish
such records to Juniper and certify its compliance with this Agreement.
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6. Confidentiality. The Parties agree that aspects of the Software and associated documentation are the confidential property of Juniper. As such, Customer
shall exercise all reasonable commercial efforts to maintain the Software and associated documentation in confidence, which at a minimum includes
restricting access to the Software to Customer employees and contractors having a need to use the Software for Customer’s internal business purposes.

7. Ownership. Juniper and Juniper’s licensors, respectively, retain ownership of all right, title, and interest (including copyright) in and to the Software,
associated documentation, and all copies of the Software. Nothing in this Agreement constitutes a transfer or conveyance of any right, title, or interest in
the Software or associated documentation, or a sale of the Software, associated documentation, or copies of the Software.

8. Warranty, Limitation of Liability, Disclaimer of Warranty. The warranty applicable to the Software shall be as set forth in the warranty statement that
accompanies the Software (the “Warranty Statement”). Nothing in this Agreement shall give rise to any obligation to support the Software. Support services
may be purchased separately. Any such support shall be governed by a separate, written support services agreement. TO THE MAXIMUM EXTENT PERMITTED
BY LAW, JUNIPER SHALL NOT BE LIABLE FOR ANY LOST PROFITS, LOSS OF DATA, OR COSTS OR PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES,
OR FOR ANY SPECIAL, INDIRECT, OR CONSEQUENTIAL DAMAGES ARISING OUT OF THIS AGREEMENT, THE SOFTWARE, OR ANY JUNIPER OR
JUNIPER-SUPPLIED SOFTWARE. IN NO EVENT SHALL JUNIPER BE LIABLE FOR DAMAGES ARISING FROM UNAUTHORIZED OR IMPROPER USE OF ANY
JUNIPER OR JUNIPER-SUPPLIED SOFTWARE. EXCEPT AS EXPRESSLY PROVIDED IN THE WARRANTY STATEMENT TO THE EXTENT PERMITTED BY LAW,
JUNIPER DISCLAIMS ANY AND ALL WARRANTIES IN AND TO THE SOFTWARE (WHETHER EXPRESS, IMPLIED, STATUTORY, OR OTHERWISE), INCLUDING
ANY IMPLIED WARRANTY OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, OR NONINFRINGEMENT. IN NO EVENT DOES JUNIPER
WARRANT THAT THE SOFTWARE, OR ANY EQUIPMENT OR NETWORK RUNNING THE SOFTWARE, WILL OPERATE WITHOUT ERROR OR INTERRUPTION,
OR WILL BE FREE OF VULNERABILITY TO INTRUSION OR ATTACK. In no event shall Juniper’s or its suppliers’ or licensors’ liability to Customer, whether
in contract, tort (including negligence), breach of warranty, or otherwise, exceed the price paid by Customer for the Software that gave rise to the claim, or
if the Software is embedded in another Juniper product, the price paid by Customer for such other product. Customer acknowledges and agrees that Juniper
has set its prices and entered into this Agreement in reliance upon the disclaimers of warranty and the limitations of liability set forth herein, that the same
reflect an allocation of risk between the Parties (including the risk that a contract remedy may fail of its essential purpose and cause consequential loss),
and that the same form an essential basis of the bargain between the Parties.

9. Termination. Any breach of this Agreement or failure by Customer to pay any applicable fees due shall result in automatic termination of the license
granted herein. Upon such termination, Customer shall destroy or return to Juniper all copies of the Software and related documentation in Customer’s
possession or control.

10. Taxes. All license fees payable under this agreement are exclusive of tax. Customer shall be responsible for paying Taxes arising from the purchase of
the license, or importation or use of the Software. If applicable, valid exemption documentation for each taxing jurisdiction shall be provided to Juniper prior
to invoicing, and Customer shall promptly notify Juniper if their exemption is revoked or modified. All payments made by Customer shall be net of any
applicable withholding tax. Customer will provide reasonable assistance to Juniper in connection with such withholding taxes by promptly: providing Juniper
with valid tax receipts and other required documentation showing Customer’s payment of any withholding taxes; completing appropriate applications that
would reduce the amount of withholding tax to be paid; and notifying and assisting Juniper in any audit or tax proceeding related to transactions hereunder.
Customer shall comply with all applicable tax laws and regulations, and Customer will promptly pay or reimburse Juniper for all costs and damages related
to any liability incurred by Juniper as a result of Customer’s non-compliance or delay with its responsibilities herein. Customer’s obligations under this
Section shall survive termination or expiration of this Agreement.

11. Export. Customer agrees to comply with all applicable export laws and restrictions and regulations of any United States and any applicable foreign
agency or authority, and not to export or re-export the Software or any direct product thereof in violation of any such restrictions, laws or regulations, or
without all necessary approvals. Customer shall be liable for any such violations. The version of the Software supplied to Customer may contain encryption
or other capabilities restricting Customer’s ability to export the Software without an export license.

12. Commercial Computer Software. The Software is “commercial computer software” and is provided with restricted rights. Use, duplication, or disclosure
by the United States government is subject to restrictions set forth in this Agreement and as provided in DFARS 227.7201 through 227.7202-4, FAR 12.212,
FAR 27.405(b)(2), FAR 52.227-19, or FAR 52.227-14(ALT III) as applicable.

13. Interface Information. To the extent required by applicable law, and at Customer's written request, Juniper shall provide Customer with the interface
information needed to achieve interoperability between the Software and another independently created program, on payment of applicable fee, if any.
Customer shall observe strict obligations of confidentiality with respect to such information and shall use such information in compliance with any applicable
terms and conditions upon which Juniper makes such information available.

14. Third Party Software. Any licensor of Juniper whose software is embedded in the Software and any supplier of Juniper whose products or technology
are embedded in (or services are accessed by) the Software shall be a third party beneficiary with respect to this Agreement, and such licensor or vendor
shall have the right to enforce this Agreement in its own name as if it were Juniper. In addition, certain third party software may be provided with the
Software and is subject to the accompanying license(s), if any, of its respective owner(s). To the extent portions of the Software are distributed under and
subject to open source licenses obligating Juniper to make the source code for such portions publicly available (such as the GNU General Public License
(“GPL”) or the GNU Library General Public License (“LGPL”)), Juniper will make such source code portions (including Juniper modifications, as appropriate)
available upon request for a period of up to three years from the date of distribution. Such request can be made in writing to Juniper Networks, Inc., 1194
N. Mathilda Ave., Sunnyvale, CA 94089, ATTN: General Counsel. You may obtain a copy of the GPL at http://www.gnu.org/licenses/gpl.html, and
a copy of the LGPL at http://www.gnu.org/licenses/lgpl.html.

15. Miscellaneous. This Agreement shall be governed by the laws of the State of California without reference to its conflicts of laws principles. The provisions
of the U.N. Convention for the International Sale of Goods shall not apply to this Agreement. For any disputes arising under this Agreement, the Parties
hereby consent to the personal and exclusive jurisdiction of, and venue in, the state and federal courts within Santa Clara County, California. This Agreement
constitutes the entire and sole agreement between Juniper and the Customer with respect to the Software, and supersedes all prior and contemporaneous
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agreements relating to the Software, whether oral or written (including any inconsistent terms contained in a purchase order), except that the terms of a
separate written agreement executed by an authorized Juniper representative and Customer shall govern to the extent such terms are inconsistent or conflict
with terms contained herein. No modification to this Agreement nor any waiver of any rights hereunder shall be effective unless expressly assented to in
writing by the party to be charged. If any portion of this Agreement is held invalid, the Parties agree that such invalidity shall not affect the validity of the
remainder of this Agreement. This Agreement and associated documentation has been written in the English language, and the Parties agree that the English
version will govern. (For Canada: Les parties aux présentés confirment leur volonté que cette convention de même que tous les documents y compris tout
avis qui s'y rattaché, soient redigés en langue anglaise. (Translation: The parties confirm that this Agreement and all related documentation is and will be
in the English language)).
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Preface

■ Objectives on page xix

■ Audience on page xix

■ Documentation Conventions on page xix

■ Related Documentation on page xxi

■ Requesting Technical Support on page xxii

Objectives

This guide explains and provides examples of Juniper Networks IDP Series Intrusion
Detection and Prevention Appliance features.

For complete procedures for implementing IDP features and monitoring security
events, see the IDP Administration Guide.

For details on using Juniper Networks Network and Security Manager (NSM) user
interface features, see the NSM documentation.

Audience

This guide is intended for network administrators who are familiar with TCP/IP
networks and network security issues.

Documentation Conventions

This section provides all the documentation conventions that are followed in this
guide. Table 1 on page xx defines notice icons used in this guide.
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Table 1: Notice Icons

DescriptionMeaningIcon

Indicates important features or instructions.Informational note

Indicates a situation that might result in loss of data or hardware damage.Caution

Alerts you to the risk of personal injury or death.Warning

Alerts you to the risk of personal injury from a laser.Laser warning

Table 2 on page xx defines text conventions used in this guide.

Table 2: Text Conventions

ExamplesDescriptionConvention

■ Issue the clock source command.

■ Specify the keyword exp-msg.

■ Click User Objects

■ Represents commands and keywords
in text.

■ Represents keywords

■ Represents UI elements

Bold typeface like this

user inputRepresents text that the user must type.Bold typeface like this

host1# 
show ip ospf
Routing Process OSPF 2 with Router
 ID 5.5.0.250
Router is an area Border Router 
(ABR)

Represents information as displayed on
the terminal screen.

fixed-width font

Ctrl + dIndicates that you must press two or more
keys simultaneously.

Key names linked with a plus (+)
sign

■ The product supports two levels of
access, user and privileged.

■ clusterID, ipAddress.

■ Emphasizes words

■ Identifies variables

Italics

Object Manager > User Objects > Local
Objects

Indicates navigation paths through the UI
by clicking menu options and links.

The angle bracket (>)

Table 3 on page xxi defines syntax conventions used in this guide.
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Table 3: Syntax Conventions

ExamplesDescriptionConvention

terminal lengthRepresent keywordsWords in plain text

mask, accessListNameRepresent variablesWords in italics

diagnostic | lineRepresent a choice to select one keyword or
variable to the left or right of this symbol. The
keyword or variable can be optional or
required.

Words separated by the pipe ( | )
symbol

[ internal | external ]Represent optional keywords or variables.Words enclosed in brackets ( [ ] )

[ level1 | level2 | 11 ]*Represent optional keywords or variables that
can be entered more than once.

Words enclosed in brackets followed
by and asterisk ( [ ]*)

{ permit | deny } { in | out } {
clusterId | ipAddress }

Represent required keywords or variables.Words enclosed in braces ( { } )

Related Documentation

Table 4 on page xxi lists related IDP documentation.

Table 4: Related IDP Documentation

DescriptionDocument

Contains information about what is included in a specific product release:
supported features, unsupported features, changed features, known problems,
and resolved problems. If the information in the release notes differs from
the information found in the documentation set, follow the release notes.

Release notes

Provides instructions for installing, configuring, updating, and servicing the
IDP Series appliances.

■ IDP Installation Guide: IDP200, IDP600,
IDP1100

■ IDP75 Installation Guide

■ IDP250 Installation Guide

■ IDP800 Installation Guide

■ IDP8200 Installation Guide

Provides procedures for implementing and using IDP features.IDP Administration Guide

A collection of topics from the IDP Administration Guide and IDP Concepts and
Examples Guide, in HTML.

IDP Series Pathway Pages

Provides examples and reference information for creating custom attack
objects.

IDP Custom Attack Objects Reference and
Examples Guide

Describes how to use IDP Reporter.IDP Reporter User’s Guide

Table 4 on page xxi lists related NSM documentation.
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Table 5: Related NSM Documentation

DescriptionDocument

Provides information about new features, changed features, fixed problems,
and known issues with the NSM release.

Network and Security Manager release notes

Describes how to install the NSM management system on a single server or
on separate servers. It also includes information on how to install and run
the NSM user interface. This guide is intended for IT administrators responsible
for the installation and/or upgrade to NSM.

Network and Security Manager Installation Guide

Describes how to configure and manage IDP devices using NSM. This guide
also helps in understanding of how to configure basic and advanced NSM
functionality, including adding new devices, deploying new device
configurations, updating device firmware, viewing log information, and
monitoring the status of IDP devices.

Network and Security Manager Configuring
Intrusion Detection and Prevention Devices Guide

Describes how to use and configure key management features in the NSM.
It provides conceptual information, suggested workflows, and examples where
applicable. This guide is best used in conjunction with the NSM Online Help,
which provides step-by-step instructions for performing management tasks
in the NSM UI.

This guide is intended for application administrators or those individuals
responsible for owning the server and security infrastructure and configuring
the product for multi-user systems. It is also intended for device configuration
administrators, firewall and VPN administrators, and network security
operation center administrators.

Network and Security Manager Administration
Guide

Provides task-oriented procedures describing how to perform basic tasks in
the NSM user interface. It also includes a brief overview of the NSM system
and a description of the GUI elements.

Network and Security Manager Online Help

Requesting Technical Support

Technical product support is available through the Juniper Networks Technical
Assistance Center (JTAC). If you are a customer with an active J-Care or JNASC support
contract, or are covered under warranty, and need post-sales technical support, you
can access our tools and resources online or open a case with JTAC.

■ JTAC policies—For a complete understanding of our JTAC procedures and policies,
review the JTAC User Guide located at
http://www.juniper.net/customers/support/downloads/710059.pdf.

■ Product warranties—For product warranty information, visit
http://www.juniper.net/support/warranty/.

■ JTAC Hours of Operation —The JTAC centers have resources available 24 hours
a day, 7 days a week, 365 days a year.

Self-Help Online Tools and Resources

For quick and easy problem resolution, Juniper Networks has designed an online
self-service portal called the Customer Support Center (CSC) that provides you with
the following features:
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■ Find CSC offerings: http://www.juniper.net/customers/support/

■ Search for known bugs: http://www2.juniper.net/kb/

■ Find product documentation: http://www.juniper.net/techpubs/

■ Find solutions and answer questions using our Knowledge Base:
http://kb.juniper.net/

■ Download the latest versions of software and review release notes:
http://www.juniper.net/customers/csc/software/

■ Search technical bulletins for relevant hardware and software notifications:
https://www.juniper.net/alerts/

■ Join and participate in the Juniper Networks Community Forum:
http://www.juniper.net/company/communities/

■ Open a case online in the CSC Case Management tool: http://www.juniper.net/cm/

To verify service entitlement by product serial number, use our Serial Number
Entitlement (SNE) Tool located at https://tools.juniper.net/SerialNumberEntitlementSearch/.

Opening a Case with JTAC

You can open a case with JTAC on the Web or by telephone.

■ Use the Case Management tool in the CSC at http://www.juniper.net/cm/ .

■ Call 1-888-314-JTAC (1-888-314-5822 toll-free in the USA, Canada, and Mexico).

For international or direct-dial options in countries without toll-free numbers, see
http://www.juniper.net/support/requesting support.html
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Part 1

Solution Overview

■ IDP Series Product Overview on page 3

■ IDP Series Components Overview on page 7

■ IDP Series Deployment Mode Overview on page 19

Solution Overview ■ 1
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Chapter 1

IDP Series Product Overview

This chapter provides an overview of the intrusion detection and prevention (IDP)
standalone solution and provides a documentation map of IDP features to IDP
documentation sources. It includes the following topics:

■ Juniper Networks IDP Solutions on page 3

■ IDP Series Features Overview on page 3

Juniper Networks IDP Solutions

Juniper Networks provides intrusion detection services and intrusion detection and
prevention (IDP) technology in the following product families:

■ Juniper Networks IDP Series Intrusion Detection and Prevention Appliances

■ Juniper Networks ISG Series Integrated Security Gateways

■ Juniper Networks SRX Series Services Gateways

This guide describes the IDP Series appliances.

Related Topics The following related topic is included in the IDP Concepts and Examples Guide:

■ IDP Series Features Overview on page 3

IDP Series Features Overview

Table 6 on page 3 briefly describes features of the standalone Juniper Networks
IDP Series Intrusion Detection and Prevention Appliances.

Table 6: IDP Features

DocumentationDescriptionFeature

Attack Detection and Prevention

■ Using Application Identification on
page 96

The application identification feature is used in the
IDP rulebase and APE rulebase. The application
identification feature parses protocol, context, and
signature data to identify applications on any port.

Application identification

Juniper Networks IDP Solutions ■ 3



Table 6: IDP Features (continued)

DocumentationDescriptionFeature

■ Understanding the APE Rulebase
on page 117

The application policy enforcement (APE) rulebase
enables you to set limits on available bandwidth
for applications and/or user roles you specify.

Application policy
enforcement

■ Application Volume Tracking
Overview on page 43

The application volume tracking (AVT) feature
leverages Profiler functionality to collect statistics
about application usage over the network.

Application volume tracking

■ User-Role-Based Policy Feature
Overview on page 94

When integrated with Juniper Networks IC Series
Unified Access Control (UAC) appliance, the IDP
Series appliance supports security policy rules
based on UAC user roles. This feature enables you
to more easily configure focused rules to
implement your business security policy.

User role-based policies

See Table 7 on page 5 for a description
of detection methods.

The IDP Series uses eight methods to detect
malicious traffic.

Multimethod attack detection

■ J-Security Center Updates Overview
on page 17

Juniper Networks Security Center (J-Security Center)
provides a robust protocol detection engine that
can decode more than 60 protocols and analyze
and enforce proper usage in more than 500
contexts.

Protocol decoding

■ J-Security Center Updates Overview
on page 17

J-Security Center attack updates provide same-day
coverage for newly found vulnerabilities.

The J-Security Center attack database includes more
than 5500 signatures for identifying anomalies,
attacks, spyware, and applications.

Zero-day protection

■ Using the Recommended Security
Policy on page 87

■ Using Attack Objects on page 97

J-Security Center provides a robust default security
policy (called Recommended) and a comprehensive
set of predefined attack objects (including those
flagged as Recommended for various categories of
attacks).

Recommended security policy
and predefined attack objects

■ Understanding the Components of
an IDP Security Policy on page 81

■ Using Attack Objects on page 97

If you choose, you can use the default security
policy or other predefined templates as a basis for
your own user-defined security policy.

Similarly, you can use the predefined attack objects
as a basis for your own user-defined attack objects.

User-defined security policies
and attack objects

■ Understanding IDP Rulebase
Actions on page 100

J-Security Center attack objects are coded with
recommended actions to take on the instant
session, including drop packet, drop connection,
close client, close server, and close client/server.
You can rely on these or set your own.

In addition, when the IDP appliance detects an
attack from a particular IP address, it can block
connections from the IP address for a configurable
duration of time.

Active response methods
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Table 6: IDP Features (continued)

DocumentationDescriptionFeature

■ Understanding IDP Rulebase
Notification Options on page 103

The IDP Series supports several passive responses,
including logging and TCP reset.

Passive response methods

■ Inspection of SSL Traffic Overview
on page 165

■ Inspection of GRE Traffic Overview
on page 163

■ Inspection of GTP Traffic Overview
on page 163

■ Inspection of IPsec VPN Traffic
Overview on page 164

■ Inspection of MPLS Traffic
Overview on page 164

The IDP Series can decapsulate or decrypt and
inspect the payload of SSL, GRE, GTP, IPsec ESP
NULL, and MPLS traffic.

Traffic decryption and
decapsulation

■ Profiler Overview on page 27The Profiler captures accurate and granular detail
of your network traffic over time.

Network profiling

■ IDP Logs Overview on page 51

■ NSM Reports Overview on page 75

■ IDP Reporter Overview on page 77

The IDP Series includes useful predefined log views
and reports and enables you to create custom
views and reports.

Robust logging, reporting, and
notification

■ Centralized Management with NSM
Overview on page 16

The IDP Series is compatible with Juniper Networks
Network and Security Manager (NSM).

Centralized management

■ Coordinated Threat Control
Overview on page 177

The IDP Series is compatible with Juniper Networks
SA Series SSL VPN appliances and IC Series devices.

Coordinated threat control

■ Internal Bypass on page 13

■ External Bypass on page 14

■ Flow Bypass Feature on page 9

You can configure network interfaces to enter a
bypass state in case of failure or graceful shutdown,
or if the JNET driver encounters problems
processing packets.

The IDP Series also supports flow bypass to forward
traffic when traffic exceeds IDP session capacity.

Bypass

■ Auto-Recovery Feature on page 9If an IDP process engine experiences failure, the
IDP appliance buffers the next packets in the flow
and restarts the process engine.

Auto-recovery

Table 7 on page 5 briefly describes IDP detection methods and provides a reference
to detailed information.

Table 7: Intrusion Detection Methods

DocumentationDescriptionFeature

■ Understanding the IDP Rulebase
on page 91

■ Using Attack Objects on page 97

The IDP rulebase attack object signatures are
bound to protocol context. As a result, this
detection method produces few false positives.

Stateful signature

IDP Series Features Overview ■ 5
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Table 7: Intrusion Detection Methods (continued)

DocumentationDescriptionFeature

■ Understanding the IDP Rulebase
on page 91

■ Using Attack Objects on page 97

The IDP rulebase attack objects detect protocol
usages that violate published RFCs. This method
protects your network from undiscovered
vulnerabilities.

Protocol anomaly

■ Understanding the Traffic
Anomalies Rulebase on page 141

The Traffic Anomalies rulebase uses heuristic rules
to detect unexpected traffic patterns that might
indicate reconnaissance or attacks. This method
blocks distributed denial-of-service (DDoS) attacks
and prevents reconnaissance activities.

Traffic anomaly

■ Understanding the Backdoor
Rulebase on page 127

The Backdoor rulebase uses heuristic-based
anomalous traffic patterns and packet analysis to
detect Trojans and rootkits. These methods prevent
proliferation of malware in case other security
measures have been compromised.

Backdoor

■ IP Spoof Attack Prevention
Overview on page 159

The IDP appliance checks the validity of allowed
addresses inside and outside the network,
permitting only authentic traffic and blocking
traffic with a disguised source.

IP spoofing

■ Understanding the SYN Protector
Rulebase on page 135

The SYN Protector rulebase provides two,
alternative methods to prevent SYN-flood attacks.

Denial of service (DoS)

■ Understanding the Network
Honeypot Rulebase on page 147

The IDP appliance impersonates vulnerable ports
so you can track attacker reconnaissance activity.

Network honeypot

Related Topics The following additional related topic is included in the IDP Concepts and Examples
Guide:

■ Juniper Networks IDP Solutions on page 3
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Chapter 2

IDP Series Components Overview

This chapter provides an overview of IDP Series components. It includes the following
topics:

■ IDP Series Operating System Overview on page 7

■ IDP Series Network Interfaces Overview on page 11

■ Centralized Management with NSM Overview on page 16

■ J-Security Center Updates Overview on page 17

IDP Series Operating System Overview

The following topics explain the features of the IDP Series operating system:

■ IDP Series Multicore Architecture on page 7

■ Auto-Recovery Feature on page 9

■ Flow Bypass Feature on page 9

■ Key Processes on page 10

IDP Series Multicore Architecture

The IDP Series operating system separates control plane and data plane processes,
making the IDP Series appliances resilient to periods of heavy load, such as a
denial-of-service attack (DoS attack) or distributed denial-of-service attack (DDoS
attack). In high-end models, control plane and data plane processes run on separate
CPU, bolstering resiliency and performance. Figure 1 on page 8 shows the processes
that run on each core CPU for IDP Series models.

IDP Series Operating System Overview ■ 7



Figure 1: IDP Multicore Architecture

Table 8 on page 8 describes how CPUs are dedicated on IDP Series models.

Table 8: IDP Multicore Architecture

Multicore ArchitectureModel

The IDP8200 appliance has eight core CPUs:

■ One CPU is dedicated to control plane processes, including configuration and logging processes.

■ One CPU is dedicated to the JNET driver processes, which handle traffic transmission and
buffering. The JNET driver runs in polling mode.

■ The remaining CPUs are dedicated to data plane processes, including the IDP engine processes
that inspect traffic and take action against attacks.

NOTE: When you use the scio or sctop utilities to monitor IDP processes, you can specify the -c CPU
option to display statistics related to processing on a particular IDP engine. For example, to display
CPU utilization for CPU 2, the syntax is scio -c 2 idp-cpu-utilization. Without the -c option, scio displays
an aggregate for all IDP engines.

IDP8200

8 ■ IDP Series Operating System Overview
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Table 8: IDP Multicore Architecture (continued)

Multicore ArchitectureModel

The IDP1100, IDP800, and IDP250 appliances have two core CPUs:

■ One CPU is used for both control plane and JNET driver processes. The JNET driver runs in NAPI
mode: when traffic is low, the JNET driver operates in interrupt mode; when traffic is high, the
JNET driver switches to polling mode.

■ The second CPU is dedicated to data plane processes.

IDP1100, IDP800,
IDP250

The IDP600, IDP200, and IDP75 appliances have one core CPU. The JNET driver runs in NAPI mode:
when traffic is low, the JNET driver operates in interrupt mode; when traffic is high, the JNET driver
switches to polling mode.

IDP600, IDP200,
IDP75

Auto-Recovery Feature

The auto-recovery feature monitors the status of individual IDP engines. In the event
an IDP engine is terminated, the auto-recovery daemon logs the event, attempts to
restart the IDP engine, and logs recovery. The auto-recovery feature is enabled by
default.

The auto-recovery feature bolsters resiliency of IDP Series appliances by enabling
restart per IDP engine. In case of failure by an IDP engine, the other IDP engines in
the data plane do not need to be restarted. If an IDP engine becomes overloaded or
terminates, the JNET driver buffers packets for the active sessions while the IDP
engine restarts. If the IDP engine does not restart after six attempts, IDP may enter
internal bypass (if enabled).

The auto-recovery feature is complemented by the bypass under congestion feature.
When the IDP engine recovers, it processes the buffered packets. If the buffer becomes
large enough, it triggers bypass under congestion instead of resulting in subsequent
failure.

NOTE: The auto-recovery process ensures the IDP engine restarts with the same
device configuration, feature configuration, and security policy that were in place
before the restart. However, because the application identification feature uses the
first packets of a session as a key to determining the application, the auto-recovery
process cannot reliably identify the application for buffered sessions. As a result, in
processing buffered traffic, the application identification feature is unavailable and
application rate limiting cannot be applied. In addition, the latest interval of application
volume tracking data is discarded.

Flow Bypass Feature

The flow bypass feature prevents the IDP appliance from becoming a point of failure
when the network is congested. With flow bypass enabled, when the IDP system
packet receive queue reaches a rising threshold that you specify, the IDP engine
marks the flow as a bypass flow and passes it through, uninspected. The IDP appliance
passes through subsequent flows until the IDP system receive queue falls below a
reset threshold that you also specify. On IDP8200, which has multiple IDP engines,
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the flow bypass feature operates per IDP engine; that is, when the IDP packet receive
queue for an individual IDP engine reaches its rising threshold, the individual IDP
engine takes the flow bypass action and other IDP engines continue to inspect flows.

The flow bypass feature is disabled by default. It is intended for use in networks that
prioritize availability over security.

For procedures for enabling the flow bypass feature, configuring its thresholds, and
monitoring the feature, see the IDP Administration Guide.

Key Processes

Table 9 on page 10 describes the key processes.

Table 9: Processes

DescriptionProcess

Manages communication between the IDP appliance and Network and Security Manager.agent

Performs packet processing, including decapsulation or decryption, defragmentation, reassembly,
inspection, and rule actions.

idpengine

Generates SNMP alerts when thresholds are crossed for tracked resources on the device. Responds
to SNMP poll requests. Resources are CPU, memory, hard disk space, and session count.

idpHMD

Gathers logs generated by idpengine and stores the information in a local log database. The agent
process forwards the data to NSM, where you can view records.

idpLogReader

Inspects SSL traffic, if SSL inspection is turned on.pkid

Gathers information about hosts and applications in your network. Profiler stores the information
in the Profiler database. The agent process forwards the data to NSM, where you can view records.

profiler

Handles policy push, information retrieval, Profiler status, and so on.sciod

Used by the standalone high availability feature. The standalone high availability feature is not
supported in IDP 5.0.

shad

Related Topics The following related topic is included in the IDP Concepts and Examples Guide:

■ IDP Series Network Interfaces Overview on page 11

The following related topics are included in the IDP Administration Guide:

■ Viewing Auto-Recovery Logs

■ Enabling the Flow Bypass Feature
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IDP Series Network Interfaces Overview

In Figure 2 on page 11, eth0, eth1, eth2, eth3, and so forth are the IDP network
interfaces.

Figure 2: IDP Network Interfaces

The following topics explain the features of these network interfaces:

■ Management Interface (eth0) on page 12

■ High Availability Interface (eth1) on page 12

■ Traffic Interfaces on page 12

■ Internal Bypass on page 13

■ External Bypass on page 14

■ Peer Port Modulation on page 15

IDP Series Network Interfaces Overview ■ 11
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Management Interface (eth0)

In Figure 2 on page 11, eth0 is a dedicated management interface used for
communication with Network and Security Manager (NSM). The agent process is a
control plane process. It manages communication between the IDP appliance and
NSM. The agent process handles the following functionality:

■ Device configuration–You set part of the active configuration with the Appliance
Configuration Manager (ACM), part with the CLI, and part with NSM. The agent
process pushes changes you make from NSM to the IDP device.

■ Security policy–You configure policies with NSM. You push a single policy to the
IDP appliance to be installed and used by the IDP process engines. The installed
policy is the policy used to determine which traffic the IDP process inspects,
what to look for, and what actions to take.

■ Detector engine–The IDP detector engine is a code base that contains the
application signatures and protocol decoder definitions used by the IDP process
engines in packet analysis. J-Security Center periodically updates the IDP detector
engine. In Figure 2 on page 11, note the process flow: first, you download updates
from J-Security Center to NSM; then, you push updates from NSM to IDP
appliances.

■ Attack database–The attack database includes the attack objects used by the IDP
rulebase to match attack signatures and protocol anomalies. J-Security Center
updates predefined attack object definitions as often as necessary to provide
zero-day coverage. As with detector engine updates, you download them from
J-Security Center to NSM and then push them from NSM to the IDP appliance.

■ Logging–The IDP process engines generate logs and packet captures related to
security policy and application policy enforcement rules. The Profiler generates
profiling and application volume logs. The agent process sends these logs to NSM
so you can use NSM monitoring features to monitor security events and
application usage.

High Availability Interface (eth1)

In Figure 2 on page 11, eth1 is a dedicated high availability (HA) interface used for
sync-state communication with a cluster peer in a high availability deployment. The
shad process monitors the availability of the IDP node for HA purposes.

NOTE: High availability is not supported in the IDP 5.0 release.

Traffic Interfaces

In Figure 2 on page 11, eth2, eth3, and so forth are the network interfaces you
connect to the network devices that route traffic in your network.

12 ■ IDP Series Network Interfaces Overview
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The IDP Series implements the following abstract objects to manage network
interfaces:

■ Virtual circuit—A virtual circuit corresponds with the physical interface. For
example, physical interface eth2 is a virtual circuit. You use the Appliance
Configuration Manager (ACM) to configure speed and duplex, as well as optional
interface alias settings for each interface.

■ Virtual router—A virtual router contains a logical pair of virtual circuits. For
example, virtual router vr0 contains eth2 and eth3. In transparent mode, traffic
arrives in one interface and is forwarded through the other. You use ACM to
configure the deployment mode (sniffer or transparent) and bypass options
(internal, external, or off) for each virtual router. You can use the command-line
interface to display information and status for each virtual router, including
Address Resolution Protocol (ARP) and media access control (MAC) tables.

■ Subscriber—A single subscriber named s0 contains all virtual routers. The
subscriber maintains process and status of all traffic that flows through the device.
You can use the command-line interface to view information and status
maintained by subscriber s0. We test and support only configurations where the
default subscriber is used.

Internal Bypass

Physical interfaces are network interface cards (NICs). If your network security policy
privileges availability over security, you can configure the interfaces to enter an
internal bypass state in the event of failure or graceful shutdown. Internal bypass is
also triggered when the JNET driver is in a state where it cannot receive packets.

In internal bypass, physical interfaces join mechanically to form a circuit that bypasses
IDP processing. For example, if you configure internal bypass for vr0, and the IDP
appliance encounters failure or is shut down, eth2 and eth3 join to form a circuit
that avoids the IDP engine and forwards the traffic to the next network hop.

Internal bypass operates through a timing mechanism. When enabled, the timer on
traffic interfaces counts down to a bypass trigger point. When the IDP appliance is
turned on and available, it sends a reset signal to the traffic interface timer so that
it does not reach the bypass trigger point. If the IDP operating system encounters
failure, then it fails to send the reset signal, the timer counts down to the trigger
point, and the traffic interfaces enter a bypass state. If the IDP appliance is shut down
gracefully, the traffic interfaces immediately enter bypass.

Figure 3 on page 14 shows the communications path when a virtual router is in
internal bypass state.
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Figure 3: Internal Bypass

When the IDP operating system resumes healthy operations, it sends a reset signal
to the traffic interfaces, and the interfaces resume normal operation.

External Bypass

External bypass operates according to the logic of a third-party external bypass unit.
When the IDP appliance is turned on and available, it sends NetScreen Redundancy
Protocol (NSRP) heartbeats to the external bypass unit. When the NSRP packets flow,
the external bypass unit allows connections to proceed through the IDP appliance.
If IDP encounters failure or is shut down, it cannot send the NSRP packets. IDP traffic
interfaces enter a bypass state. When the external bypass unit detects this, it forwards
packets around the IDP appliance, according to the rules you configure on the external
bypass unit. See Figure 4 on page 15.
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Figure 4: Internal Bypass

When the IDP appliance resumes healthy operations, it resumes sending NSRP
packets. The external bypass unit detects this and allows connections to proceed
through the virtual router.

Peer Port Modulation

The peer port modulation (PPM) feature supports deployments where routers monitor
link state to make routing decisions. In these deployments, a router might be set to
monitor link state on only one side of the IDP appliance. Suppose, for example, the
router monitors only the IDP inbound interface. Suppose the inbound interface
remains up but the outbound interface goes down. The router watching the inbound
link would detect an available link and forward traffic to the IDP appliance. Traffic
would be dropped at the point of failure—the outbound link. PPM propagates a link
loss state for one traffic interface to all interfaces in the IDP virtual router.

When PPM is enabled, a PPM daemon monitors the health of IDP traffic interfaces
belonging to the same virtual router. If a traffic interface loses link, the PPM process
turns off any associated network interfaces in the same virtual router so that other
network devices detect that the virtual router is down and route around it. For
example, assume you have enabled PPM and configured IDP virtual routers as shown
in Figure 5 on page 16.
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Figure 5: Peer Port Modulation

Suppose there is a network problem and eth3 goes down. The PPM daemon detects
this and turns off the other interface in vr0: eth2. The interfaces in vr1, vr2, and vr3
are unaffected. After the you fix the problem with eth3, the PPM daemon detects
this, and turns on eth2.

NOTE: The PPM feature is independent of the bypass feature (NIC state setting). PPM
is related to the status of the link, not the status of the IDP operating system. A link
can be down even when the IDP operating system is healthy. Note, however, that
PPM runs as a control plane process and operates only when the IDP appliance is
turned on and the control plane is available. If the IDP operating system is unavailable,
the PPM feature is also unavailable, regardless of the setting for the NIC state.

Related Topics The following related topics are included in the IDP Concepts and Examples Guide:

■ IDP Series Operating System Overview on page 7

■ Centralized Management with NSM Overview on page 16

The following related topics are included in the IDP Administration Guide:

■ Configuring Virtual Routers (ACM Procedure)

■ Tuning the JNET Driver Failure Count

■ Configuring Interface Aliasing (ACM Procedure)

Centralized Management with NSM Overview

Juniper Networks Network and Security Manager (NSM) is a central management
server capable of managing hundreds of IDP appliances and other Juniper Networks
devices, such as ScreenOS firewalls, SA Series appliances, and IC Series appliances.
You typically deploy NSM in a management subnet accessible to the NSM-managed
devices.
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Figure 6 on page 17 illustrates the flow of information between the tiers of the central
management solution: the NSM user interface, the NSM server, and IDP appliances.

Figure 6: IDP-NSM Communication

The IDP configuration, security policies, attack objects, and log records are stored in
NSM server databases and administered using the NSM user interface. Communication
between the NSM server and IDP appliances, and between the NSM server and the
NSM user interface, is encrypted and authenticated.

For IDP deployments, centralized management provides the following benefits:

■ Centralized management for IDP appliances and other network devices

■ Consolidated logs from different devices in a single repository

■ Centralized management of enterprise security policies

■ Simplified management for attack signature updates

■ Role-based administration

For information about installing NSM and using NSM distributed management features,
management objects (such as address objects, service objects, and templates), and
navigational and display features, see the NSM documentation.

Related Topics The following related topics are included in the IDP Concepts and Examples Guide:

■ J-Security Center Updates Overview on page 17

■ Management Interface (eth0) on page 12

The following related topics are included in the IDP Administration Guide:

■ NSM Device Configuration Management Task Summary

■ IDP Logs and Reports in NSM Task Summary

J-Security Center Updates Overview

The Juniper Networks Security Center (J-Security Center) routinely makes important
updates available to IDP security policy components, including updates to the IDP
detector engine and the NSM attack database.
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The IDP detector engine is a dynamic protocol decoder that includes support for
decoding more than 60 protocols and more than 500 service contexts. You should
update IDP detector engine when you first install IDP, whenever you upgrade, and
whenever alerted to do so by Juniper Networks. You can view release notes for
detector engine updates at
http://www.juniper.net/techpubs/software/management/idp/de/.

The NSM attack database stores data definitions for attack objects. Attack objects
are patterns comprising stateful signatures and traffic anomalies. Security policy
rules direct the IDP engine to inspect traffic for attack objects. We recommend you
schedule automatic updates for the NSM attack database.

Related Topics The following related topics are included in the IDP Concepts and Examples Guide:

■ Centralized Management with NSM Overview on page 16

■ Using Attack Objects on page 97

The following related topics are included in the IDP Administration Guide:

■ Attack Objects Task Summary

■ Loading J-Security Center Updates (NSM Procedure)
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Chapter 3

IDP Series Deployment Mode Overview

This chapter provides an overview of the deployment modes supported by Juniper
Networks IDP Series Intrusion Detection and Prevention Appliances. It includes the
following topics:

■ Sniffer Mode Overview on page 19

■ Transparent Mode Overview on page 21

■ Mixed Deployment Mode Overview on page 22

Sniffer Mode Overview

You deploy an IDP virtual router in sniffer mode if you want to learn about security
threats in your network but not disrupt connections.

In sniffer mode, the IDP appliance is not directly involved with packet flow. Based
on your security policy, the device detects and logs threats in Layer 3 and Layer 2
traffic. For some attacks, the IDP appliance can send TCP resets. However, this action
does not guarantee protection, as attacks might have already happened before the
reset or the attacker might persist.

For a sniffer mode deployment, you connect an IDP traffic interface to a port mirror
or Switched Port Analyzer (SPAN) port.

Figure 7 on page 20 illustrates a sniffer mode deployment.
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Figure 7: Network Diagram: Sniffer Mode

Table 10 on page 20 lists the features and the limitations of sniffer mode.

Table 10: Sniffer Mode: Features and Limitations

LimitationsFeatures

■ Requires a hub or the SPAN port of a network switch

■ Cannot perform the following security policy actions:

■ Drop Packet

■ Drop Connection

■ Mark Diffserv

■ IP Block

■ Cannot perform drop actions

■ Does not inspect HTTPS traffic that requires the interdiction
feature

■ Does not support SYN Protector rulebase in relay mode

■ Does not support Network Honeypot rulebase

■ Replaces the current intrusion detection with minimal
effort

■ Does not create an additional point-of-failure gateway

■ Detects attacks according to your security policy rules

■ Performs the following security policy actions:

■ Close Client and Server

■ Close Client

■ Close Server

■ IP Close

■ IP Notify

Related Topics The following related topics are included in the IDP Concepts and Examples Guide:

■ Transparent Mode Overview on page 21

■ Mixed Deployment Mode Overview on page 22

The following related topic is included in the IDP Administration Guide:

■ Configuring Virtual Routers (ACM Procedure)
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Transparent Mode Overview

You deploy a virtual router in transparent mode when you are ready to take action
against network attacks.

In transparent mode, the IDP appliance is in the path of network traffic. You connect
the device traffic interfaces to network devices, such as firewalls or switches. The
virtual router receives traffic from an input port of a traffic interface pair. For Layer
3 traffic, IDP inspects and processes it according to your security policy rules, taking
action against threats and forwarding safe traffic through the output port of the traffic
interface pair. For Layer 2 connections, you can choose to drop them or pass them
through the device without inspection.

You do not need to configure other network devices to be aware of the IDP appliance.

Figure 8 on page 21 illustrates a transparent mode deployment.

Figure 8: Network Diagram: Transparent Mode

Table 11 on page 22 lists the features and limitations of transparent mode.
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Table 11: Transparent Mode: Features and Limitations

LimitationsFeatures

■ Cannot connect IP
networks with different
address spaces

■ Simple, transparent deployment

■ No changes to routing tables or network equipment

■ Supports all IDP security policy rulebases and all rule actions

■ Optionally passes through Layer 2 traffic

■ Passes through non-IP and non-ARP traffic

■ Passes through heartbeats used in deployments with an external bypass unit

■ Passes through bridge protocol data unit (BPDU) packets used in deployments with
Spanning Tree Protocol (STP)

■ Internal bypass, peer port modulation, and flow bypass under congestion features
minimize risk that the IDP appliance will be a point of failure

Related Topics The following related topics are included in the IDP Concepts and Examples Guide:

■ Sniffer Mode Overview on page 19

■ Mixed Deployment Mode Overview on page 22

The following related topic is included in the IDP Administration Guide:

■ Configuring Virtual Routers (ACM Procedure)

Mixed Deployment Mode Overview

IDP devices have multiple traffic interfaces. Logical pairs of interfaces belong to the
same virtual router. You configure deployment mode for each virtual router. In your
network design, you can think in terms of deploying IDP virtual routers instead of
IDP appliances. One IDP appliance can be deployed to support two types of network
designs simultaneously:

■ In-path designs. To protect against attacks and regulate application usage, you
connect the virtual router traffic interfaces to devices that are in the path of
network traffic. You configure the corresponding virtual router in transparent
mode.

■ Out-of-path designs. To gather information about attacks and application usage,
you connect one of the virtual router traffic interfaces to a port mirror or Switched
Port Analyzer (SPAN) port. You configure the corresponding virtual router in
sniffer mode.

Figure 9 on page 23 shows a network design where two virtual routers are deployed
in transparent mode and another in sniffer mode.
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Figure 9: Mixed Deployment Mode

Related Topics The following related topics are included in the IDP Concepts and Examples Guide:

■ Transparent Mode Overview on page 21

■ Sniffer Mode Overview on page 19

The following related topic is included in the IDP Administration Guide:

■ Configuring Virtual Routers (ACM Procedure)
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Part 2

Analyzing Your Network

■ Profiler on page 27

■ Security Explorer Overview on page 41

■ Application Volume Tracking on page 43

■ Logs and Reports on page 51
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Chapter 4

Profiler

This chapter provides an overview of Profiler features and examples of when and
how to use Profiler. It includes the following topics:

■ Profiler Overview on page 27

■ Example: Using Profiler to Set a Baseline on page 29

■ Example: Using Profiler to Alert You to New Hosts and Port Activity on page 35

■ Example: Identifying Services That Use Nonstandard Ports on page 35

■ Example: Responding to Vulnerability Announcements with Due
Diligence on page 36

■ Example: Using Profiler to Investigate Unanticipated Attacks on page 37

■ Example: Using Profiler to Mitigate Risks from Laptops on page 38

Profiler Overview

The Profiler is a network-analysis tool that helps you learn about your internal network
so you can create effective security policies and minimize unnecessary log records.
The Profiler queries and correlates information from multiple IDP appliances.

After you configure the Profiler, it automatically learns about your internal network
and the elements that constitute it, including hosts, peers (which host is talking to
which other host), ports (non-IP protocols, TCP/UDP ports, RPC programs), and Layer
7 data that uniquely identifies hosts, applications, commands, users, and filenames.
You can use this data to investigate and analyze potential problems in the network
and to resolve security incidents.

During profiling, the IDP appliance records network activity at Layer 3, Layer 4, and
Layer 7 and stores this information in a searchable database called the Profiler DB.
The Profiler uses session creation, session teardown, and protocol contexts to generate
this database, which defines all unique activities occurring on your network. Unique
activities include attempts, probes, and successful connections.

The device logs normal events only once, and it logs all unique events as often as
they occur.

A normal event is an event that reoccurs frequently and does not change. For example,
suppose Wendy holds a meeting every Tuesday at 4:00 PM in conference room A.
Every meeting, she connects her laptop to the network and accesses documents on
the primary fileserver. Because the same event occurs multiple times, the device
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logs the event once and includes a timestamp that indicates the first and last times
Wendy accessed the network from conference room A.

A unique event is an event that is new, unexpected, or does not match the normal
traffic patterns of your network. For example, suppose that in her weekly meeting,
Wendy accesses documents from a different fileserver or has a colleague lead the
meeting when she is on vacation. Because the network session information differs,
the device logs these activities separately from the normal Tuesday afternoon meeting.

When you configure the Profiler, you can specify:

■ General settings, such as whether to collect application volume data and whether
to record the OS fingerprint of network hosts

■ Network and host IP addresses to track in Profiler logs

■ Network and host IP addresses to exclude in Profiler logs

■ Contexts to retrieve additional data

■ Alerts in cases where you want to track new hosts and applications

For complete procedures on setting Profiler options, see the IDP Administration Guide.

Related Topics The following related topics are included in the IDP Concepts and Examples Guide:

■ Example: Using Profiler to Set a Baseline on page 29

■ Example: Using Profiler to Alert You to New Hosts and Port Activity on page 35

■ Example: Identifying Services That Use Nonstandard Ports on page 35

■ Example: Responding to Vulnerability Announcements with Due Diligence on
page 36

■ Example: Using Profiler to Investigate Unanticipated Attacks on page 37

■ Example: Using Profiler to Mitigate Risks from Laptops on page 38
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The following related topic is included in the IDP Administration Guide:

■ Profiler Task Summary

Example: Using Profiler to Set a Baseline

A baseline is a place to start. Baseline data gives you the building blocks for your
network security policy. The first time you use Profiler, the Profiler report will provide
you with detailed views of the devices and applications that communicate in your
network.

You use the baseline to:

■ Determine which hosts to protect with security policies.

■ Determine the applications that communicate over the network and therefore
which services require protection in general.

■ Determine specific operating systems and software versions in use and therefore
which security policy attack objects are relevant and which may be exempted.

■ Determine which security policy rulebases are relevant.

■ Determine session contexts that can be safely ignored and those that should be
monitored.

This example assumes a network that uses the private address space defined in RFC
1918: 10.0.0.0/8, 172.16.0.0.12, and 192.168.0.0/16.

To discover hosts and applications in your private network:

1. Use NSM to create network address objects for each of the three private address
spaces.

Figure 10 on page 29 shows the NSM network address object editor.

Figure 10: NSM Network Address Object Editor

2. Create address objects for any additional networks or hosts that you are aware
of.

The Profiler detects host and application information for all traffic that traverses
it. If it cannot match the traffic to your network address objects, it assumes you
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are not tracking the host and populates the source or destination fields as
Non-tracked IP.

3. Optionally, create a group object to contain the private address space networks.

Figure 11 on page 30 shows the NSM group object editor.

Figure 11: NSM Group Object Editor

4. In the NSM Device Manager, right-click the IDP appliance and select IDP Profiler
> Start Profiler.

Figure 12 on page 31 shows how to navigate in NSM Device Manager to start
Profiler.
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Figure 12: Starting Profiler from NSM Device Manager

Figure 13 on page 31 shows the Profiler configuration tabs.

Figure 13: NSM Profiler Configuration Tabs

5. In the General tab, check the boxes to enable profiling, application profiling, OS
fingerprinting, and non-tracked IP addresses.
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6. Click the Tracked Hosts tab and add the address objects you created in Step 1.

Figure 14 on page 32 shows the Tracked Hosts tab.

Figure 14: NSM Profiler Tracked Hosts Tab

7. Click the Contexts to Profile  tab and select all contexts.

8. Click the Alert tab and clear all alerts. You can use alerts after you have
established your baseline but you do not need them in this initial procedure.

9. Click Apply to update the Profiler configuration and start the Profiler update job.

The Profiler detects network traffic that traverses the path of the IDP appliance.
Consequently, it takes time to build the Profiler database. In most networks,
critical services are used frequently and you might see data in five or ten minutes.
For best results, let the Profiler run for a full business day to ensure that it has
had enough time to monitor all pertinent network traffic.

Figure 15 on page 33 shows the Job Information window that appears when the
Profiler update job is completed.
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Figure 15: NSM Profiler Update Job Information Window

10. In the NSM navigation tree, select Investigate > Security Monitor > Profiler
to display the Profiler viewer.

11. Click the Network Profiler tab and examine the data gathered about hosts in
your network.

Figure 16 on page 34 shows the Network Profiler tab.
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Figure 16: Profiler: Network Profiler Tab

12. Optionally, use the Profiler data to create address objects and groups that you
can later use when you create security policy rules.

For example, to create groups for SMTP servers, DNS servers, Windows AD
servers, and, HTTP servers:

a. Create group objects, such as SMTP, DNS, Windows AD, and HTTP.

b. Use NSM UI features to filter and sort Profiler table rows by service.

c. Double-click a destination entry to display the host editor, populated with
data for the row you clicked.

d. If you have created a group for the server type, such as SNMP, assign the
host to the group.

e. Click Save.
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Related Topics The following related topic is included in the IDP Concepts and Examples Guide:

■ Profiler Overview on page 27

The following related topic is included in the IDP Administration Guide:

■ Profiler Task Summary

Example: Using Profiler to Alert You to New Hosts and Port Activity

After you have created a baseline and installed an appropriate security policy, you
can use Profiler to alert you when new hosts or applications appear in your network.
You can analyze the alerts to decide whether to update your security policy.

To set alerts when Profiler detects new hosts or applications:

1. In the NSM Device Manager, right-click the IDP appliance and select IDP Profiler
> Start Profiler.

2. Retain your baseline settings for general features, tracked hosts, and contexts.

3. Click the Alert tab and select options to generate alerts when Profiler detects
new hosts, new protocols, or new ports.

4. Click Apply.

Related Topics The following related topic is included in the IDP Concepts and Examples Guide:

■ Profiler Overview on page 27

The following related topic is included in the IDP Administration Guide:

■ Profiler Task Summary

Example: Identifying Services That Use Nonstandard Ports

Suppose you want to identify traffic that uses nonstandard ports so that you can take
the appropriate security measures, such as physically removing the unauthorized
network components, accounting for nonstandard ports in your existing corporate
security policy, or creating rules in your security policy to restrict the traffic to specific
network components.

To display a view of traffic that uses nonstandard ports:

1. In the NSM navigation tree, select Investigate > Security Monitor > Profiler
to display the Profiler viewer.

2. Click the Violation Viewer tab.

3. Click the + icon that appears on the top of the right-hand window to display the
New Permitted Object window.
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4. For this example, name the new permitted object Non-Standard-Ports.

5. Right-click the Service column and select Add Service.

6. Select all predefined services.

7. Click OK.

After you have created and saved the permitted object, the object automatically
becomes available in the Profiler.

8. Select the new permitted object Non-Standard-Ports.

The Profiler uses the object to filter the data collected from the devices. Traffic
that matches the object (uses a standard service port) is filtered out, leaving only
the traffic that does not match (uses a nonstandard service port).

9. Review the data for all traffic on your network that uses nonstandard service
ports and take appropriate action.

Related Topics The following related topic is included in the IDP Concepts and Examples Guide:

■ Profiler Overview on page 27

The following related topic is included in the IDP Administration Guide:

■ Profiler Task Summary

Example: Responding to Vulnerability Announcements with Due Diligence

New network attacks and exploits are discovered every day. When new security
patches are issued, use the Profiler to quickly identify which systems are running
the affected software version, then patch them appropriately.

For large networks, it is difficult to patch everything immediately. Plan your patching
process by prioritizing based on the importance of the resources. Critical, high-risk,
and heavily used resources should be patched first, while less important, minimally
used resources might be able to wait.

For example, suppose Microsoft announces a vulnerability in version 6.0 of the
Microsoft Internet Information Services (IIS).

To quickly identify all network components running the vulnerable version:

1. In the NSM navigation tree, select Investigate > Security Monitor > Profiler
to display the Profiler viewer.

2. Click the Protocol Profiler tab and review the Profiler logs keyed to protocols
running on the network.

3. In the Context column, right-click a value and select Edit Filters to display the
Context Filters dialog box.

4. Set a filter for HTTP Header Servers, for example.
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The filtered view highlights the Web servers in your network. Suppose the table
lists the following Web servers:

■ Apache (two versions)

■ Microsoft IIS, version 6.0

5. Select the Microsoft IIS 6.0 value to display your Microsoft IIS 6.0 destination
server IP addresses.

6. Patch the vulnerable IIS server by using the information supplied with the
Microsoft Security Bulletin.

Related Topics The following related topic is included in the IDP Concepts and Examples Guide:

■ Profiler Overview on page 27

The following related topic is included in the IDP Administration Guide:

■ Profiler Task Summary

Example: Using Profiler to Investigate Unanticipated Attacks

Suppose your corporate security policy does not permit SQL servers on the internal
network. However, during a regular Microsoft update, SQL applications are installed
on a network server, without your knowledge. Because you are not aware that an
SQL server is running on your network, you have not configured security policy rules
to block SQL attacks.

Suppose you receive a call informing you that the SQL Slammer worm attacks and
infects your network.

To investigate:

1. Create a custom TCP service object to represent Microsoft SQL (default port:
TCP/1433).

2. Restart the Profiler.

3. In the NSM navigation tree, select Investigate > Security Monitor > Profiler
to display the Profiler viewer.

4. Click the Network Profiler tab and review the source, destination, and service
data.

5. Use a filter to display only records matching the SQL service object you created
in Step 1.

The filtered view highlights the SQL servers in your network.

6. Take appropriate measures to secure the network, such as:

■ Applying patches.

■ Removing the components from your network.
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■ Removing SQL server from all components.

■ Creating a rule in your security policy that drops all SQL connections between
your internal network objects.

Related Topics The following related topic is included in the IDP Concepts and Examples Guide:

■ Profiler Overview on page 27

The following related topic is included in the IDP Administration Guide:

■ Profiler Task Summary

Example: Using Profiler to Mitigate Risks from Laptops

Suppose your corporate firewall denies RPC file sharing traffic to protect sensitive
corporate files from Internet users, but enables RPC file sharing on a local network
for convenience.

Suppose a laptop user has a good reason to use a partner’s wireless network to access
the Internet. Because the laptop is configured to allow RPC, it contracts a Blaster
worm from an infected user on that network. When the user returns to the office
and connects the laptop to the corporate network, the worm immediately begins
scanning the internal network and infecting all components that have RPC enabled.

The Profiler records all unique activity on the network, so it identifies the ICMP packet
scans as a new event. If you have configured the Profiler to send alerts for new hosts,
you receive an alert that a new host has joined the network. In response to the alert,
you check the Profiler viewer for details on the new host, and you learn that a host
in your network is scanning the entire network using ICMP, a possible sign of the
Blaster worm.

To investigate:

1. Restart the Profiler.

2. In the NSM navigation tree, select Investigate > Security Monitor > Profiler
to display the Profiler viewer.

3. Click the Network Profiler tab and review the source, destination, and service
data.

4. Apply a filter to the Service column values so that only records matching ICMP
are displayed.

5. Apply a second filter to the Access Type column so that only records matching
ICMP and probe are displayed.

6. Apply a third filter to the Last Time column so that only records from the last
two hours are displayed.

The Network Profiler displays all network components that used ICMP to probe
the network in the last two hours.
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Assuming the filters have cleared nonmatching records, you can now see the
only IP address or IP addresses currently probing your network using ICMP.
However, because you use DHCP to dynamically assign IP addresses, you need
to identify which user laptop is currently using that IP address.

7. Right-click the table cell for source properties to display the MAC address. If your
enterprise maintains records matching MAC address to laptops, you can track
down the specific host that is infected.

Related Topics The following related topic is included in the IDP Concepts and Examples Guide:

■ Profiler Overview on page 27

The following related topic is included in the IDP Administration Guide:

■ Profiler Task Summary
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Chapter 5

Security Explorer Overview

This chapter describes the NSM Security Explorer. It includes the following topic:

■ NSM Security Explorer Overview on page 41

NSM Security Explorer Overview

The NSM Security Explorer is a graphical tool that enables you to visualize and
correlate network behavior based on data collected in the Profiler, Log Viewer, and
Report Manager. You can use the Security Explorer to:

■ Get a dynamic, interactive view of your network.

■ Drill down on a particular host or server and view all the different attacks, open
ports, destination or peer IP addresses, and so on.

■ Move between hosts and peers and trace a connection or attack.

■ Toggle between different views or slices of the network, as well as explore the
contextual information (logs, reports, IDP attacks, IP addresses, and so on) within
the Security Explorer panel.

Figure 17 on page 42 shows the NSM Security Explorer.
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Figure 17: NSM Security Explorer

For information on using the NSM Security Explorer, see the NSM documentation.
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Chapter 6

Application Volume Tracking

This chapter explains how to use the application volume tracking (AVT) feature to
gather statistics on applications used over your network. It includes the following
topic:

■ Application Volume Tracking Overview on page 43

■ Example: Using NSM to Enable and View Application Volume Tracking on page 45

Application Volume Tracking Overview

The application volume tracking (AVT) feature uses application identification and the
Profiler to collect application statistics aggregated at 15-minute and 1-hour intervals.
The AVT database stores up to four sets of each interval at a time (four 15-minute
intervals and four 1-hour intervals). After it has accumulated four intervals, it begins
dropping the oldest interval as it collects a new one.

The AVT process writes data files to the following directories:

■ /usr/idp/device/var/stat/1hour

■ /usr/idp/device/var/stat/15min

The data is collected and parsed for reporting in NSM, IDP Reporter, or Juniper
Networks Application Usage Manager.

Table 12 on page 43 describes the columns of data in AVT records for each session.

Table 12: Application Volume Tracking Data

DescriptionData Field

Unique ID for the session.Session ID

IP address for the host that initiated the session.Source IP address

The port number for the source host.Source port

IP address for the destination server.Destination IP address

The port number of the destination host.Destination port

VLAN ID (if any).VLAN ID
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Table 12: Application Volume Tracking Data (continued)

DescriptionData Field

The IP protocol: TCP, UDP, or ICMP.Protocol

The application identified by the application identification feature.Application ID

Throughput in bytes for sessions during the interval. AVT tracks both server-to-client and
client-to-server bytes.

Bytes

Number of packets for sessions during the interval. AVT tracks both server-to-client and
client-to-server packets.

Packets

Table 13 on page 44 lists documentation references for AVT log viewing tools.

Table 13: Application Volume Tracking Log Viewing Tools

DocumentationAVT Log Viewing Tools

IDP Administration GuideNSM Profiler Viewer > Application Profiler tab (logs)

NSM Report (reports)

IDP Reporter User’s GuideIDP Reporter

Juniper Networks Application Usage Manager Installation and User’s
Guide

Juniper Networks Application Usage Manager

NOTE: To avoid issues with reports, we highly recommend that you synchronize the
network clocks for all devices to the same NTP server. For example, the network
clocks for all IDP appliances and NSM clients should be synchronized to the NTP
server specified in the NSM configuration.

Related Topics The following related topic is included in the IDP Concepts and Examples Guide:

■ Example: Using NSM to Enable and View Application Volume Tracking on page 45

■ Profiler Overview on page 27

■ NSM Reports Overview on page 75

■ IDP Reporter Overview on page 77

The following related topic is included in the IDP Administration Guide:

■ Profiler Task Summary

■ IDP Reporter Task Summary
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Example: Using NSM to Enable and View Application Volume Tracking

You can use NSM to enable application volume tracking (AVT) and to view AVT logs
and reports.

To enable AVT: 1. From NSM Device Manager, double-click a device and then click Profiler Settings.

2. Click the General tab.

3. Ensure Enable AVT is selected. This setting is enabled by default and shown in
Figure 18 on page 46.

4. If you have changed settings, click Apply.

5. Start the Profiler:

a. From the NSM main menu, select Devices > IDP Profiler > Start Profiler.

b. Select the devices on which you want to start the Profiler.

c. Click OK.

NOTE: If you change Profiler settings, you must push a configuration update to the
device before the new settings take effect. From the Device Manager, right-click the
device, select Update Device, select the Restart IDP Profiler After Device Update
check box, and click OK.
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Figure 18: Profiler Settings: Enable AVT

To view AVT logs: In the NSM navigation tree, select Investigate > Security Monitor > Profiler.1.

2. Click the Application Profiler tab.

The Application Profiler tab displays application data. Figure 19 on page 46 shows
the Application Profiler tab.

Figure 19: Profiler Viewer: Application Profiler Tab
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The Application Profiler view is divided into two sections:

■ In the left pane, the Application Profiler tab displays a hierarchical tree of
application categories. Applications are grouped by common functionality. For
example, Peer-to-Peer applications include Chat and File Sharing applications.
Under Chat, you can display Yahoo messenger, MSN, and AIM; under File Sharing,
you can display Kazaa, Bittorrent, and Gnutella.

The left pane also displays aggregate statistics for volume (bytes) and packet
count for the application category, application group, or application you select
in the tree.

■ In the right pane, the Application Profiler tab displays tables of session logs
related to the application category or application you select in the left pane.

Table 14 on page 47 describes the Application Profiler session table.

Table 14: Application Profiler Session Table

DescriptionColumn

Source IP address of the session.Src IP

Destination IP address.Dst IP

VLAN ID (if any).VLAN ID

Application.Application ID

Byte count.Byte count

Packet count.Packet count

The user associated with the session.User

The role to which the user belongs.Role

Timestamp for the first time the device logged the event (within the specified time interval).First Time

Timestamp for the last time the device logged the event (within the specified time interval).Last Time

NSM domain.Domain

Device through which the session was forwarded.Device

The Application Profiler tab displays application data. Figure 20 on page 48 is an
example of an NSM AVT report.
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Figure 20: NSM AVT Report

NOTE: AVT reports are not real-time reports. On the local IDP device, the AVT
processor writes an AVT log file at 15 minute intervals. NSM collects the interval data
during its routine device log collection activity. As a result, there might be up to a 15
or 16 minute lag from the time a session is received by the IDP device and the display
of the data in the NSM report.

To view AVT reports: In the NSM navigation tree, select Investigate > Report Manager > AVT
Reports.

1.

2. Click the name of a predefined report to display it. Table 15 on page 48 describes
the predefined AVT reports.

Table 15: NSM: Application Volume Tracking Reports

DescriptionReport

Applications with the highest volume in bytes in the past 24 hours.Top 10 Applications by Volume

Application categories with the highest volume in bytes in the past 24 hours.Top 10 Application Categories by
Volume

Applications with the highest volume in bytes in the past hour.Top 5 Applications by Volume over
Time (last hour)

Application categories with the highest volume in bytes in the past hour.Top 5 Application Categories by
Volume (last hour)

Source IP addresses with the highest volume in bytes in the past hour.Top 5 Source by Volume over Time
(last hour)
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Table 15: NSM: Application Volume Tracking Reports (continued)

DescriptionReport

Destination IP addresses with the highest volume in bytes in the past hour.Top 5 Destination by Volume over
Time (last hour)

Related Topics The following related topic is included in the IDP Concepts and Examples Guide:

■ Application Volume Tracking Overview on page 43

■ NSM Reports Overview on page 75

■ IDP Reporter Overview on page 77

The following related topic is included in the IDP Administration Guide:

■ Profiler Task Summary

■ IDP Reporter Task Summary
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Chapter 7

Logs and Reports

This chapter describes IDP logging and reporting features. It includes the following
topics:

■ IDP Logs Overview on page 51

■ Developing a Logging Strategy on page 56

■ Developing a Log Storage Strategy on page 57

■ Example: Using NSM Log Viewer Features on page 60

■ Example: Packet Logging Workflow on page 68

■ NSM Reports Overview on page 75

■ IDP Reporter Overview on page 77

IDP Logs Overview

The IDP system generates logs for device events and security events.

Device event logs are related to the operation of the IDP appliance. By default, the
system logs events when it reaches the rising and reset threshold for memory usage,
CPU usage, disk space usage, or maximum number of active sessions. The default
threshold is 90%. You can optionally configure logging for other operational events,
such as flow or fragment errors.

Security event logs are related to traffic that matches security policy rules or IP spoof
attack settings.

Table 16 on page 51 summarizes options for viewing and managing logs.

Table 16: IDP Logging Options

DescriptionOption

IDP devices automatically send device event logs to NSM. IDP devices send security event logs
when traffic matches security policy rules for which logging has been enabled. You can use the
NSM log viewer to sort through and analyze logs. If you enable packet logging for a security
policy rule, you can use the NSM packet viewer to display packet data.

For details on using NSM log utilities, see the Network and Security Manager Administration
Guide.

Network and Security
Manager (NSM)
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Table 16: IDP Logging Options (continued)

DescriptionOption

You can configure IDP devices to forward logs to a syslog server, a commonly used method for
storing logs for troubleshooting or record-keeping.

For details on configuring syslog collection, see the IDP Administration Guide.

Syslog

You can enable SNMP reporting. With SNMP enabled and configured, an SNMP manager can
use the snmp get command to query the IDP appliance statistics for CPU usage, memory usage,
disk usage, and session count. In addition, the IDP sends an SNMP trap when usage exceeds
90%.

For details on configuring SNMP reporting, see the IDP Administration Guide.

SNMP

You can configure log suppression to reduce the volume of logs. The log suppression feature
eliminates multiple log entries for events with the same properties. Instead, in NSM Log Viewer,
a single entry appears along with a count of all such matching events.

For details on configuring log suppression, see the IDP Administration Guide.

Log suppression

NOTE: To avoid issues with reports, we highly recommend that you synchronize the
network clocks for all devices to the same NTP server. For example, the network
clocks for all IDP appliances and NSM clients should be synchronized to the NTP
server specified in the NSM configuration.

Table 17 on page 52 describes the fields that appear in log entries.

Table 17: NSM Log Viewer: Log Columns

DescriptionColumn

Unique ID for the log entry, derived by combining the date and log number.Log ID

Date and time that the management system received the log entry.Time Received

NSM-defined alert for this type of log entry. Configure alerts in policy rules.Alert

To set a flag, right-click the log row, select Flag, and then select one of the following flags:

■ High

■ Medium

■ Low

■ Closed

■ False Positive

■ Assigned

■ Investigate

■ Follow-up

■ Pending

User Flag
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Table 17: NSM Log Viewer: Log Columns (continued)

DescriptionColumn

Source IP address of the packet that generated the log entry.Src Addr

Destination IP address of the packet that generated the log entry.Dst Addr

Action the security device performed on the packet/connection that generated this log entry:

■ Accepted–Did not block the packet.

■ Closed Client–Closed the connection and sent an RST packet to the client, but did neither to the server.

■ Closed Server–Closed the connection and sent an RST packet to the server, but did neither to the
client.

■ Closed–Closed the connection and sent an RST packet to both the client and the server.

■ Dropped–Dropped the connection without sending an RST packet to the sender, preventing the traffic
from reaching its destination.

■ Dropped Packet–Dropped a matching packet before it could reach its destination but did not close
the connection.

■ Ignored–Matched the attack, did not take action, and ignored the remainder of the connection.

NOTE: IDP logs show the action that was set in the rule, not necessarily the actual action taken. For TCP
events, these are the same. For UDP and ICMP events, the IDP logs show close client, close server, and
close client and server actions, even when the actual action taken was a drop (close actions are not possible
for UDP or ICMP packets).

Action

Protocol that the packet that generated the log entry used.Protocol

Destination port of the packet that generated the log entry.Dst Port

Security policy rule that generated the log entry.Rule #

NAT source address of the packet that generated the log entry.Nat Src Addr

NAT destination address of the packet that generated the log entry.Nat Dst Addr

Miscellaneous string associated with log entry.Details
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Table 17: NSM Log Viewer: Log Columns (continued)

DescriptionColumn

Type of log entry:

■ Admin

■ Alarm–The device generates event alarms for any security event that has a predefined severity level
of emergency, critical, or alert. Additionally, the device generates traffic alarm log entries when it
detects network traffic that exceeds the specified alarm threshold in a rule (the traffic alarm log entry
describes the security event that triggered the alarm).

■ Config–A configuration change occurred on the device.

■ Custom–A match with a custom attack object was detected.

■ Implicit–An implicit rule was matched.

■ Info–General system information.

■ Predefined. A match with a predefined attack object was detected.

■ Profiler–Traffic matches a Profiler alert setting.

■ Screen–Not applicable for IDP appliances. Generated by ScreenOS firewall devices.

■ Self–The device generated this log for a non-traffic related reason.

■ Sensor.

■ Traffic–Traffic matches a rule you have configured for harmless traffic.

■ URL Filtering–Not applicable for IDP appliances. Generated by ScreenOS firewall devices.

■ User.

Category

Category-specific type of log entry (examples are "Reboot" or message ID).Subcategory

Severity rating associated (if any) with this type of log entry:

■ Not Set (the device could not determine a severity for this log entry)

■ Info

■ Device_warning_log

■ Minor

■ Major

■ Device_critical_log

■ Emergency

■ Error

■ Notice

■ Informational

■ Debug

Severity

Device that generated this log entry.Device

User-defined comment about the log entry.Comment

Application associated with the current log.Application
Name

For sessions, specifies the number of inbound bytes.Bytes In

For sessions, specifies the number of outbound bytes.Bytes Out

For sessions, specifies the combined number of inbound and outbound bytes.Bytes Total
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Table 17: NSM Log Viewer: Log Columns (continued)

DescriptionColumn

Domain version that generated this log entry.Dev Domain Ver

Domain for the device that generated this log entry.Device Domain

Family of the device that generated this log entry.Device family

Name of the outbound interface of the packet that generated this log entry.Dst Intf

Destination zone associated with a traffic log entry.Dst Zone

For sessions, specifies how long the session lasted.Elapsed Secs

Indicates whether the log entry has associated packet data.Has Packet Data

The NAT destination port of the packet that generated the log entry.NAT Dst Port

The NAT source port of the packet that generated the log entry.NAT Src Port

For sessions, specifies the number of inbound packets.Packets In

For sessions, specifies the number of outbound packets.Packets Out

For sessions, specifies the combined number of inbound and outbound packets.Packets Total

Security policy that generated the log entry.Policy

Role group associated with this log entry.Roles

The domain of the rule that generated the log entry.Rule Domain

The domain version of the rule that generated the log entry.Rule Domain
Ver

Security policy rulebase that generated the log entry.Rulebase

Name of the inbound interface of the packet that generated this log entry.Src Intf

Source port of the packet that generated the log entry.Src Port

Source zone associated with a traffic log entry.Src Zone

Date and time the device generated the log entry.Time Generated

User associated with this log entry.User

The following example shows a syslog message record:

[syslog@juniper.net dayId="20061012" recordId="0" timeRecv="2006/10/12 
21:52:21" timeGen="2006/10/12 21:52:21" domain="" devDomVer2="0" 
device_ip="10.209.83.4" cat="Predefined" attack="TROJAN:SUBSEVEN:SCAN" 
srcZn="NULL" srcIntf="NULL" srcAddr="192.168.170.20" srcPort="63396" 
natSrcAddr="NULL" natSrcPort="0" dstZn="NULL" dstIntf="NULL" 
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dstAddr="192.168.170.10" dstPort="27374" natDstAddr="NULL" natDstPort="0"
 protocol="TCP" ruleDomain="" ruleVer="5" policy="Policy2" rulebase="IDS" 
ruleNo="4" action="NONE" severity="LOW" alert="no" elaspedTime="0" inbytes="0"
 outbytes="0" totBytes="0" inPak="0" outPak="0" totPak="0" repCount="0" 
packetData="no" varEnum="31" misc="<017>'interface=eth2" user="NULL" 
app="NULL" uri="NULL"]

Related Topics The following related topics are included in the IDP Concepts and Examples Guide:

■ Developing a Logging Strategy on page 56

■ Developing a Log Storage Strategy on page 57

■ Example: Using NSM Log Viewer Features on page 60

■ Example: Packet Logging Workflow on page 68

■ Understanding IDP Rulebase Notification Options on page 103

■ Understanding Backdoor Rulebase Notification Options on page 131

■ Understanding SYN Protector Rulebase Notification Options on page 139

■ Understanding Traffic Anomalies Rulebase Notification Options on page 146

■ Understanding Network Honeypot Rulebase Notification Options on page 150

■ IP Spoof Attack Prevention Overview on page 159

The following related topics are included in the IDP Administration Guide:

■ IDP Logs and Reports in NSM Task Summary

■ Using tcpdump to Capture Packets

Developing a Logging Strategy

Intrusion prevention systems can generate hundreds of logs per hour. In order to
make the best use of the security logs, you should develop strategic approaches to
the following administrative tasks:

■ Fine-turning the security policy rules.

Security policy rules determine the amount of logging performed by the IDP
device, as well as automatic actions to take on offending traffic, such as dropping
the session, sending a TCP reset, blocking the IP address from future connections,
and so forth. See “Example: Fine-Tuning a Security Policy” on page 153.

■ Analyzing log event summaries and packet capture data.

By viewing log summaries, attack reference information, and packet data, you
can verify whether the severity and actions associated with a security event are
appropriate, whether refinements to your security policy are required, and
whether further response actions are warranted. See “Example: Using NSM Log
Viewer Features” on page 60.

■ Managing log and packet storage.
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Your business log management and log storage policies determine where you
store IDP device logs and security event logs. Your IDP device supports local
logging, central collection by NSM, and forwarding to a syslog server. See
“Developing a Log Storage Strategy” on page 57.

Related Topics The following related topic is included in the IDP Concepts and Examples Guide:

■ IDP Logs Overview on page 51

The following related topics are included in the IDP Administration Guide:

■ IDP Logs and Reports in NSM Task Summary

Developing a Log Storage Strategy

This topic summarizes IDP log storage and log forwarding options so you can develop
a log storage strategy suitable for your business. It includes the following sections:

■ Log Management Considerations on page 57

■ Local Log Files and Directories on page 57

■ NSM Log Collection on page 60

Log Management Considerations

An IDP device might generate hundreds of logs per day. Your log storage strategy
depends on a number of factors:

■ The nature of your business. Compliance with regulations or business agreements
might determine where you collect logs or how often you retain them.

■ Existing log management infrastructure. We recommend you become familiar
with an use Network and Security Manager (NSM) as a central location for log
analysis, but your previous investments in technology and training are also strong
considerations.

■ Distribution to the appropriate personnel for analysis is also a key consideration.

If your organization has not formalized a log management policy, consult the National
Institute of Standards and Technology (NIST) publication, Guide to Computer Security
Log Management, for a treatment of the myriad considerations.

Local Log Files and Directories

Logs are stored locally on the device in subdirectories of /usr/idp/device/var. Log
pruning occurs when a disk partition reaches 90% capacity.
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Table 18: IDP Local Log Directories

ContentDirectory

Local storage for device and security event logs before they are forwarded to
NSM.

/usr/idp/device/var/logs

Local storage for packet capture logs before they are forwarded to NSM./usr/idp/device/var/pktlogs

Local storage for Profiler database logs before they are forwarded to NSM./usr/idp/device/var/profile

Location where system messages are written./usr/idp/device/var/sysinfo/logs

Local storage for application volume tracking logs before they are forwarded
to NSM, IDP Reporter, or Application Usage Manager.

/usr/idp/device/var/stat/

NOTE: Although /usr/idp/device/var is a symbolic link to /var/idp/device/var, user
scripts or programs created to manage files should reference the /usr/idp/device/var
path.

By default, logs are forwarded to NSM, which is the primary user interface for the
IDP device.

Optionally, you can configure the IDP device to send copies of logs to external devices,
such as:

■ A syslog server, including a Juniper Networks Security Threat Response Manager
(STRM) device, which reads the IDP syslog format.

■ A Juniper Networks Secure Access Series or Infranet Controller Series device to
inform access policies.

Figure 21 on page 59 provides a visual summary of your log forwarding options. The
solid line indicates default behavior. The dashed lines indicate options you must
configure to use.
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Figure 21: IDP Log Storage and Log Forwarding
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NSM Log Collection

By default, the IDP device sends logs to NSM where they can be displayed and
analyzed with the NSM user interface. We recommend you become familiar with an
use NSM as a central location for log analysis. Logs are stored on the NSM Device
Server in subdirectories of /usr/netscreen/DevSvr/var/logs. NSM supports the
following log management features:

■ Command-line utilities to archive, copy, and purge logs.

■ Configurable time retention policies that trigger pruning.

■ Automated log management jobs based on criteria you configure, including
severity, category, and so forth.

■ Support for log field filters in export operations to XML, CSV, syslog, SNMP,
e-mail, or script.

For complete information on NSM log management features, see Chapter 18 of the
NSM Administration Guide.

Related Topics The following related topic is included in the IDP Concepts and Examples Guide:

■ IDP Logs Overview on page 51

The following related topics are included in the IDP Administration Guide:

■ IDP Logs and Reports in NSM Task Summary

■ Connecting to the Command-Line Interface (CLI Procedure)

Example: Using NSM Log Viewer Features

The Network and Security Manager (NSM) Log Viewer includes many display features
to help you sort and correlate logs so you can analyze security events. For complete
information on NSM Log Viewer features, see Chapter 18 of the NSM Administration
Guide. The following sections are provided here to give you ideas of how to take
advantage of NSM features as you develop your approach to log monitoring:

■ Using Predefined Views on page 61

■ Showing and Hiding Columns on page 61

■ Using Filters on page 62

■ Using Log Viewer Detail Panes on page 64

■ Using Flags and Comments on page 65

■ Using Custom Views on page 67
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Using Predefined Views

Out of the box, the NSM Log Viewer includes a predefined view for DI/IDP event
logs. A predefined view is a filtered view of all logs collected on the NSM device
server. The DI/IDP view is filtered for events that match a predefined or custom
attack object (Category field = Predefined or Category = Custom). Figure 22 on
page 61 shows the DI/IDP view.

Figure 22: NSM Log Viewer: Predefined View

Showing and Hiding Columns

The default columns shown in the predefined DI/IDP view might not include all of
the data fields you are interested in. To select your preferred columns and the order
in which they appear, select View > Choose Columns and use the dialog box to
organize columns according to your preference.
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Figure 23: NSM Log Viewer: Choose Columns

Using Filters

The default DI/IDP view is filtered to display only logs where Category=Predefined
or Category=Custom. To set additional filters, select View > Filter Summary and
use the dialog box to set additional filters. In Figure 24 on page 63, filters are selected
to display logs for traffic where the rule action allowed the traffic continue to the
destination server. When you approach the set of logs you examine each day, you
might want to start with events of high severity, where traffic continued to the
destination.
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Figure 24: NSM Log Viewer: Filters

You can also filter on the fly. Suppose you find a log for an attack targeting HTTP
traffic. In the row for the log, you can right-click the cell containing destination port
80 and select Filter > Only This Value to redisplay the table with only records where
destination port = 80.
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Figure 25: NSM Log Viewer: Filters

Using Log Viewer Detail Panes

The details pane below the log table provides summary and security reference
information for the attack object that triggered the log. The details pane also includes
a link to WHOIS information for the source IP.

Suppose your security policy rule includes the following attack object: Predefined ::
HTTP: Windows Media Services NSIISlog.DLL Buffer Overflow. It generates a log
when it identifies the attack pattern in traffic through the IDP device. Use the reference
information in the details pane below the log table to learn more about the attack.
You can click the hypertext linked name of the attack object in the summary tab to
display reference information for the attack, as shown in Figure 26 on page 65.
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Figure 26: Using NSM Log Viewer Attack Reference Information

Using Flags and Comments

As you work through logs, you can annotate them with flags and comments and then
filter on your annotations. Figure 27 on page 66 shows a log marked as a false positive
because the attack targets server versions not present in our network.
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Figure 27: Using NSM Log Viewer Flag and Comment Features

To mark a log with a flag, right-click the cell in the Flag column and select one of the
following flags:

■ High (severity)

■ Medium (severity)
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■ Low (severity)

■ Closed

■ False Positive

■ Assigned

■ Investigate

■ Follow-Up

■ Pending

Using Custom Views

As you become familiar with NSM Log Viewer filters, you are likely to discover views
of the data you typically want to use to monitor traffic. You can save custom views.
Because the custom view is based on filters, incoming log entries that match the
filter criteria are automatically displayed in the view. You do not need to reapply the
view to new logs.

Figure 28 on page 67 shows a custom view of columns and filters focusing on events
where the IDP device allowed HTTP traffic to proceed to its destination.

Figure 28: NSM Log Viewer: Custom View
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You might want to create views to help manage the following example cases:

■ Workflow—If your team distributes responsibilities based on IDP device, internal
servers, application, severity, or type of attack, you can create views filtered on
the appropriate columns. In the same manner, you can also use the Flag or
Comments columns to prioritize or delegate investigation.

■ Attackers—Once you learn the IP address of an attacker, you can create a view
filtered on Source IP to watch what the attackers activities on your network.

■ Devices—After you deploy a new device, you can create a view filtered on the
Device column to observe and validate device effectiveness.

To create a new view, select the columns you want to display and apply filters. Select
File > New View to display a dialog box to save the view in your preferred Log
Viewer folder. We recommend saving custom views in the Custom folder.

Related Topics The following related topic is included in the IDP Concepts and Examples Guide:

■ IDP Logs Overview on page 51

■ NSM Reports Overview on page 75

The following related topics are included in the IDP Administration Guide:

■ IDP Logs and Reports in NSM Task Summary

Example: Packet Logging Workflow

This topic summarizes IDP packet logging basics. It includes the following sections:

■ Using Packet Captures on page 68

■ Enabling Packet Capture in Security Policy Rules on page 69

■ Forwarding Packet Capture Logs to NSM on page 70

■ Viewing Packet Capture Logs on page 71

Using Packet Captures

The IDP solution supports packet capture logging triggered by security policy rules.

You can use packet captures for a number of response activities, including:

■ Validation of the security policy rule and attack object. You may choose to enable
packet logging to test a new attack object. Once verified, you may find packet
logging for the rule unnecessary.

■ Further analysis of traffic surrounding the matching event. The surrounding
traffic might provide information that helps you determine whether you need
to take further steps to protect the target or whether the attack should be
considered a false positive.
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■ Reproducibility and documentation for Internet security groups, including the
Juniper Networks Security Center.

■ Legal evidence. Consult with your legal counsel for guidance on how local laws
and rules of evidence apply if you want to use packet capture data as evidence
in the prosecution of attackers.

Enabling Packet Capture in Security Policy Rules

When traffic matches a rule where packet logging is configured, the IDP device
captures the packet that matched the rule, as well as the preceding and trailing
packets (according to your configured preference).

To enable packet logging within a security policy rule, use the Security Policy editor.
Right-click a cell in the Notification column and select Configure to display the dialog
box where you can set packet logging options.

Figure 29: Notification Options: Packet Logging

In the NSM Log Viewer, logs for events where packet captures have been generated
are noted by an icon in the Has Packet Data column (the last column in Figure 30
on page 70).

Example: Packet Logging Workflow ■ 69

Chapter 7: Logs and Reports



Figure 30: NSM Log Viewer: Has Packet Data Column

Forwarding Packet Capture Logs to NSM

The IDP device writes packet captures locally to subdirectories of
/usr/idp/device/var/pktlogs/. It forwards the packet data to NSM according to your
NSM Report Settings:

■ Include packet data in log selected. Forwards the packet capture to NSM
automatically whenever it sends the corresponding event log.

■ Include packet data in log not selected. Forwards a reference to the packet
capture file to NSM automatically but forwards the packet data itself only
on-demand (when an NSM user takes action to display the packet data).

70 ■ Example: Packet Logging Workflow

IDP Concepts and Examples Guide



Figure 31: NSM Device Configuration Editor: Report Settings

Viewing Packet Capture Logs

You have two options for viewing packet captures:

■ Using the NSM Packet Viewer on page 71

■ Using an External Viewer to View Packet Data on page 72

Using the NSM Packet Viewer

The NSM packet viewer displays the offending attack payload that triggered the alert
as well as preceding and trailing packets (according to your configuration). Figure
32 on page 72 shows the NSM packet capture viewer.
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Figure 32: NSM Packet Capture Viewer

To view a packet capture in the NSM packet viewer:

1. In the NSM navigation tree, select Investigate > Log Viewer > Predefined >
DI/IDP to display the IDP table.

2. Select View > Choose Columns to display the dialog box you use to show and
hide log table columns.

3. Select Has Packet Data to show this column.

If a security event log has packet data, an icon appears in the table cell under
this column.

4. Double-click the Has Packet data icon to display the packet data in the NSM
packet viewer.

Using an External Viewer to View Packet Data

You can configure NSM to launch an external viewer for packet captures.

Figure 33 on page 73 shows the NSM dialog box where you can specify the location
of an external packet viewer.
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Figure 33: Specifying an External Viewer

To set the location of the external viewer:

1. In NSM, select Tools > Preferences.

2. Select Local Properties.

3. Under External Tools > Packet Viewer, click the browse button and select the
executable file for the external viewer (for example: C:\Program
Files\Wireshark\wireshark.exe).

4. Click OK to close the New Preferences dialog box.

Figure 34 on page 74 shows packet data displayed in the Wireshark packet viewer.
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Figure 34: Wireshark Packet Viewer

To view a packet capture in an external packet viewer:

1. In the NSM navigation tree, select Investigate > Log Viewer > Predefined >
DI/IDP to display the IDP table.

2. Select View > Choose Columns to display the dialog box you use to show and
hide log table columns.

3. Select Has Packet Data to show this column.

If a security event log has packet data, an icon appears in the table cell under
this column.

4. Right-click the Has Packet data icon and select Show > Packet Data in External
Viewer.

Related Topics The following related topics are included in the IDP Concepts and Examples Guide:

■ Understanding IDP Rulebase Notification Options on page 103

■ Using tcpdump to Capture Packets
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The following related topics are included in the IDP Administration Guide:

■ Specifying Rule Notification Options (NSM Procedure)

■ Enabling Collection of Packet Data in NSM Logs (NSM Procedure)

NSM Reports Overview

IDP reports are representations of log data, aggregated and sorted to facilitate network
and security analysis. The standalone IDP solution supports both centralized,
aggregated reporting through NSM, and on-box reporting for a single IDP appliance
through IDP Reporter.

NSM Report Manager contains a set of predefined network and security reports,
including a group of deep inspection (DI) and intrusion detection and prevention
(IDP) reports.

Table 19 on page 75 summarizes NSM DI/IDP predefined reports.

Table 19: NSM DI/IDP Predefined Reports

DescriptionReport

Those attacks that are detected most frequently within the last 24 hours.Top 100 Attacks (last 24 hours)

Those attacks that are prevented most frequently within the last 24 hours.Top 100 Attacks Prevented (last 24 hours)

IP addresses that have most frequently been the source of an attack during the
last 24 hours.

Top 20 Attackers (All Attacks - last 24
hours)

IP addresses that have most frequently been prevented from attacking the network
during the last 24 hours.

Top 20 Attackers Prevented (All Attacks -
last 24 hours)

IP addresses that have most frequently been the target of an attack during the
last 24 hours.

Top 20 Targets (last 24 hours)

IP addresses that have most frequently prevented attacks during the last 24 hours.Top 20 Targets Prevented (last 24 hours)

Number of attacks by severity level (set in attack objects) during the last 24 hours.All Attacks by Severity (last 24 hours)

Number of attacks preventedby severity level (set in attack objects) during the
last 24 hours.

All Attacks Prevented by Severity (last 24
hours)

All attacks detected during the last 7 days.All Attacks Over Time (last 7 days)

All attacks prevented during the last 7 days.All Attacks Prevented Over Time (last 7
days)

All attacks detected during the last 30 days.All Attacks Over Time (last 30 days)

All attacks prevented during the last 30 days.All Attacks Prevented Over Time (last 30
days)

All attacks categorized as “critical” detected during the past 24 hours.Critical Attacks (last 24 hours)
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Table 19: NSM DI/IDP Predefined Reports (continued)

DescriptionReport

All attacks categorized as “critical” prevented during the past 24 hours.Critical Attacks Prevented (last 24 hours)

All attacks categorized as either “critical” or “ medium” detected during the past
24 hours.

Critical through Medium Attacks (last 24
hours)

All attacks categorized as either “critical” or “medium” prevented during the past
24 hours.

Critical through Medium Attacks Prevented
(last 24 hours) (last 24 hours)

IP addresses that have most frequently been the source of a scan during the past
7 days.

Top 50 Scan Sources (last 7 days)

IP addresses that have most frequently been the target of a scan over the last 7
days.

Top 50 Scan Targets (last 7 days)

New hosts listed in the Profiler over the last 7 days.Profiler - New Hosts (last 7 days)

New ports listed in the Profiler over the last 7 days.Profiler - New Ports (last 7 days)

New protocols listed in the Profiler over the last 7 days.Profiler - New Protocols (last 7 days)

The total number of log entries generated by specific rules in your IDP policies.
You can use the Top Rules report to identify those rules that are generating the
most log events. This enables you to better optimize your rulebases by identifying
those rules that are most and least effective. You can then modify or remove
those rules from your security policies.

Top IDP Rules

Table 20 on page 76 describes Profiler predefined reports. These reports are related
to activity by hosts in your network.

Table 20: NSM Profiler Predefined Reports

DescriptionReport

Source and destination IP addresses that appeared most frequently in the Profiler
logs.

Top 10 Peers by Count

Source and destination IP addresses that had the highest number of hits in the
Profiler logs.

Top 10 Peers with maximum hits

Table 21 on page 76 describes the predefined application volume tracking (AVT)
reports. The reports are related to application use in your network.

Table 21: NSM: Application Volume Tracking Reports

DescriptionReport

Applications with the highest volume in bytes in the past 24 hours.Top 10 Applications by Volume

Application categories with the highest volume in bytes in the past 24 hours.Top 10 Application Categories by Volume

76 ■ NSM Reports Overview

IDP Concepts and Examples Guide



Table 21: NSM: Application Volume Tracking Reports (continued)

DescriptionReport

Applications with the highest volume in bytes in the past hour.Top 5 Applications by Volume over Time
(last 1 hour)

Application categories with the highest volume in bytes in the past hour.Top 5 Application Categories by Volume
(last 1 hour)

Source IP addresses with the highest volume in bytes in the past hour.Top 5 Source by Volume over Time (last 1
hour)

Destination IP addresses with the highest volume in bytes in the past hour.Top 5 Destination by Volume over Time
(last 1 hour)

In addition to these predefined reports, you can create custom reports based on IDP
log fields. For details on creating custom reports, see the IDP Administration Guide.

Related Topics The following related topic is included in the IDP Concepts and Examples Guide:

■ IDP Logs Overview on page 51

The following related topic is included in the IDP Administration Guide:

■ IDP Logs and Reports in NSM Task Summary

IDP Reporter Overview

IDP reports are representations of log data, aggregated and sorted to facilitate network
and security analysis. The standalone IDP solution supports both centralized,
aggregated reporting through NSM, and on-box reporting for a singular IDP appliance
through IDP Reporter.

IDP Reporter is a Java application that has been preinstalled on your IDP appliance.
You can access IDP Reporter through a Web interface. Like NSM Report Manager,
IDP Reporter contains predefined reports and enables you to create custom reports
based on log fields.

For details on accessing and using IDP Reporter, see the IDP Reporter User’s Guide.

Related Topics The following related topics are included in the IDP Concepts and Examples Guide:

■ IDP Logs Overview on page 51

■ Application Volume Tracking Overview on page 43

The following related topic is included in the IDP Administration Guide:

■ IDP Reporter Task Summary
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Part 3

Protecting Your Network

■ Security Policy Basics on page 81

■ Predefined Security Policies on page 87

■ The IDP Rulebase on page 91

■ The Exempt Rulebase on page 113

■ Application Policy Enforcement Rulebase on page 117

■ The Backdoor Rulebase on page 127

■ The SYN Protector Rulebase on page 135

■ The Traffic Anomalies Rulebase on page 141

■ The Network Honeypot Rulebase on page 147

■ Fine-Tuning a Security Policy on page 153

■ Additional Security Features on page 159
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Chapter 8

Security Policy Basics

This chapter provides a basic overview of what is involved in creating the security
policies that protect your network. It includes the following topics:

■ Understanding the Components of an IDP Security Policy on page 81

■ Understanding the Number of Available and Installed Policies on page 83

■ Understanding the Rule-Matching Algorithm on page 84

Understanding the Components of an IDP Security Policy

An IDP security policy defines how an IDP appliance handles network traffic. It allows
you to enforce various attack detection and prevention techniques on traffic that
traverses your network.

Figure 35 on page 81 illustrates the components of an IDP security policy.

Figure 35: Security Policy Components

A security policy is made up of one or more rulebases. A rulebase is an ordered set
of rules that use a particular detection method to identify and prevent attacks.

Table 22 on page 82 describes the IDP security policy rulebases. A security policy
can contain only one instance of any rulebase type.
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Table 22: IDP Security Policy Rulebases

DescriptionRulebase

Enables you to implement application policy enforcement rules. You can use APE rules to manage
sessions based on application and/or user role. You can terminate matching sessions or limit
bandwidth available to them.

See “Understanding the APE Rulebase” on page 117.

APE rulebase

Protects your network from attacks by using attack objects to detect known and unknown attacks.
Juniper Networks Security Center (J-Security Center) provides predefined attack objects that you
can use in IDP rules. You can also configure your own custom attack objects.

See “Understanding the IDP Rulebase” on page 91.

IDP rulebase

You configure rules in this rulebase to exclude known false positives or to exclude a specific source,
destination, or attack object from matching an IDP rule. If traffic matches a rule in the IDP rulebase,
IDP attempts to match the traffic against the Exempt rulebase before performing the action specified.

See “Understanding the Exempt Rulebase” on page 113.

Exempt rulebase

Protects your network from attacks by using traffic flow analysis to identify attacks that occur over
multiple connections and sessions (such as scans).

See “Understanding the Traffic Anomalies Rulebase” on page 141.

Traffic Anomalies
rulebase

Protects your network from SYN-floods by ensuring that the three-way handshake is performed
successfully for specified TCP traffic. If your network is vulnerable to SYN-flood attacks, use the
SYN-Protector rulebase to prevent it.

See “Understanding the SYN Protector Rulebase” on page 135.

SYN Protector rulebase

Protects your network by impersonating open ports on existing servers on your network, alerting
you to attackers performing port scans and other information-gathering activities.

See “Understanding the Network Honeypot Rulebase” on page 147.

Network Honeypot
rulebase

Protects your network from mechanisms installed on a host computer that facilitate unauthorized
access to the system. Attackers who have already compromised a system typically install backdoors
(such as Trojans) to make future attacks easier. When attackers send and retrieve information to
and from the backdoor program (as when typing commands), they generate interactive traffic that
IDP can detect.

See “Understanding the Backdoor Rulebase” on page 127.

Backdoor rulebase

NOTE: Firewall rulebases, visible in NSM, do not apply to standalone IDP appliances.

Rules are instructions that provide context to detection methods. Rules specify:

■ A match condition that determines which traffic to inspect

■ Attack objects that determine what to look for (IDP rulebase and Exempt rulebase)
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■ Actions and operation modes that determine what to do when traffic matches
a rule

■ Notification options, including logs, alerts, and packet captures

Related Topics The following additional related topics are included in the IDP Concepts and Examples
Guide:

■ Understanding the Number of Available and Installed Policies on page 83

■ Understanding the Rule-Matching Algorithm on page 84

■ Example: Fine-Tuning a Security Policy on page 153

The following additional related topic is included in the IDP Administration Guide:

■ Developing Security Policies Task Summary

Understanding the Number of Available and Installed Policies

In NSM, you can create and save an unlimited number of security policies, and these
policies are available to be installed on IDP appliances.

You can install the same security policy on an unlimited number of IDP appliances.

You can install one security policy on an IDP appliance. However, when you push a
security policy update, you might observe more than one policy in place for a period
after the update.

By default, IDP resets the flow table when you install a new policy. When the flow
table is reset, existing sessions are passed through uninspected. For IDP75 and
IDP200, you cannot override the default.

For high-end appliances, you can unset this default to avoid passing through sessions
uninspected. Go to NSM Device Manager > Run-time Parameters and unselect Reset
flow table with policy load/unload. If you unset this default, when you load a new
policy, the IDP flow table will maintain sessions belonging to the previously installed
policy as well as the newly installed policy. The IDP process engine will continue to
use the previously installed security policy to inspect previous sessions; and use the
newly installed security policy to inspect new sessions. When the previously installed
policy is no longer in use, it is unloaded and all traffic is inspected using the newly
installed policy. For IDP8200 and IDP250, the IDP engine can maintain flows for as
many as two security policies. For IDP1100, IDP800, and IDP600, the IDP engine
can maintain flows for as many as four security policies.

Related Topics The following related topic is included in the IDP Concepts and Examples Guide:

■ Understanding the Components of an IDP Security Policy on page 81

The following related topic is included in the IDP Administration Guide:

■ Developing Security Policies Task Summary
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■ Modifying the IDP Device Configuration

Understanding the Rule-Matching Algorithm

The IDP process engine processes rulebases in the following order:

1. Application Policy Enforcement (APE) rulebase (terminal)

2. Traffic Anomalies rulebase (terminal)

3. SYN Protector rulebase (terminal)

4. Network Honeypot rulebase (terminal)

5. IDP rulebase (nonterminal)

6. Exempt rulebase (nonterminal)

7. Backdoor rulebase (terminal)

For terminal rulebases, the IDP rule-matching algorithm evaluates rules according
to the ordered list to identify matches. As soon as the algorithm identifies a match,
it applies the rule and terminates rule matching. For example, if a terminal rule 1
matches, it is applied, and rule 2 is not consulted.

For nonterminal rulebases, the IDP rule-matching algorithm also evaluates rules
according to the ordered list to identify matches. However, even if it finds a match,
it continues down the list to identify additional matches.

The IDP rulebase includes the option to mark a rule as a terminal rule. When a
terminal rule matches source, destination, and service, IDP applies the rule and
terminates rule matching. It does not matter whether the traffic matches the attack
objects.

In the IDP rulebase, you can set the terminal rule flag for the following purposes:

■ To disregard traffic that originates from a particular trusted source (however, an
Exempt rulebase rule might be a better choice).

■ To exit rule processing when you want a particular match to always trigger a
particular action and no other, such as a drop connection action.

■ To exit rule processing when your rule specifies precise destination addresses
and precise services, and you know that the subsequent rules do not apply.

Use caution when specifying the terminal flag. You can inadvertently leave your
network open to attacks by creating an inappropriate terminal rule. Be particularly
careful about terminal rules using the value Any for both the source and destination.
Terminal rules should appear near the top of the rulebase, before other rules that
would match the same traffic.
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Related Topics The following related topics are included in the IDP Concepts and Examples Guide:

■ Understanding the Components of an IDP Security Policy on page 81

■ Example: Fine-Tuning a Security Policy on page 153

■ Understanding APE Rulebase Match Conditions on page 118

■ Understanding IDP Rulebase Rule Match Settings on page 92

■ Understanding Backdoor Rulebase Match Settings on page 129

■ Understanding SYN Protector Rulebase Match Settings on page 137

■ Understanding Traffic Anomalies Rulebase Match Conditions on page 143

■ Understanding Network Honeypot Rulebase Match Settings on page 148

The following related topic is included in the IDP Administration Guide:

■ Developing Security Policies Task Summary
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Chapter 9

Predefined Security Policies

This chapter describes the predefined security policies that you can use to secure
your network. It includes the following topics:

■ Using the Recommended Security Policy on page 87

■ Using Other Security Policy Templates on page 88

Using the Recommended Security Policy

The highly respected Juniper Networks Security Center team (J-Security Center)
provides the default IDP security policy–named Recommended. We advise that you
use this policy (or customize it) to protect your network from the likeliest and most
dangerous attacks.

Table 23 on page 87 summarizes the properties of the Recommended security policy.

Table 23: Recommended Security Policy Definition

ValueProperty

IDP rulebaseRulebase

Nine rules, distinguished by attack objectRules

AnySource

Default, meaning the matching property is based on the service bindings of the attack object
specified by the rule

Service

AnyDestination

Recommended IP, Recommended TCP, Recommended ICMP, Recommended HTTP,
Recommended SMTP, Recommended DNS, Recommended FTP, Recommended POP3,
Recommended IMAP, Recommended Trojan, Recommended Virus, Recommended Worm

Attack objects

Recommended, meaning the action is specified by the attack objectAction

LoggingNotification

If you prefer, you can copy this security policy and use it as a template for a custom
security policy tailored for your network.

Using the Recommended Security Policy ■ 87



Related Topics The following related topics are included in the IDP Concepts and Examples Guide:

■ Understanding the IDP Rulebase on page 91

■ IDP Rulebase Example: Specifying the Default Service on page 108

■ IDP Rulebase Example: Using Application Identification on page 107

■ IDP Rulebase Example: Using Recommended Attack Objects on page 109

■ IDP Rulebase Example: Using Recommended Actions on page 111

■ Example: Fine-Tuning a Security Policy on page 153

The following related topic is included in the IDP Administration Guide:

■ Developing Security Policies Task Summary

Using Other Security Policy Templates

NSM includes security policy templates you can use as the basis for a custom security
policy tailored for your network. Template rules include a set of attack objects and
logically associated IDP actions. If you choose to use these templates, we advise you
to customize them for your deployment. At a minimum, you should change the
destination IP setting from Any to the IP addresses for specific servers you want to
protect.

Table 24 on page 88 describes IDP security policy templates.

Table 24: IDP Security Policy Templates

DescriptionTemplate

Includes all attack objects and enables packet logging for all rules. This policy is provided for
lab use and is not recommended in production.

all_with_logging

Includes all attack objects but does not enable packet logging.all_without_logging

Protects a typical DMZ environment.dmz_services

Protects DNS services.dns_server

Protects file sharing services, such as SMB, NFS, FTP, and others.file_server

Contains very open rules. Useful in controlled lab environments, but should not be deployed
on heavy traffic live networks.

getting_started

Contains a set of attack groups that balances security and performance.idp_default

Protects HTTP servers from remote attacks.web_server
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Related Topics The following related topic is included in the IDP Concepts and Examples Guide:

■ Using the Recommended Security Policy on page 87

The following related topic is included in the IDP Administration Guide:

■ Developing Security Policies Task Summary

Using Other Security Policy Templates ■ 89

Chapter 9: Predefined Security Policies



90 ■ Using Other Security Policy Templates

IDP Concepts and Examples Guide



Chapter 10

The IDP Rulebase

The purpose of this chapter is to explain how the IDP rulebase protects your network
and to provide examples on how to leverage IDP rulebase features. It includes the
following topics:

■ Understanding the IDP Rulebase on page 91

■ Understanding IDP Rulebase Rule Match Settings on page 92

■ User-Role-Based Policy Feature Overview on page 94

■ Using Application Identification on page 96

■ Using Attack Objects on page 97

■ Understanding IDP Rulebase Actions on page 100

■ Understanding IDP Rulebase Notification Options on page 103

■ IDP Rulebase Example: User-Role-Based Policies on page 104

■ IDP Rulebase Example: Using Application Identification on page 107

■ IDP Rulebase Example: Specifying the Default Service on page 108

■ IDP Rulebase Example: Using Recommended Attack Objects on page 109

■ IDP Rulebase Example: Using Recommended Actions on page 111

Understanding the IDP Rulebase

The IDP rulebase employs an attack object database to support two robust detection
methods: stateful signatures and protocol anomalies.

A stateful signature combines an attack pattern with service, context, and other
properties into a signature attack object. As a result, IDP does not need to expend
resources inspecting huge sections of network traffic where attacks cannot possibly
be, and IDP produces very few false positives.

A protocol anomaly is a deviation from protocol standards established by the Internet
Engineering Taskforce (IETF) Request for Comment (RFC) process. Traffic that does
not adhere to these standards is suspicious because most legitimate applications
adhere to the standards, and anomalies can fairly be regarded as purposeful attempts
to evade an intrusion detection system (IDS). IDP protocol-anomaly attack objects
find traffic that deviates from IETF RFC standards.
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When you create rules for the IDP rulebase, you specify:

■ A source/destination/service match condition

■ Attack objects

■ Action

■ Notification options

For complete procedures on configuring IDP rulebase rules, see the IDP Administration
Guide.

Related Topics The following additional related topics are included in the IDP Concepts and Examples
Guide:

■ Understanding IDP Rulebase Rule Match Settings on page 92

■ Using Application Identification on page 96

■ Using Attack Objects on page 97

■ Understanding IDP Rulebase Actions on page 100

■ Understanding IDP Rulebase Notification Options on page 103

■ IDP Rulebase Example: Using Application Identification on page 107

■ IDP Rulebase Example: Specifying the Default Service on page 108

■ IDP Rulebase Example: Using Recommended Attack Objects on page 109

■ IDP Rulebase Example: Using Recommended Actions on page 111

■ Example: Fine-Tuning a Security Policy on page 153

The following related topic is included in the IDP Administration Guide:

■ Modifying IDP Rulebase Rules (NSM Procedure)

Understanding IDP Rulebase Rule Match Settings

IDP inspects the session beginning with the first packet to determine whether the
session matches a rule. If the session matches all rule settings for source, destination,
service, and VLAN tag ID, IDP decodes the traffic and inspects the session packets
for the attack objects specified in the rule. If the session matches only some of the
rule settings, the rule is not a match.

Table 25 on page 92 provides guidelines for setting IDP rulebase match conditions.

Table 25: IDP Rulebase Match Condition Guidelines

GuidelineSetting

Not applicable for standalone IDP appliances.From zone/To zone
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Table 25: IDP Rulebase Match Condition Guidelines (continued)

GuidelineSetting

Requires one of the specified source IP addresses to match the session for the rule to be applied.
You can add address objects for hosts, groups, or network address ranges.

NOTE: You must choose between source IP address or user role as match criteria for a rule. You
cannot configure both for one rule.

In most cases, to detect incoming attacks that target your internal network, specify Any. Specifying
Any means you are not using source as a key to your match.

To detect traffic from spyware that has affected hosts in your internal network, specify internal
network addresses as the source.

To detect attacks between two networks you manage, specify multiple addresses. The more specific
you are in defining the source and destination of an attack, the more you reduce false positives.

Source

Requires one of the specified user roles to match the session for the rule to be applied. If a value
for User Role matches, the Source parameter is not consulted.

You must choose to configure either source IP address or user role as match criteria for a rule. User
role-based rules are evaluated before IP address-based rules. If a user-role based rule matches, the
rule is applied and IP address-based rules are not consulted.

NOTE: Matching based on user role depends on integration with the Juniper Networks IC Series
Unified Access Controller (UAC) appliance.

User Role

Requires one of the specified destination IP addresses to match the session for the rule to be applied.
You can add address objects for hosts, groups, or network address ranges.

In most cases, specify the hosts or servers you want to protect.

Specify Any to not use destination as a key to your match. For example, it would be impossible to
predict the destination IP address for traffic resulting from spyware in your internal network. Specify
Any for rules that target spyware attacks.

Destination

Requires one of the specified services to match the session for the rule to be applied. Services are
Application Layer protocols that define how data is structured as it travels across the network. IDP
can inspect services that use TCP, UDP, RPC, and ICMP transport layer protocols. If the application
running on the destination server uses standard ports, you can select from predefined services. If
the application running on the destination server uses nonstandard ports, you must create a custom
service object.

TIP: Specify Default to match the service(s) specified in the rule attack object(s). If the application
identification feature is enabled, the IDP process engine identifies services even if they are running
on nonstandard ports.

If you disable application identification and specify Default, the IDP process engine assumes that
standard ports are used for the service.

NOTE: If you disable application identification and your service uses nonstandard ports, you must
create custom service objects. For procedures, see the IDP Administration Guide.

Specify Any to not use service as a key to your match.

Service

Requires one of the specified VLAN tags to match the session for the rule to be applied.

Specify Any to not use VLAN tag as a key to your match.

VLAN
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TIP: You can use Profiler to identify the hosts and services that are included in your
network. In NSM, you can create address objects and service objects to facilitate
configuration. One benefit of using objects is that you can configure them once and
then use them in multiple rules. For details, see the NSM online Help.

Related Topics The following related topic is included in the IDP Concepts and Examples Guide:

■ Understanding the IDP Rulebase on page 91

■ User-Role-Based Policy Feature Overview on page 94

■ Using Application Identification on page 96

■ IDP Rulebase Example: Specifying the Default Service on page 108

■ IDP Rulebase Example: Using Application Identification on page 107

The following related topic is included in the IDP Administration Guide:

■ Specifying Rule Match Conditions (NSM Procedure)

User-Role-Based Policy Feature Overview

The user role-based policy feature depends on integration with the Juniper Networks
IC Series Unified Access Control appliance. This feature requires collaboration with
the UAC administrator.

The user role-based policy feature enables you to specify user roles as match criteria
in IDP rulebase and application policy enforcement (APE) rulebase rules. Matching
based on user role rather than IP address both simplifies and finely tunes your rules.
In many networks, the IP address is dynamically assigned. To protect your network,
you would have to cast a wide net for traffic sources. In most cases, you would specify
a subnet mask or specify Any source (in the latter case, this means you really are
not matching on source). For the purpose of intrusion detection and prevention, a
wide net is not necessarily a bad thing: you do want to inspect any session that could
potentially contain an attack. Use of role-based rules with a terminal match, however,
will improve performance by providing faster matching with specific source targets
and rulebase termination. In addition, you are likely to find that user role-based logs
are easier to analyze because they provide visibility into the user role associated with
an attack event or application usage.

UAC integration with IDP Series appliances also improves end user experience
authenticating to your network. In a UAC deployment, you use the Host Checker
feature to quarantine users with vulnerable hosts. Instead of using a firewall to shut
down access to network resources, you can use IDP security policies to enable access
and inspect the traffic to guard against threats.

In the APE rulebase, role-based rules are indispensable to supporting the business
cases that demand a nuanced approach to application policy enforcement. They
enable you to enforce business policies such as “Contractors, Part-Time, and
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Temporary employees may not use peer-to-peer filesharing applications; full-time
employees may use them, but only with a limited pool of bandwidth.”

To deploy the user role-based feature:

1. Read the release notes for the IDP and UAC releases to verify version compatibility
requirements.

2. Deploy a UAC solution for user access to the network. For details, see the Unified
Access Control Administration Guide.

3. Use the UAC user interface to create the user roles you want to use in your
security policy:

■ For security rules, you want to leverage results of the Host Checker to map
users to roles that identify vulnerabilities, such as “Laptop Users,”
“Unauthorized Instant Messenger Installed,” or “Windows XP Patch
Required.”

■ For application policy enforcement rules, you want to map users to roles
that reflect the business rule, such as Contractor, Part-Time, and Temporary.

For details, see the Unified Access Control Administration Guide or UAC online
Help.

4. Configure communication between the UAC appliance and the IDP appliance so
you can use the IDP role-based policy feature:

■ From the IDP side, you use the Appliance Configuration Manager (ACM) to
generate a one-time password the UAC appliance can use to connect to the
IDP appliance.

■ From the UAC side, you configure the connection to the IDP appliance,
specifying the IP address, port 7103, and the one-time password.

For details, see the UAC online Help.

5. Use the IDP appliance command-line interface to verify integration. You can use
CLI commands to verify connectivity with the IC Series device and to display the
user session table, which is populated by the IC Series appliance.

For details, see the IDP Administration Guide.

6. In NSM, create a security policy with role-based rules. The roles you specify are
the roles created and managed in UAC.

7. Push the security policy from NSM to the IDP appliance.

Related Topics The following related topic is included in the IDP Concepts and Examples Guide:

■ Understanding Communication Between IDP Series and IC Series Appliances on
page 179

■ IDP Rulebase Example: User-Role-Based Policies on page 104

■ APE Rulebase Example: Limiting Bandwidth to Instant Messaging and Peer-to-Peer
Traffic in the Enterprise on page 123

■ APE Rulebase Example: Using User-Role-Based Rules to Support Tiered
Subscriptions on page 124
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The following related topic is included in the IDP Administration Guide:

■ Specifying Rule Match Conditions (NSM Procedure)

Using Application Identification

The application identification feature enables the IDP engine to detect applications
running on standard ports or nonstandard ports. Port independent application
identification enhances both security and manageability by eliminating the need to
manually and comprehensively configure application-port mapping for the service
objects used in the IDP rulebase and APE rulebase rules.

The application identification feature uses application signatures provided by the
Juniper Security Center team (J-Security Center) to identify the session application.
J-Security Center updates signatures and develops new ones as necessary. Updates
are provided to customers during routine detector engine updates. You cannot create
custom signatures.

When the application identification feature identifies a new application, it caches the
result (the destination address, port, protocol, and service) to reduce processing
required for subsequent sessions.

When the IDP engine processes security policy rules, it examines the session
beginning with the first packet to determine a match. To match service or application,
the IDP engine first tries to match the session against the application identification
cache to determine the application. If the session does not match the application
identification cache, the IDP engine processes the session against the application
signatures to determine the application. If the IDP engine is still unable to determine
the application, it uses the standard application protocol and port.

In IDP rulebase rules, with application identification enabled, you set the service
object in rules to Default to allow the application identification feature to determine
the correct service. If you set service to a specific service object, application
identification is not applied and the rule is processed using the service object
properties.

In APE rulebase rules, you can specify a match based on application or service. With
the application identification feature enabled, you should specify a match based on
application. If you disable application identification and specify a match based on
application, the IDP engine uses the standard application protocol and port for the
application. If your application is not supported by the application identification
feature, you can specify a match based on service and configure a custom service
object.

The application identification feature is enabled by default. You have the option to
disable the feature and to tune the following parameters (if necessary):

■ Maximum number of sessions utilizing application identification

■ Maximum memory used by application identification

■ Maximum memory for saving TCP or UDP packets per session
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For complete procedures on tuning these parameters, see the IDP Administration
Guide.

Related Topics The following related topic is included in the IDP Concepts and Examples Guide:

■ IDP Rulebase Example: Using Application Identification on page 107

■ Understanding the IDP Rulebase on page 91

■ J-Security Center Updates Overview on page 17

The following related topic is included in the IDP Administration Guide:

■ Specifying Rule Match Conditions (NSM Procedure)

Using Attack Objects

If the session matches rule settings for source, destination, service, and VLAN tag
ID, the IDP engine decodes the traffic and inspects the session packets for the attack
objects specified in the rule. The following topics provide guidelines for using attack
objects in IDP rulebase rules:

■ Attack Objects Overview on page 97

■ Understanding Predefined Attack Objects and Attack Object Groups on page 98

■ Using Custom Attack Object Groups on page 99

■ Using Custom Attack Objects on page 100

Attack Objects Overview

When traffic matches an IDP rulebase source/destination/service condition, the IDP
engine inspects the traffic for the attack objects you specify.

A signature attack object detects known attacks using stateful attack signatures. An
attack signature is a pattern that always exists within an attack; if the attack is present,
so is the attack signature. With stateful signatures, the IDP engine can look for the
specific protocol or service used to perpetrate the attack, the direction and flow of
the attack, and the context in which the attack occurs. Stateful signatures produce
few false positives because the context of the attack is defined, eliminating huge
sections of network traffic in which the attack would not occur.

A protocol anomaly attack object  identifies unusual activity on the network. It detects
abnormal or ambiguous messages within a connection according to the set of rules
for the particular protocol being used. Protocol anomaly detection works by finding
deviations from protocol standards, most often defined by RFCs and common RFC
extensions. Most legitimate traffic adheres to established protocols. Traffic that does
not, produces an anomaly, which may be created by attackers for specific purposes,
such as evading an IPS.

A compound attack object combines multiple signatures and/or protocol anomalies
into a single object. Traffic must match all of the combined signatures and/or protocol
anomalies to match the compound attack object; you can specify the order in which
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signatures or anomalies must match. Use compound attack objects to refine your
IDP policy rules, reduce false positives, and increase detection accuracy. A compound
attack object enables you to be very specific about the events that need to occur
before the IDP engine identifies traffic as an attack. You can use And, Or, and Ordered
and operations to define the relationship among different attack objects within a
compound attack and the order in which events occur.

Attack object definitions also include data fields to help you group and manage attack
objects and use them in security policies. These data fields include category, severity,
keywords, and a recommended flag.

Predefined attack objects provided by the Juniper Networks Security Center (J-Security
Center) team also contain a recommended action for the IDP appliance to take against
the attack session.

Custom attack objects are ones you create, if your security policy requires more or
less protection, or more or less accounting than what the predefined attack objects
provide.

Both predefined and custom attack objects are stored in the attack object database.

When you add attack objects to an IDP rulebase rule, you can add attack objects by
group or individually.

Understanding Predefined Attack Objects and Attack Object Groups

The Juniper Networks Security Center (J-Security Center) team has developed more
than 600 attack objects and these are included in the attack object database used in
IDP security policies.

Table 26 on page 98 describes the attack object groups provided by the J-Security
Center.

Table 26: Predefined Attack Object Groups

ContentsGroup

Contains two subgroups: anomaly and signature. Within each subgroup, attack objects are grouped
by severity.

Attack Type

Contains subgroups based on category. Within each category, attack objects are grouped by severity.Category

Contains the following subgroups: BSD, Linux, Solaris, and Windows. Within each operating system,
attack objects are grouped by services and severity.

Operating System

Contains the following subgroups: Critical, Major, Minor, Warning, Info. Within each severity, attack
objects are grouped by category. Our severity rating is not based on CVSS (Common Vulnerability
Scoring System). We do include data from Bugtraq (Symantec) and CVE (Common Vulnerabilities
and Exposures).

Severity

Contains subgroups based on Web services. Within services, attacked objects are grouped by
severity.

Web Services

Contains attack objects that have a significant affect on IDP performance.Miscellaneous
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Table 26: Predefined Attack Object Groups (continued)

ContentsGroup

Contains attack objects where the attack is detected in the server-to-client direction. This group
contains a hierarchy of subgroups that includes all of the above categories.

Response

J-Security Center updates the attack object database to provide new attack objects,
to revise severities or recommendations, or to remove obsolete attack objects. We
recommend you schedule routine, automatic updates.

Using Custom Attack Object Groups

A dynamic group contains members that match properties you specify for the group.
You use dynamic groups so that an attack database update automatically populates
the group with relevant members. This eliminates the need to review each new
signature to determine if you need to use it in your existing security policy. A
predefined or custom dynamic group can only contain attack objects and not attack
groups. Dynamic group members can be either predefined or custom attack objects.

A static group is not automatically updated with new members. It contains only the
attack objects or groups you have added. Use static groups when you do not want
your attack group dynamically populated during NSM updates. For example, if you
customize the action for predefined attack objects to meet your company’s security
policy guidelines, you can create one or more static groups to contain these attack
objects. When you perform an NSM attack object update, your static group will not
be affected.

There are two types of static groups: predefined static groups and custom static
groups. Predefined static groups are categories of groups provided by default.

A custom static group can include the same members as a predefined static group
(predefined attack objects, predefined static groups, and predefined dynamic groups),
plus the following members:

■ Custom attack objects

■ Custom dynamic groups

■ Other custom static groups

Static groups require more maintenance than dynamic groups because you must
manually add or remove attack objects in a static group to manage the members.
However, you can include a dynamic group within a static group to automatically
update some attack objects. For example, the predefined attack object group
Operating System is a static group that contains four predefined static groups: BSD,
Linux, Solaris, and Windows. The BSD group contains the predefined dynamic group
BSD-Services-Critical, to which attack objects can be added during an attack database
update.
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Using Custom Attack Objects

The attack objects provided by the Juniper Networks Security Center (J-Security
Center) team cover most cases for small business, enterprise, and service provider
networks. Your business might encounter cases where you must modify a predefined
attack object or create a new one. For example:

■ You read a security advisory about a known attack and want to create an attack
object that detects the malicious traffic described in that advisory.

■ You need to update or improve an existing third-party signature (such as a Snort
signature).

■ You want to customize an existing signature or protocol anomaly attack object
for your local environments. For example, you might need to customize a
signature to prevent false positives generated by a specific application running
on your network.

■ You want to detect specific activity on your network. For example, you might
want to detect abnormal traffic (possibly malicious), remote log-ins, or brute
force attacks that attempt to guess usernames and passwords.

For a complete tutorial on creating custom attack objects, see the IDP Custom Attack
Objects Reference and Examples Guide.

Related Topics The following related topic is included in the IDP Concepts and Examples Guide:

■ J-Security Center Updates Overview on page 17

■ Understanding the IDP Rulebase on page 91

■ IDP Rulebase Example: Using Recommended Attack Objects on page 109

■ Exempt Rulebase Example: Exempting an Attack Object on page 115

The following related topic is included in the IDP Administration Guide:

■ Attack Objects Task Summary

Understanding IDP Rulebase Actions

Actions are responses to sessions that match the source/destination/service condition
and the attack object. Actions are what protect your network from attacks.

If a packet triggers multiple rule actions, the IDP appliance takes the most severe
action. For example, if the rules dictate that a packet receive a DiffServ marking and
be dropped, the IDP appliance will take the more severe action, which is dropping
the packet.

Predefined attack objects include a recommended action. The recommended action
is generally related to attack severity, but other factors are considered. Table 27 on
page 101 lists the recommended actions by attack severity.
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Table 27: Recommended Action by Attack Severity

Recommended ActionDescriptionSeverity

Drop Packet, Drop
Connection

Attacks attempt to evade an intrusion prevention system, crash a
machine, or gain system-level privileges.

Critical

Drop Packet, Drop
Connection

Attacks attempt to crash a service, perform a denial of service, install
or use a Trojan, or gain user-level access to a host.

Major

NoneAttacks attempt to obtain critical information through directory traversal
or information leaks.

Minor

NoneAttacks are obsolete or attempt to obtain noncritical information or scan
the network.

Warning

NoneAttacks are normal, harmless traffic containing URLs, DNS lookup
failures, and SNMP public community strings. You can use informational
attack objects to obtain information about your network.

Info

If you choose, you can set a different action. Table 28 on page 101 describes the
actions you can set for IDP rulebase rules.

Table 28: IDP Rulebase Actions

DescriptionAction

Inspects for attacks but takes no action against the connection if an attack is found.None

Does not take action and ignores the remainder of the session.Ignore

Assigns the indicated service-differentiation value to the packet, and then passes it on normally.
Set the service-differentiation value in the dialog box that appears when you select this action in
the rulebase.

NOTE: In sniffer mode, the IDP appliance is not in the path of network traffic. Therefore, this action
has no effect in sniffer mode.

Diffserv Marking

Drops a matching packet before it can reach its destination but does not close the connection. Use
this action in rules focused on traffic that is prone to spoofing, such as UDP traffic. Dropping a
connection for such traffic could result in a DoS that prevents you from receiving traffic from a
legitimate source address.

NOTE: In sniffer mode, the IDP appliance is not in the path of network traffic. Therefore, this action
has no effect in sniffer mode.

Drop Packet

Drops the connection without sending an RST packet to the sender, preventing the traffic from
reaching its destination. Use this action to drop connections for traffic that is not prone to spoofing.

NOTE: In sniffer mode, the IDP appliance is not in the path of network traffic. Therefore, this action
has no effect in sniffer mode.

Drop Connection
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Table 28: IDP Rulebase Actions (continued)

DescriptionAction

Closes the connection and sends an RST packet to both the client and the server.

NOTE: In sniffer mode, the IDP appliance is not in the path of network traffic. However, if you use
ACM to configure a sniffer mode reset interface, the IDP device can send an RST packet to both
the client and server but does not close the connection.

Close Client and Server

Closes the connection to the client but not to the server.

NOTE: In sniffer mode, the IDP appliance is not in the path of network traffic. However, if you use
ACM to configure a sniffer mode reset interface, the IDP device can send an RST packet to both
the client and server but does not close the connection.

NOTE: In VLAN tagged MPLS traffic, the Close Client action drops the connection instead of closing
it.

Close Client

Closes the connection to the server but not to the client.

NOTE: In sniffer mode, the IDP appliance is not in the path of network traffic. However, if you use
ACM to configure a sniffer mode reset interface, the IDP device can send an RST packet to both
the client and server but does not close the connection.

Close Server

If the IDP engine matches an attack, it can take action not only against the current
session but also against subsequent network traffic from the same IP address. Such
actions are called IP actions. By default, the specified IP action is permanent (timeout
= 0). If you prefer, you can set a timeout.

Table 29 on page 102 describes IDP rulebase IP actions.

Table 29: IDP Rulebase IP Actions

DescriptionIP Action

IDP blocks the matching connection and future connections that match combinations of the following
properties you specify:

■ Source IP address

■ Source subnet

■ Protocol

■ Destination IP address

■ Destination subnet

■ Destination port

■ From zone

IP Block
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Table 29: IDP Rulebase IP Actions (continued)

DescriptionIP Action

IDP closes the matching connection and future connections that match combinations of the following
properties you specify:

■ Source IP address

■ Source subnet

■ Protocol

■ Destination IP address

■ Destination subnet

■ Destination port

■ From zone

IP Close

IDP does not take any action against future traffic but logs the event or sends an alert.IP Notify

Related Topics The following related topic is included in the IDP Concepts and Examples Guide:

■ Understanding the IDP Rulebase on page 91

■ IDP Rulebase Example: Using Recommended Actions on page 111

The following related topic is included in the IDP Administration Guide:

■ Specifying Rule Session Action (NSM Procedure)

Understanding IDP Rulebase Notification Options

You use notification features to help you manage your network, analyze your network
security, validate your security policy, and capture forensic evidence of attacks. You
can set notification options per rule.

The first time you design a security policy, you might be tempted to log all data for
all attacks and let the policy run indefinitely. We recommend you take a more refined
approach. Some attack objects are informational only, and others can generate false
positives and redundant logs. If you become overloaded with data, you can miss
something important. Remember that security policies that generate too many log
records are hazardous to the security of your network, as you might discover an
attack too late or miss a security breach entirely as a result of having to sift through
hundreds of log records. Excessive logging can also affect IDP throughput,
performance, and available disk space. A good security policy generates enough logs
to fully document only the important security events on your network.

By default, logging is enabled for IDP rulebase rules. Table 30 on page 104 describes
the notification options you can configure. You also have the option to disable logging.
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Table 30: IDP Rulebase Notification Options

DescriptionOption

You can enable the following delivery and handling options for logs:

■ Send to NSM log viewer.

■ Send to NSM log viewer and flag as an alert.

■ Send to an e-mail address list.

■ Send to syslog.

■ Send to SNMP trap.

■ Save in XML format.

■ Save in CVS format.

■ Process with a script.

Event logs and alerts

Viewing the packets used in an attack on your network can help you determine the extent of the
attempted attack and its purpose, whether or not the attack was successful, and any possible
damage to your network.

If multiple rules with packet capture enabled match the same attack, IDP captures the maximum
specified number of packets. For example, you configure rule 1 to capture 10 packets before and
after the attack, and you configure rule 2 to capture 5 packets before and after the attack. If both
rules match the same attack, IDP attempts to capture 10 packets before and after the attack.

You can capture up to 256 packets before the event and 256 packets after the event.

NOTE: If necessary, you can improve performance by logging only the packets received after the
attack.

Packet captures

For complete procedures on setting IDP rulebase notification options, see the IDP
Administration Guide.

Related Topics The following related topic is included in the IDP Concepts and Examples Guide:

■ Understanding the IDP Rulebase on page 91

■ IDP Logs Overview on page 51

The following related topic is included in the IDP Administration Guide:

■ IDP Logs and Reports in NSM Task Summary

IDP Rulebase Example: User-Role-Based Policies

Suppose your enterprise uses Juniper Networks Unified Access Control (UAC) to
authenticate access to the corporate network. When you initially rolled out the
solution, Host Checker quarantined and denied network access to many users with
noncompliant systems, and you received a lot of negative feedback about end user
inconvenience and lost productivity. You can ameliorate these concerns when you
deploy the IDP appliance with user session signaling from UAC. When the IDP
appliance is protecting your network, users who were formerly flagged for quarantine
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because Host Checker identified vulnerabilities do not need to be denied access.
With role-based IDP security policies, you can adopt a remediation plan that allows
access, and even if the vulnerability has been exploited, your network will be protected
by the IDP role-focused security policy.

To deploy this solution, follow these basic steps:

1. Read the release notes for the IDP Series appliance and the IC Series appliance
to verify version compatibility requirements.

2. Deploy a UAC solution for user access to the network. For details, see the Unified
Access Control Administration Guide.

3. Use UAC to create roles you want to use in your security policy. For security
rules, you want to leverage results of the Host Checker to map users with
vulnerable systems to roles that identify the vulnerabilities, such as “Laptop
Users,” “Unauthorized Instant Messenger Installed,” or “Windows XP Patch
Required.” Figure 36 on page 105 shows the IC Series Admin Console Role
Mapping page.

Figure 36: IC Series Admin Console: Configuring User Roles

For details on configuring roles and role mapping, see the Unified Access Control
Administration Guide or UAC online Help.

4. Configure communication between the IC Series appliance and the IDP Series
appliance so you can use the IDP user-role-based policy feature:

■ From the IDP Series side, you use the Appliance Configuration Manager
(ACM) to generate a one-time password the IC Series appliance will use to
connect to the IDP Series appliance. Figure 37 on page 106 shows the ACM
page used to generate a password for the IC Series connection.
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Figure 37: ACM: Generating a One-Time Password for the Connection from the IC
Series Appliance

■ From the IC Series side, you configure the connection to the IDP appliance,
specifying the IP address, port 7103, and the one-time password. Figure 38
on page 106 shows the IC Series Admin Console Sensor Configuration page.

Figure 38: IC Series Admin Console: Configuring the Connection to the IDP Appliance

For details, see the UAC online Help.

5. In NSM, configure IDP rulebase rules that inspect traffic from users with
vulnerable systems. Push the security policy to the IDP appliance.

Figure 39 on page 107 shows a rule where the IDP appliance inspects traffic from
vulnerable hosts for the relevant Recommended attack objects.
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Figure 39: IDP Rulebase: User-Role-Based Rules

Related Topics The following related topics are included in the IDP Concepts and Examples Guide:

■ User-Role-Based Policy Feature Overview on page 94

■ Understanding Communication Between IDP Series and IC Series Appliances on
page 179

The following related topics are included in the IDP Administration Guide:

■ Generating a One-Time Password for Communication with SA Series SSL VPN
and IC Series Unified Access Control Appliances (ACM Procedure)

■ Verifying Integration with an IC Series Unified Access Control Appliance

IDP Rulebase Example: Using Application Identification

This example demonstrates the usefulness of the application identification feature.

Suppose your corporate security policy changes, and you are charged with inspecting
peer-to-peer traffic from applications such as Kazaa, Torrent, or eDonkey. To add
new rules that inspect peer-to-peer traffic, you would take the following steps:

1. Analyze network traffic to identify peer-to-peer applications running in your
network.

2. Research and identify the pattern for every peer-to-peer application.

3. Create signature and port definitions for every peer-to-peer application.

4. Verify the effectiveness of the signatures.

5. Repeat these steps several times for each peer-to-peer application.

6. Continually monitor the network for peer-to-peer traffic that uses nonstandard
ports so you can update your signature set to inspect traffic over these ports.

Juniper Networks Security Center saves you much of this work. With predefined
attack objects and application identification enabled, you can create a rule whose
only elements are the predefined attack object and the service match set to Default.

Figure 40 on page 108 is an example of a simple rule that detects any chat application.
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Figure 40: A Simplified Rule Enabled by the Application Identification Feature

When the IDP process engine identifies a source/destination/Default service match,
it examines the session against the application signatures to determine the application,
regardless of which port is used. IDP then decodes the traffic and inspects it for the
attack objects related to that application.

Related Topics The following related topics are included in the IDP Concepts and Examples Guide:

■ Using Application Identification on page 96

■ Understanding the IDP Rulebase on page 91

IDP Rulebase Example: Specifying the Default Service

This example demonstrates the usefulness of specifying the value Default for the
service match parameter in IDP rulebase rules.

When you specify a service, you have the option to specify:

■ A service object

■ Any

■ Default

If you specify the value Default, the rule gets the service parameter from the attack
object. For example, if the attack object service binding specifies FTP, and you specify
the value Default for service, the match value is FTP.

Figure 41 on page 108 is an example of a rule where the default service resolves to
FTP.

Figure 41: Default Service
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TIP: With application Identification enabled, the IDP process engine identifies services
even if they are running on nonstandard ports.

If you disable application identification and specify Default, the IDP process engine
assumes that standard ports are used for the service.

NOTE: If you do not enable application identification and your service uses
nonstandard ports, you must create a custom service object. For procedures, see the
NSM documentation.

Related Topics The following related topics are included in the IDP Concepts and Examples Guide:

■ IDP Rulebase Example: Using Application Identification on page 107

■ Understanding IDP Rulebase Rule Match Settings on page 92

■ Understanding the IDP Rulebase on page 91

IDP Rulebase Example: Using Recommended Attack Objects

This example demonstrates the usefulness of Juniper Networks Security Center
(J-Security Center) recommended attack objects.

When you add attack objects to an IDP rulebase rule, you have the option of adding:

■ Predefined attack objects by group

■ Recommended predefined attack objects by group

■ Custom attacks

Figure 42 on page 110 shows recommended attack objects in the dialog box for adding
attack objects to the IDP rulebase.
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Figure 42: Recommended Attack Objects

The groups marked Recommended have the following special features:

■ Recommended attacks have been identified and coded for their recommended
purpose by J-Security Center, a world class team of security experts.

■ Recommended attack groups are dynamic groups, so members are added or
deleted as appropriate during NSM attack database updates.

When you get started with IDP, you should use the recommended attack objects and
enable notification for rule matches. Later, you can turn off logging (at your discretion).
If you find you need to customize attack object properties, you can make a copy of
the recommended attack object and modify it with your required properties. Then
you can replace the recommended attack object with the custom attack object in
your IDP rulebase rule.

NOTE: If you use a recommended attack object as the basis for a custom attack
object, be sure to view the original attack object from time-to-time after attack
database updates. If J-Security Center makes changes to the original, you must
manually propagate changes to your custom attack object.

BEST PRACTICE: Each attack object specified in an IDP rulebase rule has a
performance cost. We recommend that your rules include only the attack objects
that are applicable to the rule destination server and only those of a severity that
concerns you. We also recommend that you create more rules with a few attack
objects in each rather than fewer rules with many attack objects.
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Related Topics The following related topics are included in the IDP Concepts and Examples Guide.

■ Using Attack Objects on page 97

■ J-Security Center Updates Overview on page 17

■ Understanding the IDP Rulebase on page 91

IDP Rulebase Example: Using Recommended Actions

This example demonstrates the usefulness of Juniper Networks Security Center
(J-Security Center) recommended actions.

When you specify a rule action, you have the option to specify:

■ No action

■ A specific action

■ The value Recommended

Recommended actions are coded in the predefined attack object by the J-Security
Center team. The J-Security Center team codes a recommended action in all
predefined attack objects, not just the recommended attack objects. When you use
the recommended action, you leverage the experience and expertise of the J-Security
Center team.

Figure 43 on page 111 shows an IDP rulebase rule with action set to Recommended.

Figure 43: Recommended Action

When you update the NSM attack database, any changes to recommended actions
are also automatically updated.
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When you get started with IDP, you should use the recommended actions and enable
notification for rule matches. If you find these settings meet your needs, you can
turn off logging (at your discretion). If you find you prefer a different action, you can
specify a different action.

Related Topics The following related topics are included in the IDP Concepts and Examples Guide.

■ Understanding IDP Rulebase Actions on page 100

■ Understanding the IDP Rulebase on page 91
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Chapter 11

The Exempt Rulebase

This chapter explains how to use the Exempt rulebase to reduce logs for false
positives. It includes the following topics:

■ Understanding the Exempt Rulebase on page 113

■ Exempt Rulebase Example: Exempting a Source Destination Pair on page 114

■ Exempt Rulebase Example: Exempting an Attack Object on page 115

Understanding the Exempt Rulebase

The Exempt rulebase enhances manageability of the IDP solution by enabling you
to categorically exempt traffic segments you know to be safe from processing by the
IDP rulebase.

A false positive, also known as a false alert, is a situation in which benign traffic
causes an intrusion detection system (IDS) to generate an alert. Too many false
positives can degrade performance and produce oversized log files.

The IDP engine reduces false positives by using stateful signatures to detect known
attacks. A stateful signature knows the pattern and location of the attack, and produces
fewer false positives than regular attack signatures because it does not inspect network
traffic that cannot contain the attack.

To further increase detection accuracy and reduce false positives, the IDP engine
uses:

■ Flow tracking to correlate multiple TCP/UDP connections into a single flow to
determine the validity of the traffic.

■ IP defragmentation and TCP reassembly to reconstruct fragmented traffic.

■ Protocol normalization to normalize traffic to a common format for analysis.

Still, a few false positives from your IDS are normal, especially when you are testing
new security policies. You can use the Exempt rulebase to manage these cases.

When you create rules for the Exempt rulebase, you specify:

■ A source/destination/service match condition

■ At least one attack object
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NOTE: The Exempt rulebase is a non-terminal rulebase. That is, the IDP process
engine processes all rules in the rulebase.

Related Topics The following related topics are included in the IDP Concepts and Examples Guide.

■ Understanding the Components of an IDP Security Policy on page 81

■ Understanding the Rule-Matching Algorithm on page 84

■ Understanding the IDP Rulebase on page 91

■ Exempt Rulebase Example: Exempting a Source Destination Pair on page 114

■ Exempt Rulebase Example: Exempting an Attack Object on page 115

The following related topics are included in the IDP Administration Guide.

■ Configuring Exempt Rulebase Rules (NSM Procedure)

Exempt Rulebase Example: Exempting a Source Destination Pair

Suppose in your security policy implementation there are schedule phases where
your security team probes your internal network for vulnerabilities and you want
IDP to generate logs, and phases where you have put your security policy in place
and now want to exclude security team traffic from the logs generated by IDP. To
support these alternative phases, you can create an Exempt rulebase rule and toggle
it off and on.

To create an Exempt rulebase rule:

1. Create address objects that contain the security team IP addresses and the
protected servers.

2. Add the Exempt rulebase to your security policy.

3. Add a rule that specifies the source/destination match condition to exempt.

4. Add the All group of attack objects.

Figure 44 on page 114 shows an Exempt rulebase rule.

Figure 44: Exempt Rulebase Rule

To toggle the rule off, right-click it and select Disable.
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Related Topics The following related topics are included in the IDP Concepts and Examples Guide.

■ Understanding the Exempt Rulebase on page 113

■ Example: Fine-Tuning a Security Policy on page 153

The following related topic is included in the IDP Administration Guide.

■ Configuring Exempt Rulebase Rules (NSM Procedure)

Exempt Rulebase Example: Exempting an Attack Object

Suppose your security policy detects HTTP Buffer Overflow: Header attacks on your
internal network, but you know this can safely be ignored. You can exempt this
traffic from inspection to optimize IDP performance and eliminate unnecessary logs.

To exempt an attack object:

1. If you have not done so already, create an address object for your internal
network.

2. Add the Exempt rulebase to your security policy.

3. Add a rule that specifies a source that is the internal network and destination
that is anywhere.

4. Add the relevant attack object. In this example, add HTTP Buffer Overflow:
Header.

Related Topics The following related topics are included in the IDP Concepts and Examples Guide.

■ Understanding the Exempt Rulebase on page 113

■ Example: Fine-Tuning a Security Policy on page 153

The following related topic is included in the IDP Administration Guide.

■ Configuring Exempt Rulebase Rules (NSM Procedure)
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Chapter 12

Application Policy Enforcement Rulebase

This chapter explains how you can use the application policy enforcement (APE)
rulebase to limit bandwidth available to traffic that matches your rules. It includes
the following topics:

■ Understanding the APE Rulebase on page 117

■ Understanding APE Rulebase Match Conditions on page 118

■ Understanding APE Rulebase Actions on page 120

■ Understanding APE Rulebase Notification Options on page 122

■ APE Rulebase Example: Limiting Bandwidth to Instant Messaging and Peer-to-Peer
Traffic in the Enterprise on page 123

■ APE Rulebase Example: Using User-Role-Based Rules to Support Tiered
Subscriptions on page 124

Understanding the APE Rulebase

The APE rulebase (application policy enforcement) leverages the application
identification feature to enable you to manage network traffic based on application.
APE rules match source-destination-application criteria. APE rules do not use attack
objects.

You can configure rule actions to meet application policy enforcement objectives.
For example:

■ To use the IDP appliance like an application firewall, you can specify drop or
close actions. Matching traffic is terminated at the IDP appliance.

■ To set a cap on available bandwidth for disfavored applications or use of certain
applications by certain users, you can specify a rate limiting action. When the
limit is reached, the IDP appliance begins dropping matching traffic.

■ To support deployments where you use your other network equipment to
implement quality-of-service (QoS) guarantees, you can specify a DiffServ marker
action. The IDP engine applies the DSCP marker to matching applications or
user roles.

Any traffic not terminated by APE rules can be inspected subsequently by the IDP
rulebase and other rulebases.

Understanding the APE Rulebase ■ 117



When you create rules for the APE rulebase, you specify:

■ Match conditions

■ An action

■ Notification options

Related Topics The following related topics are included in the IDP Concepts and Examples Guide:

■ Understanding APE Rulebase Match Conditions on page 118

■ Understanding APE Rulebase Actions on page 120

■ Understanding APE Rulebase Notification Options on page 122

■ APE Rulebase Example: Limiting Bandwidth to Instant Messaging and Peer-to-Peer
Traffic in the Enterprise on page 123

■ APE Rulebase Example: Using User-Role-Based Rules to Support Tiered
Subscriptions on page 124

The following related topic is included in the IDP Administration Guide:

■ Configuring the APE Rulebase (NSM Procedure)

Understanding APE Rulebase Match Conditions

IDP inspects the session beginning with the first packet to determine whether it
matches an APE rulebase rule. If the session matches all of the rule settings for source
or user role, destination, service or application, and VLAN tag ID, IDP takes the action
specified by the rule. If the session matches only some of the rule settings, IDP does
not apply the rule action.

The APE rulebase is a terminal rulebase. Rules are evaluated in numerical order. The
first rule to match is applied and subsequent rules are not processed.

If an APE rule matches but the action does not drop the connection, IDP also processes
additional rulebases to inspect for attacks. If an attack rule determines the connection
be closed or dropped, that action is taken and the rate-limiting action is not required.

Table 31 on page 118 provides guidelines for setting IDP rulebase match conditions.

Table 31: APE Rulebase Match Condition Guidelines

GuidelineSetting

Not applicable for standalone IDP appliances.From zone/To zone
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Table 31: APE Rulebase Match Condition Guidelines (continued)

GuidelineSetting

Requires one of the specified source IP addresses to match the session for the rule to be applied.
You can add address objects for hosts, groups, or network address ranges.

You must choose between source IP address or user role as match criteria for a rule. You cannot
configure both for one rule.

Specify Any to not use source as a key to your match.

NOTE: If a value for user role matches, the source parameter is not used.

Source

Requires one of the specified user roles to match the session for the rule to be applied.

You must choose to configure either source IP address or user role as match criteria for a rule. User
role-based rules are evaluated before IP address-based rules. If a user-role based rule matches, the
rule is applied and IP address-based rules are not consulted.

Matching based on user role depends on integration with a Juniper Networks IC Series Unified
Access Control appliance.

User Role

Requires one of the specified destination IP addresses to match the session for the rule to be applied.
You can add address objects for hosts, groups, or network address ranges.

Specify Any to not use destination as a key to your match.

Destination

Requires one of the specified services to match the session for the rule to be applied. Services are
Application Layer protocols that define how data is structured as it travels across the network. The
IDP engine can inspect services that use TCP, UDP, RPC, and ICMP Transport Layer protocols. If
the application running on the destination server uses standard ports, you can select from predefined
services. If the application running on the destination server uses nonstandard ports, you must
create a custom service object.

If you specify named values for both service and application, only the application value is used.

We recommend you specify Default for the service parameter and configure the application
parameter instead.

Specify Any to not use service as a key to your match.

NOTE: To apply an APE action to all traffic matching source and destination parameters, set both
the service parameter and the application parameter to Any.

Service

Requires one of the specified applications to match the session for the rule to be applied. The
predefined list of applications is populated by the application identification feature. The application
identification feature identifies the application regardless of port. Port-independent application
identification simplifies rule configuration and ensures you do not miss applications running on
nonstandard ports. For this reason, we recommend you use the application parameter instead of
the service parameter whenever possible.

If you specify named values for both service and application, only the application value is used.

Specify Any to not use application as a key to your match.

NOTE: To apply an APE action to all traffic matching source and destination parameters, set both
the service parameter and the application parameter to Any.

Application
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Table 31: APE Rulebase Match Condition Guidelines (continued)

GuidelineSetting

Requires one of the specified VLAN tags to match the session for the rule to be applied.

Specify Any to not use VLAN tag as a key to your match.

VLAN

TIP: You can use Profiler to identify the destination servers and services that are
included in your network. In NSM, you can create address objects and service objects
to facilitate configuration. One benefit of using objects is that you can configure them
once and then use them in multiple rules. For details, see the NSM online Help.

Related Topics The following related topics are included in the IDP Concepts and Examples Guide:

■ Understanding the Rule-Matching Algorithm on page 84

■ Understanding the APE Rulebase on page 117

■ User-Role-Based Policy Feature Overview on page 94

■ Using Application Identification on page 96

The following related topic is included in the IDP Administration Guide:

■ Configuring the APE Rulebase (NSM Procedure)

Understanding APE Rulebase Actions

Actions are responses to sessions that match the source/destination/service or
source/destination/application condition.

Table 32 on page 121 describes the actions you can specify for APE rulebase rules.
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Table 32: IDP Rulebase Actions

DescriptionAction

Rate limits set an aggregate limit for all matching sessions. If a session matches an APE rule where
a rate limit has been set, the IDP engine performs a rate-limit check. If the limit has not been
reached, the IDP appliance forwards the packets. If the limit has been reached, the IDP appliance
behaves as if no bandwidth is available: it drops packets until the aggregate bandwidth falls below
the limit. When the IDP appliance drops packets, the TCP or UDP endpoints identify the packet
loss and slow down the transmission rate.

The rate limits that make sense for your business case depend on the bandwidth for your links. If
you have a 1-Gbps link, and want no more than 10% available to peer-to-peer traffic, the sum of
the rate limits you specify for all peer-to-peer rules should be less than 102.4 Mbps (in each direction).

You configure separate rate limits for client-to-server and server-to-client directions. For peer-to-peer
traffic, we recommend you set the same rate for each direction.

NOTE: For TFTP traffic, all traffic is counted as client-to-server traffic. A TFTP server responds to
get requests by establishing an ephemeral port from which to send the reply. In this case, both
directions appear to the IDP appliance as client-to-server flows. We recommend you set the same
rate for each direction.

Logs generated for traffic that match this rule display Rate Limit and traffic direction (c2s or s2c).

NOTE: In sniffer mode, the IDP appliance is not in the path of network traffic. Therefore, the rate
limiting action has no effect in sniffer mode.

Rate Limit

Does not perform rate limiting. Logs generated for traffic that match this rule display Accepted.None

Closes the connection and sends an RST packet to both the client and the server.

Logs generated for traffic that match this rule display Close.

NOTE: In sniffer mode, the IDP appliance is not in the path of network traffic. However, if you use
ACM to configure a sniffer mode reset interface, the IDP device can send an RST packet to both
the client and server but does not close the connection.

Close Client and Server

Closes the connection to the client but not to the server.

Logs generated for traffic that match this rule display Close Client.

NOTE: In sniffer mode, the IDP appliance is not in the path of network traffic. However, if you use
ACM to configure a sniffer mode reset interface, the IDP device can send an RST packet to both
the client and server but does not close the connection.

Close Client

Closes the connection to the server but not to the client.

Logs generated for traffic that match this rule display Close Server.

NOTE: In sniffer mode, the IDP appliance is not in the path of network traffic. However, if you use
ACM to configure a sniffer mode reset interface, the IDP device can send an RST packet to both
the client and server but does not close the connection.

Close Server
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Table 32: IDP Rulebase Actions (continued)

DescriptionAction

Assigns the DiffServ value you specify to the packet.

Logs generated for traffic that match this rule display DiffServ.

NOTE: In sniffer mode, the IDP appliance is not in the path of network traffic. Therefore, this action
has no effect in sniffer mode.

DiffServ Marking

Drops the connection without sending an RST packet to the sender, preventing the traffic from
reaching its destination. Use this action to drop connections for traffic that is not prone to spoofing.

Logs generated for traffic that match this rule display Drop Connection.

NOTE: In sniffer mode, the IDP appliance is not in the path of network traffic. Therefore, this action
has no effect in sniffer mode.

Drop Connection

Related Topics The following related topic is included in the IDP Concepts and Examples Guide:

■ Understanding the APE Rulebase on page 117

The following related topic is included in the IDP Administration Guide:

■ Configuring the APE Rulebase (NSM Procedure)

Understanding APE Rulebase Notification Options

Notification options determine whether the IDP appliance generates logs and alerts
when a session matches a rule. When enabled, the IDP appliance generates a log
that the client-to-server or server-to-client rate limit was reached. Logging is enabled
by default. Table 33 on page 122 describes the notification options.

Table 33: APE Rulebase Notification Options

DescriptionOption

You can enable the following delivery and handling options for logs:

■ Send to NSM log viewer.

■ Send to NSM log viewer and flag as an alert.

■ Send to an e-mail address list.

■ Send to syslog.

■ Send to SNMP trap.

■ Save in XML format.

■ Save in CVS format.

■ Process with a script.

You also have the option to disable logging.

Event logs and alerts

122 ■ Understanding APE Rulebase Notification Options

IDP Concepts and Examples Guide



Related Topics The following related topic is included in the IDP Concepts and Examples Guide:

■ Understanding the APE Rulebase on page 117

The following related topic is included in the IDP Administration Guide:

■ Configuring the APE Rulebase (NSM Procedure)

APE Rulebase Example: Limiting Bandwidth to Instant Messaging and Peer-to-Peer
Traffic in the Enterprise

Suppose you work for a company that has seen a rise in use of extracurricular
applications, such as instant messaging applications and peer-to-peer file sharing.
These applications pose a problem not only because of lost productivity, but also
because they use a lot of bandwidth. After due consideration and analysis, your
company decides to allow MSN instant messaging because it is used for legitimate
collaboration, but deny use of AIM or Yahoo Instant Messenger, which are popular
but not the company standard. At the same time, the company decides to address
the use of peer-to-peer file sharing. The executives would like to prohibit use of
peer-to-peer file sharing applications altogether, but to keep employees happy, they
decide to prohibit use by employees who are not full-time and limit use for all others.

You can leverage the role-based policy feature and the application policy enforcement
(APE) rulebase to enforce your company’s new policy.

To deploy this solution:

1. Deploy a Unified Access Control (UAC) solution for user access to your corporate
network.

2. Use the IC Series administration console to map users to roles, including:

■ Contractors

■ Part-Time

■ Temp

3. Configure communication between the IC Series and IDP so you can use the IDP
role-based policy feature.

4. Configure APE rules to:

■ Deny use of the two most popular instant messaging programs.

■ Limit bandwidth available to peer-to-peer applications.

In Figure 45 on page 124, rule 1 drops connections for AIM and Yahoo Instant
Messenger. Rule 2 drops peer-to-peer filesharing initiated by contractors, part-time
workers, and temporary workers. Rule 3 limits the bandwidth for other connections
initiated from within the corporate network to a limited pool of bandwidth.
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Figure 45: APE Rulebase: Role-based Rules Enforcing an Enterprise Resource Policy

Related Topics The following related topics are included in the IDP Concepts and Examples Guide:

■ Understanding the APE Rulebase on page 117

■ User-Role-Based Policy Feature Overview on page 94

The following related topic is included in the IDP Administration Guide:

■ Configuring the APE Rulebase (NSM Procedure)

APE Rulebase Example: Using User-Role-Based Rules to Support Tiered
Subscriptions

Internet service providers (ISP) can use the application policy enforcement (APE)
rulebase to support tiered subscriptions. Suppose your company offers Internet access
at premier, standard, and economy levels. Premier customers pay extra for unlimited
bandwidth. Standard customers pay a lower rate and have some limitations. Economy
customers pay a still lower rate and have additional limitations.

To deploy this solution:

1. Deploy a Juniper Networks IC Series Unified Access Control (UAC) appliance to
manage user access to the content provider Web site.

2. Use the IC Series administration console to map users to roles, including:

■ Premier–Customers who pay extra for unlimited access.

■ Standard–Customers who pay for standard service.

■ Economy–Customers who pay for basic service.

3. Configure communication between the the IC Series appliance and the IDP Series
appliance so you can use the IDP user-role-based policy feature.

4. Configure APE rules to limit bandwidth for specified applications according to
the user roles.

Figure 46 on page 125 shows a rule that gives premier customers unlimited access.
Standard customers get unlimited access to all applications except peer-to-peer
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filesharing, which is rate-limited. Economy customers get unlimited access to all
applications except peer-to-peer filesharing and Skype, which are rate-limited.

Figure 46: APE Rulebase: User-Role-Based Rules to Support Tiered Access

Related Topics The following related topics are included in the IDP Concepts and Examples Guide:

■ Understanding the APE Rulebase on page 117

■ User-Role-Based Policy Feature Overview on page 94

The following related topic is included in the IDP Administration Guide:

■ Configuring the APE Rulebase (NSM Procedure)
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Chapter 13

The Backdoor Rulebase

This chapter explains how the Backdoor rulebase protects your network and provides
guidelines for configuring Backdoor rulebase rules. It includes the following topics:

■ Understanding the Backdoor Rulebase on page 127

■ Understanding Backdoor Rulebase Match Settings on page 129

■ Understanding the Backdoor Rulebase Operation Setting on page 130

■ Understanding Backdoor Rulebase Actions on page 130

■ Understanding Backdoor Rulebase Notification Options on page 131

■ Backdoor Rulebase Example: netcat on page 132

Understanding the Backdoor Rulebase

The Backdoor rulebase detects the kind of interactive traffic produced during backdoor
attacks.

A backdoor is a mechanism installed on a host computer that facilitates unauthorized
access to the system. Attackers who have already compromised a system can install
a backdoor to make future attacks easier. When attackers type commands to control
a backdoor, they generate interactive traffic.

Unlike antivirus software, which scans for known backdoor files or executable files
on the host system, the IDP engine detects the interactive traffic that is produced
when backdoors are used. Interactive programs often transmit several short IP packets
containing individual keystrokes and their echoes, reflecting the real-time actions of
a user (or an attacker).

When detection is enabled, the IDP engine detects traffic that exceeds the interactive
traffic thresholds you set as runtime parameters. Figure 47 on page 128 shows the
backdoor detection settings in the NSM Device Manager configuration editor.
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Figure 47: NSM Device Manager: Sensor Settings > Run-Time Parameters

Table 34 on page 128 shows the defaults for backdoor detection runtime parameters.
You can tune these parameters if safe traffic in your network triggers false positives.

Table 34: Backdoor Detection Runtime Parameters

DefaultParameter

20,000Minimum interval between consecutive small packets (microseconds)

2,000,000Maximum interval between consecutive small packets (microseconds)

20Byte threshold for packet sizes in a backdoor connection (bytes)

20Minimum number of data carrying TCP packets (number)

20Minimum percentage of back-to-back small packets (percentage)

20Ratio of small packets to the total packets (percentage)

Detecting the signs of interactive traffic ensures that the IDP device can detect all
backdoors, both known and unknown. If the IDP device detects interactive traffic,
it can perform actions against the connection to prevent the attacker from further
compromising your network.

When you create rules for the Backdoor rulebase, you specify:

■ A source/destination/service match condition

■ Operation

■ Action

■ Notification options
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Related Topics The following related topics are included in the IDP Concepts and Examples Guide:

■ Understanding the Components of an IDP Security Policy on page 81

■ Understanding Backdoor Rulebase Match Settings on page 129

■ Understanding the Backdoor Rulebase Operation Setting on page 130

■ Understanding Backdoor Rulebase Actions on page 130

■ Understanding Backdoor Rulebase Notification Options on page 131

■ Backdoor Rulebase Example: netcat on page 132

The following related topics are included in the IDP Administration Guide:

■ Configuring Backdoor Rulebase Rules (NSM Procedure)

■ Modifying the IDP Device Configuration

Understanding Backdoor Rulebase Match Settings

Backdoor rulebase rules are triggered when source, destination, and service for the
traffic match the rule.

To detect incoming interactive traffic, set the source to Any and the destination to
the IP address of network device you want to protect.

To detect outgoing interactive traffic, set the source to the IP address of the network
device you want to protect and the destination to Any.

Specify not only the services on the network device you want to protect but also
interactive services that can be installed and used by attackers.

NOTE: Including Telnet, SSH, RSH, NetMeeting, or VNC as services can result in false
positives because these services are used to legitimately control a remote system.
We recommend that you not include these services in your service list.

TIP: You can use two rules to protect a large number of servers. Configure rule 1 to
match services you do not want to detect and set Operation to Ignore. Configure
rule 2 to match any traffic and set Operation to Detect.

TIP: In NSM, you can create address objects and service objects to facilitate
configuration. One benefit of using objects is that you can configure them once and
then use them in multiple rules. For details, see the NSM documentation.
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NOTE: The Backdoor rulebase is a terminal rulebase–that is, Backdoor rules are
inherently terminal rules. If a Backdoor rule matches, the IDP engine does not process
subsequent rules.

Related Topics The following related topics are included in the IDP Concepts and Examples Guide:

■ Understanding the Rule-Matching Algorithm on page 84

■ Understanding the Backdoor Rulebase on page 127

The following related topic is included in the IDP Administration Guide:

■ Configuring Backdoor Rulebase Rules (NSM Procedure)

Understanding the Backdoor Rulebase Operation Setting

The Backdoor rulebase operation setting is a toggle between Ignore and Detect.

Use Ignore to whitelist services for accepted forms of interactive traffic, such as
Telnet, SSH, RSH, NetMeeting, or VNC.

Use Detect for all other interactive traffic.

List the ignore rule first, followed by the detect rule.

TIP: You can use two rules to protect a large number of servers. Configure rule 1 to
match services you do not want to detect and set Operation to Ignore. Configure
rule 2 to match any traffic and set Operation to Detect.

Related Topics The following related topic is included in the IDP Concepts and Examples Guide:

■ Understanding the Backdoor Rulebase on page 127

The following related topic is included in the IDP Administration Guide:

■ Configuring Backdoor Rulebase Rules (NSM Procedure)

Understanding Backdoor Rulebase Actions

By default, Backdoor rulebase rules accept and log traffic that matches the rule. If
you choose, you can set a different action. Table 35 on page 131 describes the actions
you can set for Backdoor rulebase rules.
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Table 35: Backdoor Rulebase Actions

DescriptionAction

Accepts the interactive traffic.Accept

Drops the interactive connection without sending an RST packet to the sender, preventing the
traffic from reaching its destination. Use this action to drop connections for traffic that is not prone
to spoofing.

Drop Connection

Closes the connection and sends an RST packet to both the client and the server.

Logs generated for traffic that match this rule display Close.

NOTE: In sniffer mode, the IDP appliance is not in the path of network traffic. However, if you use
ACM to configure a sniffer mode reset interface, the IDP device can send an RST packet to both
the client and server but does not close the connection.

Close Client and Server

Closes the interactive connection to the client but not to the server.Close Client

Closes the interactive connection to the server but not to the client.Close Server

Related Topics The following related topic is included in the IDP Concepts and Examples Guide:

■ Understanding the Backdoor Rulebase on page 127

The following related topic is included in the IDP Administration Guide:

■ Configuring Backdoor Rulebase Rules (NSM Procedure)

Understanding Backdoor Rulebase Notification Options

By default, logging is enabled for Backdoor rulebase rules. Table 36 on page 131
describes the notification options you can configure. You also have the option to
disable logging.

Table 36: Backdoor Rulebase Notification Options

DescriptionOption

You can enable the following delivery and handling options for logs:

■ Send to NSM log viewer.

■ Send to NSM log viewer and flag as an alert.

■ Send to an e-mail address list.

■ Send to syslog.

■ Send to SNMP trap.

■ Save in XML format.

■ Save in CVS format.

■ Process with a script.

Event logs and alerts
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Table 36: Backdoor Rulebase Notification Options (continued)

DescriptionOption

Viewing the packets used in an attack on your network can help you determine the extent of the
attempted attack and its purpose, whether or not the attack was successful, and any possible
damage to your network.

If multiple rules with packet capture enabled match the same attack, the IDP device captures the
maximum specified number of packets. For example, you configure rule 1 to capture 10 packets
before and after the attack, and you configure rule 2 to capture 5 packets before and after the
attack. If both rules match the same attack, the IDP device attempts to capture 10 packets before
and after the attack.

You can capture up to 256 packets before the event and 256 packets after the event.

NOTE: If necessary, you can improve performance by logging only the packets received after the
attack.

Packet captures

NOTE: Backdoor rulebase notification options are the same as IDP rulebase options.

Related Topics The following related topics are included in the IDP Concepts and Examples Guide:

■ Understanding the Backdoor Rulebase on page 127

■ IDP Logs Overview on page 51

The following related topic is included in the IDP Administration Guide:

■ Configuring Backdoor Rulebase Rules (NSM Procedure)

Backdoor Rulebase Example: netcat

The netcat utility can open connections to any port and can offer services on any
port. We know that attackers use netcat to create and exploit backdoors.

Suppose an attacker gains access to a host in your network and installs a netcat
utility. The following example shows a netcat command an attacker can run:

nc 10.1.1.100 4444

This command opens a connection to the computer at IP address 10.1.1.100 over
port 4444.

Figure 48 on page 133 shows a recommended rule that would detect the interactive
traffic generated by netcat in this case.
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Figure 48: Backdoor Rulebase

Rule 1 ignores the interactive traffic you expect for interactive services in your network
(Telnet, SSH, RSH, NetMeeting, and VNC). Rule 2 detects all other interactive traffic.
Rule 2 detects interactive traffic that occurs over a port where there typically is not
interactive traffic.

Related Topics The following related topic is included in the IDP Concepts and Examples Guide:

■ Understanding the Backdoor Rulebase on page 127

The following related topic is included in the IDP Administration Guide:

■ Configuring Backdoor Rulebase Rules (NSM Procedure)
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Chapter 14

The SYN Protector Rulebase

This chapter explains how the SYN Protector rulebase protects your network and
provides guidelines for configuring SYN Protector rulebase rules. It includes the
following topics:

■ Understanding the SYN Protector Rulebase on page 135

■ Understanding SYN Protector Rulebase Match Settings on page 137

■ Understanding SYN Protector Rulebase Modes on page 138

■ Understanding SYN Protector Rulebase Notification Options on page 139

Understanding the SYN Protector Rulebase

The SYN Protector rulebase protects your network from malicious SYN flood attacks.

A SYN flood attack is a type of denial-of-service (DoS) attack, where the attacker
attempts to flood your server with TCP requests to overwhelm your resources.

Attackers send a SYN message from a host with a spoofed, unreachable IP address
to foil the TCP three-way handshake:

■ A client host sends a SYN packet to a specific port on the server.

■ Next, the server sends a SYN/ACK packet to the client host. The potential
connection is now in a SYN_RECV state.

■ Because the system is unreachable, the server never receives an ACK or RST
packet back from the client host. The potential connection remains in the
SYN_RECV state, and is placed into a connection queue while it waits for an ACK
or RST packet. This “half–opened” connection remains in the queue until the
connection-establishment timer expires (when it will be deleted).

To exploit this vulnerability, attackers use attack programs that generate thousands
of bogus SYN messages, resulting in denial of service.

When the SYN Protector rulebase is enabled, the IDP engine detects traffic that
exceeds the traffic thresholds you set as runtime parameters. Figure 49 on page 136
shows the SYN protector detection settings in the NSM Device Manager configuration
editor.
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Figure 49: NSM Device Manager: Sensor Settings > Run-Time Parameters

Table 37 on page 136 describes the SYN Protector thresholds.

Table 37: SYN Protector Thresholds

DescriptionSetting

Used when SYN Protector is configured in passive mode.

A half-open SYN flow occurs during the TCP three-way handshake, after the client has sent a
SYN/ACK packet to the server. The half-open connection is now in the SYN_RECV state, and is
placed into a connection queue while it waits for an ACK or RST packet. The connection remains
in the queue until the connection-establishment timeout expires and the half-open connection is
deleted.

In passive mode, the IDP appliance monitors session startup. If the client does not send an ACK
within the specified timeout, the IDP appliance sends a TCP reset. This setting controls the
connection establishment timer, which determines the number of seconds that the IDP engine
maintains a half-open SYN protected flow. The default is 5 seconds.

Timeout for half-open
SYN protected flows

Used to activate the SYN Protector in passive or relay mode.

In passive mode, the SYN Protector rulebase is activated when the number of SYN packets per
second is greater than the sum of the lower SYNs-per-second threshold and the upper
SYNs-per-second threshold. The defaults are 1000 and 20. Using the defaults, the SYN Protector
is activated when SYNs-per-second reach 1020. The SYN Protector rulebase is deactivated when
the number of SYN packets per second falls below the lower SYNs-per-second threshold.

In relay mode, the SYN Protector rulebase is activated when the number of SYN packets per
second exceeds the lower SYNs-per-second threshold. The upper threshold is not used.

Lower SYNs-per-second
threshold below which
SYN Protector will be
deactivated

Upper SYNs-per-second
threshold above which
SYN Protector will be
activated
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When you create rules for the SYN Protector rulebase, you specify:

■ A source/destination/service match condition

■ A response mode: passive or relay

■ Notification options

Related Topics The following related topics are included in the IDP Concepts and Examples Guide:

■ Understanding SYN Protector Rulebase Match Settings on page 137

■ Understanding SYN Protector Rulebase Modes on page 138

■ Understanding SYN Protector Rulebase Notification Options on page 139

■ Understanding the Components of an IDP Security Policy on page 81

The following related topic is included in the IDP Administration Guide:

■ Configuring SYN Protector Rulebase Rules (NSM Procedure)

Understanding SYN Protector Rulebase Match Settings

The SYN Protector rulebase becomes active when IDP detects traffic that exceeds
the thresholds you set as runtime parameters. Table 38 on page 137 shows the defaults
for SYN Protector rulebase detection runtime parameters. You can tune these
parameters if safe traffic in your network triggers false positives.

Table 38: SYN Flood Detection Runtime Parameters

DefaultParameter

5Timeout for half-open SYN protected flows

1000Lower SYN-per-second threshold below which SYN Protector will be deactivated

20Upper SYN-per-second threshold above which SYN Protector will be activated.

In other words, using the defaults, the SYN Protector rulebase is activated when the
IDP appliance counts 1020 SYN packets per second and deactivates when it falls
below 1000 SYN packets per second.

When the SYN Protector rulebase is active, the IDP process engine evaluates its rules,
beginning with source, destination, and service matching.

Because all TCP-IP is susceptible to a SYN flood attack, we recommend the following
settings:

■ Source — Any

■ Destination — Servers you want to protect
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■ Service — TCP Any

TIP: You can use two rules to protect a large number of servers. Configure rule 1 to
match servers you do not need to protect, and set Mode to None. Configure rule 2
to match any traffic and set Mode to Passive or Relay, as you prefer.

TIP: In NSM, you can create address objects and service objects to facilitate
configuration. One benefit of using objects is that you can configure them once and
then use them in multiple rules. For details, see the NSM documentation.

NOTE: The SYN Protector rulebase is a terminal rulebase–that is, SYN Protector rules
are inherently terminal rules. If a SYN Protector rule matches, IDP does not process
subsequent rules.

Related Topics The following related topics are included in the IDP Concepts and Examples Guide:

■ Understanding the Rule-Matching Algorithm on page 84

■ Understanding the SYN Protector Rulebase on page 135

The following related topics are included in the IDP Administration Guide:

■ Configuring SYN Protector Rulebase Rules (NSM Procedure)

■ Modifying the IDP Device Configuration

Understanding SYN Protector Rulebase Modes

Table 39 on page 138 summarizes SYN Protector rulebase modes.

Table 39: SYN Protector Rulebase Modes

DescriptionMode

The IDP appliance takes no action and does not participate in the three-way handshake.None

In passive mode, the IDP appliance monitors session startup. If the client does not send an ACK
within a timeout period, the IDP appliance sends a TCP reset.

Passive
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Table 39: SYN Protector Rulebase Modes (continued)

DescriptionMode

In relay mode, the IDP appliance acts as a relay for the connection establishment, performing the
three-way handshake with the client on behalf of the server. When the IDP appliance receives the
initial SYN packet, it returns a SYN/ACK packet with a SYN cookie. A SYN cookie is a 32-bit number
that is put into the TCP sequence number field of a packet. If the client replies with an ACK packet
with the appropriate cookie, the IDP appliance completes the three-way handshake and allows the
session to become established. If the IDP appliance does not receive an appropriate ACK packet
from the client, as is the case in a SYN flood attack, the IDP appliance does not establish the
connection. Relay mode guarantees that the server allocates resources only to connections that are
already in an established state. The relay is transparent to both the client and server.

Relay mode has the following limitations:

■ When the ACK packet from the client is lost, it can potentially lead to an unsynchronized state
between client and server.

■ Because the IDP appliance does not save TCP options found in SYN packets, TCP extensions
used for efficient transaction-oriented service (T/TCP) and Selective Acknowledgment (SACK),
or applications such as BGP, have a problem when SYN flooding is detected and the IDP
appliance initiates the proxy TCP handshake.

■ Relay mode can be susceptible to ACK flooding because the IDP appliance must check for the
validity of a cookie in the ACK messages.

NOTE: Relay mode might not work as expected for MPLS traffic. When the IDP engine processes
MPLS traffic, it stores the MPLS label information for traffic in each direction. In the case of traffic
that matches SYN Protector rules in relay mode, the IDP appliance is programmed to send a
SYN-ACK before the traffic has reached the server. In these cases, the IDP engine does not have
server-to-client MPLS label information. Therefore, the SYN-ACK packet does not include an MPLS
label. Some MPLS routers can add packets without a label to an existing MPLS tunnel; others drop
such packets.

Relay

TIP: You can use two rules to protect a large number of servers. Configure rule 1 to
match servers you do not need to protect, and set Mode to None. Configure rule 2
to match any traffic and set Mode to Passive or Relay, as you prefer.

Related Topics The following related topic is included in the IDP Concepts and Examples Guide:

■ Understanding the SYN Protector Rulebase on page 135

The following related topic is included in the IDP Administration Guide:

■ Configuring SYN Protector Rulebase Rules (NSM Procedure)

Understanding SYN Protector Rulebase Notification Options

By default, notification is not enabled for SYN Protector rulebase rules. You have the
option to enable notification options. Table 40 on page 140 describes these options.
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Table 40: SYN Protector Rulebase Notification Options

DescriptionOption

You can enable the following delivery and handling options for logs:

■ Send to NSM log viewer.

■ Send to NSM log viewer and flag as an alert.

■ Send to an e-mail address list.

■ Send to syslog.

■ Send to SNMP trap.

■ Save in XML format.

■ Save in CVS format.

■ Process with a script.

Event logs and alerts

Packet capture is not available for SYN Protector rulebase rules.Packet captures

NOTE: SYN Protector rulebase notification options are the same as IDP rulebase
options, except that packet capture is not applicable.

Related Topics The following related topic is included in the IDP Concepts and Examples Guide:

■ Understanding the SYN Protector Rulebase on page 135

The following related topic is included in the IDP Administration Guide:

■ Configuring SYN Protector Rulebase Rules (NSM Procedure)
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Chapter 15

The Traffic Anomalies Rulebase

This chapter explains how the Traffic Anomalies rulebase protects your network and
provides guidelines for configuring Traffic Anomalies rulebase rules. It includes the
following topics:

■ Understanding the Traffic Anomalies Rulebase on page 141

■ Understanding Traffic Anomalies Rulebase Match Conditions on page 143

■ Understanding Traffic Anomalies Rulebase Detection Settings on page 144

■ Understanding Traffic Anomalies Rulebase IP Actions on page 145

■ Understanding Traffic Anomalies Rulebase Notification Options on page 146

Understanding the Traffic Anomalies Rulebase

The Traffic Anomalies rulebase employs a traffic flow analysis method to detect
attacks that occur over multiple connections and sessions (such as scans).

A traffic anomaly is a pattern that indicates abnormal network activity. Traffic
generated by automated port scanning tools trigger Traffic Anomalies rulebase rules.
Attackers use automated port scanning tools to perform reconnaissance on your
network. Typically, an automated port scanning tool attempts to connect to every
port on a single machine (port scanning) or to connect to multiple IP addresses on
a network (network scanning). Attackers do this to determine which services are
allowed and responding on your network, so they can focus attacks on any
vulnerabilities.

Traffic Anomalies rulebase rules count the number of ports scanned in a specified
time period and use this traffic flow analysis to identify scans, as well as other attacks
that occur over multiple connections and sessions. If the rule detects an attack, you
can drop the connection and block the IP address that originated the attack. The IDP
engine takes action against traffic that exceeds the thresholds you set.

Table 41 on page 142 summarizes Traffic Anomalies rulebase detection settings. You
can tune these parameters if safe traffic in your network triggers false positives.
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Table 41: Traffic Anomalies Rulebase Detection Settings

DescriptionGroup

Set a port count (number of ports scanned) and the time threshold (the time period that ports are
counted) in seconds.

The default port count is 20. The default time threshold is 120 seconds. The rule is matched if the
same source scans 20 TCP ports on your internal network within 120 seconds or if the same source
scans 20 UDP ports on your internal network within 120 seconds.

TCP scans, UDP Port
Scans

A distributed port scan is an attack that uses multiple source IP addresses to scan ports.

Set a port count (number of ports scanned) and the time threshold (the time period that ports are
counted) in seconds.

The default IP count is 50. The default time threshold is 120 seconds. The rule is matched if 50 IP
addresses attempt to scan ports on your internal network within 120 seconds.

Distributed Port Scan

An ICMP sweep is an attack where a single source IP pings multiple IP addresses.

Set a port count (number of ports scanned) and the time threshold (the time period that ports are
counted) in seconds.

The default IP count is 50. The default time threshold is 120 seconds. The rule is matched if the
same source IP attempts to ping 50 IP addresses within 120 seconds.

ICMP Sweep

A network scan is an attack where a single source IP scans multiple IP addresses.

Set a port count (number of ports scanned) and the time threshold (the time period that ports are
counted) in seconds.

The default IP count is 50. The default time threshold is 120 seconds. The rule is matched if the
same source IP attempts to scan 50 IP addresses within 120 seconds.

Network Scan

Set a threshold number of sessions allowed from a single host within a second. The default is 100
sessions.

For example, assume your internal network typically has low volume traffic. To detect a sudden
increase in traffic from a specific host (which might indicate a worm), configure a rule that matches
traffic over your internal network and configure a limit of 200. To block traffic that exceeds the
session limit, set an IP action of IDP Block and select Source, Protocol from the Blocking Options
menu.

Session Limit

In addition, you can tune runtime parameters for Traffic Signatures. Table 42 on
page 142 describes the runtime parameters associated with the Traffic Anomalies
rulebase.

Table 42: Traffic Signature Runtime Settings

DescriptionSetting

Scans typically use small packets to access targets. You can exclude
flows that contain large packets to reduce false positives. The default
is to exclude flows where packet size exceeds 20 bytes.

Byte threshold for suspicious flows
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Table 42: Traffic Signature Runtime Settings (continued)

DescriptionSetting

Specifies how frequently log messages are generated. Default is 30
seconds.

Reporting frequency while scan in progress (seconds)

Specifies the maximum number of source IP addresses for which
session rate is calculated. Default is 32,767.

The number of IP addresses we track for session rate

When you create rules for the Traffic Anomalies rulebase, you specify:

■ A source/destination/service match condition

■ Detection settings

■ Response options

■ Notification options

For complete procedures on configuring Traffic Anomalies rulebase rules, see the
IDP Administration Guide.

Related Topics The following related topics are included in the IDP Concepts and Examples Guide:

■ Understanding Traffic Anomalies Rulebase Match Conditions on page 143

■ Understanding Traffic Anomalies Rulebase Detection Settings on page 144

■ Understanding Traffic Anomalies Rulebase IP Actions on page 145

■ Understanding Traffic Anomalies Rulebase Notification Options on page 146

■ Understanding the Components of an IDP Security Policy on page 81

The following related topic is included in the IDP Administration Guide:

■ Configuring Traffic Anomalies Rulebase Rules (NSM Procedure)

Understanding Traffic Anomalies Rulebase Match Conditions

We recommend the following settings for Traffic Anomalies rulebase match
conditions:

■ Source — Any

■ Destination — IP addresses for servers you want to protect

■ Service — Any (or specify specific services if you are creating an ignore list)

TIP: You can use two rules to protect a large number of servers. Configure rule 1 to
match services you do not want to detect and set the detection option to Ignore.
Configure rule 2 to match any traffic and set the detection operation to Detect.
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TIP: In NSM, you can create address objects and service objects to facilitate
configuration. One benefit of using objects is that you can configure them once and
then use them in multiple rules. For details, see the NSM documentation.

NOTE: The Traffic Anomalies rulebase is a terminal rulebase–that is, Traffic Anomalies
rules are inherently terminal rules. If a Traffic Anomalies rule matches, IDP does not
process subsequent rules.

Related Topics The following related topics are included in the IDP Concepts and Examples Guide:

■ Understanding the Rule-Matching Algorithm on page 84

■ Understanding the Traffic Anomalies Rulebase on page 141

The following related topic is included in the IDP Administration Guide:

■ Configuring Traffic Anomalies Rulebase Rules (NSM Procedure)

Understanding Traffic Anomalies Rulebase Detection Settings

The Traffic Anomalies rulebase detection setting is a toggle detection off and on.

Specify Ignore to turn off traffic anomaly detection for traffic that matches the rule.

Specify Detect to turn on detection for traffic that matches the rule and to configure
detection settings.

TIP: You can use two rules to protect a large number of servers. Configure rule 1 to
match services you do not want to detect and set the detection option to Ignore.
Configure rule 2 to match any traffic and set the detection option to Detect.

TIP: In NSM, you can create address objects and service objects to facilitate
configuration. One benefit of using objects is that you can configure them once and
then use them in multiple rules. For details, see the NSM documentation.
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Related Topics The following related topic is included in the IDP Concepts and Examples Guide:

■ Understanding the Traffic Anomalies Rulebase on page 141

The following related topic is included in the IDP Administration Guide:

■ Configuring Traffic Anomalies Rulebase Rules (NSM Procedure)

Understanding Traffic Anomalies Rulebase IP Actions

If traffic matches a traffic anomalies rule, the IDP appliance can take action against
the current connection and against subsequent network traffic from the same IP
address. Such actions are called IP actions. By default, the specified IP action is
permanent (timeout = 0). If you prefer, you can set a timeout.

Table 43 on page 145 describes Traffic Anomalies rulebase IP actions.

Table 43: Traffic Anomalies Rulebase IP Actions

DescriptionIP Action

IDP blocks the matching connection and future connections that match combinations of the following
properties you specify:

■ Source IP address

■ Source subnet

■ Protocol

■ Destination IP address

■ Destination subnet

■ Destination port

■ From zone

IP Block

IDP closes the matching connection and future connections that match combinations of the following
properties you specify:

■ Source IP address

■ Source subnet

■ Protocol

■ Destination IP address

■ Destination subnet

■ Destination port

■ From zone

IP Close

IDP does not take any action against future traffic but logs the event or sends an alert.IP Notify

NOTE: Traffic Anomalies rulebase IP actions are the same IP actions available for
IDP rulebase rules.
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Related Topics The following related topic is included in the IDP Concepts and Examples Guide:

■ Understanding the Traffic Anomalies Rulebase on page 141

The following related topic is included in the IDP Administration Guide:

■ Configuring Traffic Anomalies Rulebase Rules (NSM Procedure)

Understanding Traffic Anomalies Rulebase Notification Options

By default, logging is enabled for Traffic Anomalies rulebase rules. Table 44 on
page 146 describes notification options. You also have the option of disabling logging.

Table 44: Traffic Anomalies Rulebase Notification Options

DescriptionOption

You can enable the following delivery and handling options for logs:

■ Send to NSM log viewer.

■ Send to NSM log viewer and flag as an alert.

■ Send to an e-mail address list.

■ Send to syslog.

■ Send to SNMP trap.

■ Save in XML format.

■ Save in CVS format.

■ Process with a script.

Event logs and alerts

Packet capture is not available for Traffic Anomalies rulebase rules.Packet captures

NOTE: Traffic Anomalies rulebase notification options are the same as IDP rulebase
options, except that packet capture is not applicable.

Related Topics The following related topics are included in the IDP Concepts and Examples Guide:

■ Understanding the Traffic Anomalies Rulebase on page 141

■ IDP Logs Overview on page 51

The following related topic is included in the IDP Administration Guide:

■ Configuring Traffic Anomalies Rulebase Rules (NSM Procedure)
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Chapter 16

The Network Honeypot Rulebase

This chapter explains how to use the Network Honeypot rulebase to detect attacker
reconnaissance activities. It includes the following topics:

■ Understanding the Network Honeypot Rulebase on page 147

■ Understanding Network Honeypot Rulebase Match Settings on page 148

■ Understanding Network Honeypot Operation Setting on page 148

■ Understanding Network Honeypot Rulebase IP Actions on page 149

■ Understanding Network Honeypot Rulebase Notification Options on page 150

Understanding the Network Honeypot Rulebase

The Network Honeypot rulebase is a method to detect reconnaissance activities.

A network honeypot is an apparently vulnerable system that draws the attention and
action of attackers. In an IDP network honeypot, the IDP appliance impersonates
ports on protected servers.

When you create rules for the Network Honeypot rulebase, you specify:

■ A destination/service match condition

■ Operation mode

■ Response options

■ Notification options

NOTE: The IDP appliance drops MPLS traffic that matches a Network Honeypot rule.
When the IDP engine processes MPLS traffic, it stores the MPLS label information.
It stores separate labels for client-to-server and server-to-client communication. In
the case of traffic that matches Network Honeypot rules, there is no genuine
server-to-client communication, so the IDP engine does not have server-to-client
MPLS label information. Therefore, the impersonation operation cannot be supported
for MPLS traffic.
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Related Topics The following related topics are included in the IDP Concepts and Examples Guide:

■ Understanding Network Honeypot Rulebase Match Settings on page 148

■ Understanding Network Honeypot Operation Setting on page 148

■ Understanding Network Honeypot Rulebase IP Actions on page 149

■ Understanding Network Honeypot Rulebase Notification Options on page 150

■ Understanding the Components of an IDP Security Policy on page 81

The following related topic is included in the IDP Administration Guide:

■ Configuring Network Honeypot Rulebase Rules (NSM Procedure)

Understanding Network Honeypot Rulebase Match Settings

Network Honeypot rulebase rules are triggered when a source IP address makes a
connection request to the destination IP address and service specified in the rule.

We recommend you set source to Any; set destination and service to the server and
service you want to appear to be available.

TIP: In NSM, you can create address objects and service objects to facilitate
configuration. One benefit of using objects is that you can configure them once and
then use them in multiple rules. For details, see the NSM documentation.

NOTE: The Network Honeypot rulebase is a terminal rulebase–that is, Network
Honeypot rules are inherently terminal rules. If a Network Honeypot rule matches,
IDP does not process subsequent rules.

Related Topics The following related topic is included in the IDP Concepts and Examples Guide:

■ Understanding the Network Honeypot Rulebase on page 147

The following related topic is included in the IDP Administration Guide:

■ Configuring Network Honeypot Rulebase Rules (NSM Procedure)

Understanding Network Honeypot Operation Setting

The Network Honeypot rulebase operation setting is used to toggle the network
honeypot on and off.

Specify Impersonate to turn it on; specify Ignore to turn it off.
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If the Network Honeypot rulebase is turned on, an attacker attempts to connect to
an impersonated port, and the rule matches, the IDP appliance responds with a TCP
SYN/ACK.

Related Topics The following related topic is included in the IDP Concepts and Examples Guide:

■ Understanding the Network Honeypot Rulebase on page 147

The following related topic is included in the IDP Administration Guide:

■ Configuring Network Honeypot Rulebase Rules (NSM Procedure)

Understanding Network Honeypot Rulebase IP Actions

If traffic matches a Network Honeypot rule, the IDP appliance can take action against
the current connection and against subsequent network traffic from the same IP
address. Such actions are called IP actions. By default, the specified IP action is
permanent (timeout = 0). If you prefer, you can set a timeout.

Table 45 on page 149 describes Network Honeypot rulebase IP actions.

Table 45: Network Honeypot Rulebase IP Actions

DescriptionIP Action

IDP blocks the matching connection and future connections that match combinations of the following
properties you specify:

■ Source IP address

■ Source subnet

■ Protocol

■ Destination IP address

■ Destination subnet

■ Destination port

■ From zone

IP Block
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Table 45: Network Honeypot Rulebase IP Actions (continued)

DescriptionIP Action

IDP closes the matching connection and future connections that match combinations of the following
properties you specify:

■ Source IP address

■ Source subnet

■ Protocol

■ Destination IP address

■ Destination subnet

■ Destination port

■ From zone

NOTE: The IP Close action might not work as expected for MPLS traffic. When the IDP engine
processes MPLS traffic, it stores the MPLS label information for traffic in each direction. In the case
of an IP action, the IDP engine is programmed to take a server-to-client action before the traffic
has reached the server. In these cases, the IDP engine does not have server-to-client MPLS label
information. Therefore, the TCP reset packet does not include an MPLS label. Some MPLS routers
can add packets without a label to an existing MPLS tunnel; others drop such packets.

IP Close

IDP does not take any action against future traffic but logs the event or sends an alert.IP Notify

NOTE: Network Honeypot rulebase IP actions are the same IP actions available for
IDP rulebase rules.

Related Topics The following related topic is included in the IDP Concepts and Examples Guide:

■ Understanding the Network Honeypot Rulebase on page 147

The following related topic is included in the IDP Administration Guide:

■ Configuring Network Honeypot Rulebase Rules (NSM Procedure)

Understanding Network Honeypot Rulebase Notification Options

By default, logging is not enabled for Network Honeypot rulebase rules. You have
the option to enable notification options. Table 46 on page 151 describes these options.
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Table 46: Network Honeypot Rulebase Notification Options

DescriptionOption

You can enable the following delivery and handling options for logs:

■ Send to NSM log viewer.

■ Send to NSM log viewer and flag as an alert.

■ Send to an e-mail address list.

■ Send to syslog.

■ Send to SNMP.

■ Save in XML format.

■ Save in CVS format.

■ Process with a script.

Event logs and alerts

Viewing the packets used in an attack on your network can help you determine the extent of the
attempted attack and its purpose, whether or not the attack was successful, and any possible
damage to your network.

If multiple rules with packet capture enabled match the same attack, IDP captures the maximum
specified number of packets. For example, you configure rule 1 to capture 10 packets before and
after the attack, and you configure rule 2 to capture 5 packets before and after the attack. If both
rules match the same attack, IDP attempts to capture 10 packets before and after the attack.

You can capture up to 256 packets before the event and 256 packets after the event.

NOTE: If necessary, you can improve performance by logging only the packets received after the
attack.

Packet captures

NOTE: Network Honeypot rulebase notification options are the same as IDP rulebase
options.

Related Topics The following related topics are included in the IDP Concepts and Examples Guide:

■ Understanding the Network Honeypot Rulebase on page 147

■ IDP Logs Overview on page 51

The following related topic is included in the IDP Administration Guide:

■ Configuring Network Honeypot Rulebase Rules (NSM Procedure)
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Chapter 17

Fine-Tuning a Security Policy

This chapter provides a suggested workflow for getting started and fine-tuning a
security policy. It includes the following topic:

■ Example: Fine-Tuning a Security Policy on page 153

Example: Fine-Tuning a Security Policy

This topic provides a suggested workflow for getting started and fine-tuning a security
policy. It includes the following subtopics:

■ Fine-Tuning Security Policies Process Overview on page 153

■ Getting Started with the Recommended Security Policy on page 154

■ Refining Rule Matching Properties on page 154

■ Reducing False Positives on page 155

■ Adding Rulebases on page 158

Fine-Tuning Security Policies Process Overview

You want to tune a security policy so that it is:

■ Comprehensive–Detects all possible attacks on specific hosts in your network.

■ Optimized–Each attack object specified in an IDP rulebase rule has a performance
cost. In general, you want more rules with a few attack objects in each rather
than fewer rules with many attack objects. In addition, we recommend that a
single rule includes only the attack objects that are applicable to the rule
destination server and only those of a severity that concerns you.

■ Precise–Generates few false positives.

■ Maintainable–As you refine your rules, you want to leverage as much of the
built-in logic as possible. In your IDP rulebase rules, for example, you want to
use the application identification feature, dynamic attack object groups,
recommended attack objects, and recommended actions as much as possible,
knowing the Juniper Networks Security Center team updates these as needed
(even daily).
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Fine-tuning is an iterative process. The process involves the following steps:

1. “Getting Started with the Recommended Security Policy” on page 154

2. “Refining Rule Matching Properties” on page 154

3. “Reducing False Positives” on page 155

4. “Adding Rulebases” on page 158

Getting Started with the Recommended Security Policy

When you add the IDP appliance to the NSM Device Manager, NSM automatically
pushes the recommended policy to the IDP appliance. The recommended policy
protects your network from the most frequent and severe attacks.

Table 47 on page 154 summarizes the properties of the Recommended security policy.

Table 47: Recommended Security Policy Definition

ValueProperty

IDP rulebaseRulebase

Nine rules, distinguished by attack objectRules

AnySource

AnyDestination

Default, meaning the matching property is based on the service bindings of the attack object
specified by the rule

Service

Recommended IP, Recommended TCP, Recommended ICMP, Recommended HTTP,
Recommended SMTP, Recommended DNS, Recommended FTP, Recommended POP3,
Recommended IMAP, Recommended Trojan, Recommended Virus, Recommended Worm

Attack objects

Recommended, meaning the action is specified by the attack objectAction

LoggingNotification

NOTE: In the Recommended security policy, the source and destination matching
parameters for rules are set to Any. These broad settings provide comprehensive
protection, but they entail a performance cost and might result in more logs than
are necessary. We recommend you customize these settings for destination servers.

Refining Rule Matching Properties

The source and destination matching parameters for template rules are set to Any.
These broad settings provide comprehensive protection, but they entail a performance
cost and might result in more logs than are necessary. We recommend you customize
these settings.
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Run the Profiler for several days to gather information about the hosts and applications
running in your network. After several days, you should have the data you need to
complete the following tasks:

■ Create NSM address objects that identify groups of internal servers. When you
configure rules to examine client to server traffic, you specify the internal servers
as the rule’s destination servers.

■ Create an address object that defines your internal network. When you configure
rules to examine traffic from your network to hosts on the world wide web, you
can specify the internal network address object as the rule’s source.

■ Create NSM service objects to identify services running on internal servers. In
most cases, you can specify Default for service so the rule uses the service
relevant to the attack object. However, there might be cases where you want to
specify a service object or service group.

■ Identify predefined attack groups related to services (or create your own attack
group, if necessary).

■ Refine the IDP rulebase rule set so that each rule is focused on a single destination
server (client to server traffic) or service (server to client traffic).

Reducing False Positives

A false positive is a log record that reflects an event on your network that you are
not concerned about and no longer want to see in your logs. The IDP security policy
found traffic that matched your rule, but over time you realize you do not need to
track such events.

To determine whether a log is a false positive, you need to understand why the IDP
device triggered the log and whether or not the traffic poses a real risk to the target
server.

Suppose your security policy rule includes the following attack object: Predefined ::
HTTP: Windows Media Services NSIISlog.DLL Buffer Overflow. It generates a log
when it identifies the attack pattern in traffic through the IDP device. Use the reference
information in the details pane below the log table to learn more about the attack.
You can click the hypertext linked name of the attack object in the summary tab to
display reference information for the attack, as shown in Figure 50 on page 156.
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Figure 50: Using NSM Log Viewer Attack Reference Information

In this example, we learn that the threat detected applies only to Microsoft Windows
2000 Server SP4. It is a false positive because all of the Windows servers in our
network are Windows Server 2008. You can use the NSM Log Viewer flag and
comment features to mark logs as false positives. In Figure 51 on page 157, we have
marked the log ID 20090806/416967 as a false positive because the attack targets
server versions not present in our network.
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Figure 51: Using NSM Log Viewer Flag and Comment Features

There are a number of ways you can tune your security policy to reduce false
positives. Table 48 on page 158 summarizes some basic tunings.
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Table 48: Actions to Take To Reduce False Positives

Tuning RequiredType of False Positive

Add an Exempt rulebase rule to “whitelist” the trusted source.You trust the source.

You have many options:

■ Delete the attack from the rule.

■ Modify an attack group to exclude the object.

■ Add an Exempt rulebase rule to whitelist the non-offending attack
object.

■ Modify rule action so traffic is stopped or permitted differently
from before.

■ Modify the rule severity so that you can filter these events
differently from before.

The attack applies to a hardware or software version
that does not match your destination server.

Same as previous.Your team has already patched the vulnerability
detected by the attack.

Use the NSM Device Manager to modify protocol anomaly thresholds.Upon examination, benign traffic crosses thresholds
that trigger protocol anomaly events.

Adding Rulebases

The IDP rulebase is the primary rulebase in an IDP security policy. When you have
sufficiently tuned your IDP rulebase rules so that the security policy generates the
level of logs you want, you can add additional rulebases to enable additional detection
methods.

Take the same approach to tuning these additional rulebases. Instead of refining the
group of attack objects that are relevant, you tune the IDP runtime parameters that
set thresholds for detection mechanisms.

Related Topics The following related topics are included in the IDP Concepts and Examples Guide:

■ Profiler Overview on page 27

■ Understanding the Rule-Matching Algorithm on page 84

■ Understanding IDP Rulebase Rule Match Settings on page 92

■ Understanding the Components of an IDP Security Policy on page 81

■ Understanding the Exempt Rulebase on page 113

■ Using Attack Objects on page 97

■ IDP Logs Overview on page 51

The following related topic is included in the IDP Administration Guide:

■ Modifying the IDP Device Configuration
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Chapter 18

Additional Security Features

This chapter describes additional security features you can use to protect your
network. It includes the following topics:

■ IP Spoof Attack Prevention Overview on page 159

IP Spoof Attack Prevention Overview

Every IP packet includes the destination address (where the packet is going) and the
source address (where the packet came from). The routers that provide Internet
communication between distant computers determine the best route for the IP packet
using only the destination address and typically ignore the source address.

Attackers, who typically do not want you to know where an attack is coming from,
can fake the source address of a malicious IP packet (by modifying the packet headers)
so that the packet appears to come from a trusted system. The use of a fake IP
address is called IP spoofing. You can configure the IDP system to detect these
irregularities.

To detect attacks that attempt to spoof the addresses of hosts in your protected
network, you can associate IDP traffic interfaces with the addresses of hosts in your
protected network. IDP then detects an IP spoof attack if:

■ An incoming packet uses an IP address that belongs to a network object on your
internal network.

■ An outgoing packet uses an IP address that does not belong to a network object
on your internal network.

You can configure whether IDP drops or logs the session with a spoofed IP address.

Related Topics The following related topic is included in the IDP Administration Guide:

■ Modifying the IDP Device Configuration
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Part 4

Additional Deployment Topics

■ Inspection of Encapsulated and Encrypted Traffic on page 163

■ Deploying IDP Series Appliances in a Coordinated Threat Control
Solution on page 177

■ Deploying a User-Role-Based Policy Solution on page 179
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Chapter 19

Inspection of Encapsulated and Encrypted
Traffic

This chapter identifies support for inspection of encapsulated or encrypted traffic. It
includes the following topics:

■ Inspection of GRE Traffic Overview on page 163

■ Inspection of GTP Traffic Overview on page 163

■ Inspection of IPsec VPN Traffic Overview on page 164

■ Inspection of MPLS Traffic Overview on page 164

■ Inspection of SSL Traffic Overview on page 165

■ Example: Implementing Inspection of Outbound SSL Traffic on page 169

■ Example: Exempting Outbound SSL Traffic from Inspection on page 172

Inspection of GRE Traffic Overview

Generic Routing Encapsulation (GRE) is a tunneling protocol designed to encapsulate
a wide variety of network layer packets inside IP tunneling packets. The original
packet is the payload for the final packet. The protocol is used on the Internet to
secure virtual private networks.

To inspect the payload of an encapsulated packet, the IDP process engine must
decapsulate it. IDP Series appliances support decapsulation for IP-in-GRE and
PPP-in-GRE. You can configure decapsulation for one or two layers.

Related Topics The following related topic is included in the IDP Administration Guide:

■ Enabling Inspection of GRE Traffic

Inspection of GTP Traffic Overview

GPRS Tunneling Protocol (or GTP) is an IP-based protocol used within Global System
for Mobile communication (GSM) and Universal Mobile Telecommunications System
(UMTS) networks.
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To inspect the payload of an encapsulated traffic, the IDP process engine must
decapsulate it. IDP Series appliances support decapsulation for UDP GTPv0 and
GTPv1. You can configure decapsulation for one or two layers.

Related Topics The following related topic is included in the IDP Administration Guide:

■ Enabling Inspection of GTP Traffic

Inspection of IPsec VPN Traffic Overview

Internet Protocol Security (IPsec) virtual private networks use the Encapsulated
Security Payload (ESP) protocol and the NULL encryption algorithm to ensure the
authenticity, integrity, and confidentiality of IP packets.

To inspect the payload of an encapsulated packet, the IDP process engine must
decapsulate it. IDP Series appliances support decapsulation for IPsec ESP NULL traffic.
You can configure decapsulation for one or two layers.

Related Topics The following related topic is included in the IDP Administration Guide:

■ Enabling Inspection of IPsec VPN Traffic

Inspection of MPLS Traffic Overview

Multiprotocol Label Switching (MPLS) is an IP label switching technology that enables
predetermined paths to specific destinations, called Label Switched Paths (LSPs), to
be established through an inherently connectionless IP network. In MPLS networks,
packets contain short labels that describe how to forward them through the network.

With MPLS decapsulation enabled, the IDP engine can inspect the IPv4 payload and
pass through non-IPv4 payload. Note the following requirements and limitations:

■ The IDP engine cannot decapsulate other encapsulated protocols within an MPLS
frame. For example, the IDP engine cannot decapsulate the MPLS frame, find a
GRE frame, decapsulate the GRE, and inspect the payload. Instead, the IDP
engine passes through such traffic.

■ If your traffic uses Ethernet frames larger than 1750 bytes, you must ensure the
IDP default maximum frame size is sufficient (the default maximum frame size
is 9014 bytes). In addition, we recommend you set the maximum transmission
unit (MTU) on the switch or router connected to the IDP appliance to 1750 bytes
or lower.

The IDP appliance does not participate in Label Distribution Protocol (LDP). When
the IDP appliance receives the traffic, the IDP engine stores the MPLS label stacks
of client-to-server or server-to-client directions. After processing the flow, the IDP
appliance forwards the IP frames with the label stack it had stored when it created
the flow, relying on the label switch router (LSR) to add the correct MPLS labels to
the packet.
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In some cases, the IDP engine is programmed to act in the server-to-client direction
before it has seen and stored a server-to-client MPLS label. In effect, these connections
are dropped. You might observe dropped MPLS traffic if the following rule elements
apply:

■ IDP rulebase – Action: Close Client (limitation applies to VLAN tagged traffic
only)

■ IDP rulebase – IP action: IP Close

■ SYN Protector rulebase – Relay mode

■ Network Honeypot rulebase – Impersonate mode

MPLS support is not enabled by default. You can use the CLI to enable MPLS support.

Related Topics The following related topic is included in the IDP Administration Guide:

■ Enabling Inspection of MPLS Traffic

Inspection of SSL Traffic Overview

Secure Sockets Layer (SSL) is a cryptographic protocol that adds security to TCP/IP
communication. Several versions of the SSL and Transport Layer Security (TLS)
protocols are in widespread use in applications like Web browsing, electronic mail,
Internet faxing, instant messaging, and voice over IP (VoIP). SSL and TLS encrypt
the Transport Layer protocol datagrams that carry the payload of these
communications. While encryption is an excellent way to keep private data from
prying eyes, without inspection by the IDP appliance, it also unwittingly opens a
network to dangerous viruses, trojans, or network attacks.

To inspect the HTTP payload of HTTPS traffic, the IDP Series device must decrypt
the HTTPS session. Your security policy can examine both the SSL session and the
decrypted HTTP payload.

The following sections describe alternative methods you can use to enable SSL
inspection:

■ Using the SSL Server Private Keys on page 165

■ Using a Root Certificate Authority in SSL Forward Proxy Operations on page 166

■ Supported SSL Specifications on page 167

Using the SSL Server Private Keys

As of IDP Release 3.2r1, we have supported inspection of client-to-server traffic to
internal SSL servers. As shown in Figure 52 on page 166, this method depends on
administrative access to the SSL server private keys.
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Figure 52: SSL Inspection Using SSL Server Private Keys

You must be able to copy the SSL server private key to the IDP SSL keystore. The
IDP Series device uses the key to decrypt the inbound traffic so that it can inspect
the payload. The private key must be in Privacy-Enhanced Mail (PEM) format. We
have verified support for the following RSA private key lengths: 1024 bits, 2048 bits,
3072 bits, and 4096 bits.

Using a Root Certificate Authority in SSL Forward Proxy Operations

As of IDP Release 5.0r2, we support inspection of traffic to HTTPS servers where
you do not have access to the SSL private key, such as outbound traffic to the WWW.
As shown in Figure 53 on page 166, this method uses a root certificate authority (CA)
to proxy the SSL key negotiation. The IDP Series device inserts itself into the SSL key
negotiation phase so that it can decrypt the HTTPS session and inspect the session
and payload according to your security policy.

Figure 53: SSL Inspection Using a Root CA

When the special root CA is present, the IDP Series device intercepts the HTTPS
connection and makes a request to the server as if it were the client; it presents to
the client a CA (derived from the special root CA) as if it were the server. The IDP
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Series device then negotiates the key exchange, decrypts the session, inspects the
payload, and re-encrypts the session as necessary before forwarding.

To ensure employee or customer privacy, you can configure a whitelist to exclude
matching sessions from being processed by the SSL forward proxy feature. Traffic
to destination servers on your whitelist is not intercepted and is passed through
uninspected.

NOTE: When both the CA and server private keys are present, the IDP Series device
uses the SSL forward proxy method to inspect HTTPS traffic.

Supported SSL Specifications

The IDP Series appliance supports decryption of HTTPS traffic that uses SSLv3 and
TLSv1. The IDP Series appliance can inspect an SSLv2 header for anomalies, but it
cannot decrypt and examine the HTTP payload in such sessions. In addition, the IDP
Series appliance does not support inspection of compressed TLS traffic.

Table 49 on page 167 lists the SSL cipher suites supported by the two IDP SSL
inspection methods.

Table 49: Supported SSL Cipher Suites

Decryption Using Forward
Proxy

Decryption Using Private
KeysCipher Suite

YesYesName: TLS_RSA_WITH_NULL_MD5

Authorization: RSA

Key Exchange: RSA

Encryption: NULL

Digest: MD5

YesYesName: TLS_RSA_WITH_NULL_SHA

Authorization: RSA

Key Exchange: RSA

Encryption: NULL

Digest: SHA
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Table 49: Supported SSL Cipher Suites (continued)

Decryption Using Forward
Proxy

Decryption Using Private
KeysCipher Suite

YesYesName: TLS_RSA_WITH_RC4_128_MD5

Authorization: RSA

Key Exchange: RSA

Encryption: RC4_128

Digest: MD5

YesYesName: TLS_RSA_WITH_RC4_128_SHA

Authorization: RSA

Key Exchange: RSA

Encryption: RC4_128

Digest: SHA

YesYesName: TLS_RSA_WITH_DES_CBC_SHA

Authorization: RSA

Key Exchange: RSA

Encryption: DES_CBC

Digest: SHA

YesYesName: TLS_RSA_WITH_3DES_EDE_CBC_SHA

Authorization: RSA

Key Exchange: RSA

Encryption: 3DES_EDE_CBC

Digest: SHA

YesYesName: TLS_RSA_WITH_AES_128_CBC_SHA

Authorization: RSA

Key Exchange: RSA

Encryption: AES_128_CBC

Digest: SHA
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Table 49: Supported SSL Cipher Suites (continued)

Decryption Using Forward
Proxy

Decryption Using Private
KeysCipher Suite

YesYesName: TLS_RSA_WITH_AES_256_CBC_SHA

Authorization: RSA

Key Exchange: RSA

Encryption: AES_256_CBC

Digest: SHA

Related Topics The following related topics are included in the IDP Concepts and Examples Guide:

■ Example: Implementing Inspection of Outbound SSL Traffic on page 169

■ Example: Exempting Outbound SSL Traffic from Inspection on page 172

The following related topics are included in the IDP Administration Guide:

■ Using the SSL Private Server Key to Enable Inspection of SSL Traffic

■ Using the SSL Forward Proxy Feature to Enable Inspection of HTTPS Traffic

■ Exempting HTTPS Traffic from Inspection

Example: Implementing Inspection of Outbound SSL Traffic

When users in your protected network connect to HTTPS servers on the WWW, the
application activity within the encrypted sessions cannot be inspected by most
intrusion prevention systems. Once an encrypted session is established with the
server, the user might download a seemingly harmless file or executable that contains
a trojan. If this happens, an attacker could launch an attack from within the protected
network.

To protect your network against this risk, you could create a firewall policy that blocks
HTTPS connections from the protected zone to the unprotected zone. To protect
your network and support legitimate access to the WWW, you want a solution that
can inspect the HTTPS traffic.

The IDP solution supports SSL inspection in two ways:

■ Using server private keys. Use this method when inspecting traffic to internal
servers where you have access to the server private key.

■ Using the SSL forward proxy feature. Use this method when the server private
key method is not practical (for example, for traffic to servers on the WWW).
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NOTE: If you enable both methods, the IDP Series device performs SSL inspection
using the SSL forward proxy method and does not use the server private keys.

The following procedure provides the basic steps you take to implement the SSL
forward proxy feature.
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To implement the SSL forward proxy feature:

1. From the IDP Series device command-line interface:

a. Generate the root certificate authority (CA) that the IDP Series device uses
to create and sign new certificates used in SSL proxy operations. The
following example creates a root CA:

[root@defaulthost admin]# scio ssl ca create US CA Sunnyvale 'Juniper
Networks Inc.' 'SSL Inspection policy' 'Juniper IT Services'
'admin@juniper.net' 1024

NOTE: The system prompts the end user to install the CA you create in this step.
Take care to configure an organization name that an end user is likely to accept,
such as your company name.

b. Verify the CA was added:

[root@defaulthost admin]# scio ssl ca show

serial=8E0012848A2D7CCD
subject= /C=US/ST=CA/L=Sunnyvale/O=Juniper Networks Inc./OU=SSL Inspection
policy/CN=Juniper IT Services/emailAddress=admin@juniper.net
issuer= /C=US/ST=CA/L=Sunnyvale/O=Juniper Networks Inc./OU=SSL Inspection
policy/CN=Juniper IT Services/emailAddress=admin@juniper.net
notBefore=Jun 25 22:13:23 2009 GMT
notAfter=Jun 23 22:13:23 2019 GMT

c. (Optional) Distribute the CA to your users and have them install the CA in
their Web browser.

The following example prints to the screen the CA in PEM format. You can
copy this text to a file that your users can import into their browsers.

[root@defaulthost admin]# scio ssl ca export

-----BEGIN CERTIFICATE----------END CERTIFICATE-----
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2. In NSM:

a. Add IDP rulebase rules that target HTTPS traffic:

■ Match traffic flowing in the client-to-server direction.

■ Be sure to account for HTTPS over nonstandard ports. The application
identification feature is not applied when the IDP Series device proxies
an SSL session.

■ Include attack objects to inspect both the SSL session and the HTTP
payload.

TIP: You must include at least one SSL attack object. We recommend you include
the SSL: SERVR-CERT-FAILS-VALIDATION anomaly to detect invalid certificates (that
is, certificates signed by an unknown CA or that cannot be validated against the
issuer CA). An invalid certificate might indicate a phishing attack. You can drop or
log matching sessions.

■ Specify action and notification options.

b. Push the updated security policy to the IDP appliance.

c. Review logs to verify the feature operates as you expect.

Related Topics The following related topic is included in the IDP Concepts and Examples Guide:

■ Inspection of SSL Traffic Overview on page 165

The following related topics are included in the IDP Administration Guide:

■ Using the SSL Private Server Key to Enable Inspection of SSL Traffic

■ scio ssl

■ scio const

Example: Exempting Outbound SSL Traffic from Inspection

The privacy policy for your business might include cases where sessions should
remain encrypted throughout. For example, suppose you have an agreement with
your users that your network security infrastructure will not interfere with SSL
encrypted connections to banking sites. In these cases, you can create a whitelist of
destination domain names, IP addresses, and subnets you want exempted from IDP
policy inspection. If a server is included in the whitelist, the IDP system does not
decrypt the traffic or inspect it. Instead, this traffic is passed through the IDP appliance
uninspected.
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NOTE: The whitelist applies only to traffic processing based on the SSL forward proxy
feature. You would not use a whitelist to exclude inspection of traffic to internal
destination servers. If desired, you can use a security policy rule to exempt such
traffic from inspection.

The following example shows the format of a whitelist file:

10.0.0.1
1.0.0.0/8
70.34.21.82
trustedsite.com
landing.trustedsearch.com

Each line in the whitelist file specifies the IP address or domain name for a destination
server. To whitelist multiple sites with one entry, you can use an IP prefix to match
address blocks and a domain suffix to include all subdomains.

The domain name in your whitelist should match the common name (CN) entry in
the certificate presented by the destination server. For example, suppose the
certificate for the E-Trade HTTPS server contains the following subject:

C=US, ST=Georgia, L=Alpharetta, O=ETRADE FINANCIAL CORPORATION,
OU=Global Information Security, CN=us.etrade.com

You can whitelist this site by adding the string us.etrade.com or the string etrade.com
to your whitelist file.

In most cases, the CN entry in the server certificate for a website matches the server
name that appears in the browser address bar. In some cases, there are differences.
You can use the features of your Web browser to find the CN entry in the server
certificate for the website.

Figure 54 on page 174 shows the location of the certificate details in Firefox.
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Figure 54: Firefox: Displaying the Server Certificate for a Website

Figure 55 on page 175 shows the location of the certificate details in Internet Explorer.
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Figure 55: Internet Explorer: Displaying the Server Certificate for a Website

To implement a whitelist:

1. Log into the CLI as admin and enter su - to switch to root.
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2. Use an editor like vi to create a whitelist file. A whitelist file should contain the
IP address prefixes and/or domain name suffixes you want to exempt from
inspection. For example:

[root@defaulthost admin]# vi /tmp/whitelist.txt

e-trade.com
bankofamerica.com

3. Run the following command to import the whitelist entries:

[root@defaulthost admin]# scio ssl whitelist import /tmp/whitelist.txt

NOTE: To update the active whitelist, import an updated whitelist file. To clear the
whitelist, import a file that contains only one empty line.

Related Topics The following related topic is included in the IDP Concepts and Examples Guide:

■ Inspection of SSL Traffic Overview on page 165

The following related topic is included in the IDP Administration Guide:

■ scio ssl
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Chapter 20

Deploying IDP Series Appliances in a
Coordinated Threat Control Solution

This chapter provides an overview of the role of IDP Series appliances in a Juniper
Networks coordinated threat control solution. It includes the following topics:

■ Coordinated Threat Control Overview on page 177

■ Deploying IDP Series and SA Series Appliances for Coordinated Threat
Control on page 177

Coordinated Threat Control Overview

The Juniper Networks coordinated threat control solution requires deployment of
both IDP Series and SA Series SSL VPN appliances.

When the IDP Series appliance detects a security event (be it a threat or any traffic
that breaks an administrator configured policy), it can, in addition to blocking that
threat, signal the SA Series appliance in real time.

The SA Series appliance then uses the information from the IDP Series appliance to
identify the user session that is the source of the undesired traffic. It can take
appropriate actions on the endpoint, such as notifying the administrator, terminating
the user session, disabling the user account, or mapping the user to a quarantine
role.

Administrators can configure the quarantine role to provide users with a lower level
of access and inform them why they have been quarantined and what they should
do next. During remediation, administrators can enforce additional endpoint security
checks or push additional endpoint protection software.

Related Topics The following related topic is included in the IDP Concepts and Examples Guide:

■ Deploying IDP Series and SA Series Appliances for Coordinated Threat Control
on page 177

Deploying IDP Series and SA Series Appliances for Coordinated Threat Control

In a coordinated threat control deployment, Juniper Networks devices communicate
using Transport Layer Security (TLS). On the Juniper Networks SA Series SSL VPN
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appliance, you configure settings for the connection with the IDP Series appliance,
including a one-time password generated by the IDP Series appliance.

Figure 56 on page 178 shows a split deployment, where the SA Series appliance has
been deployed for extended enterprise access and the IDP Series appliance for
security for all perimeter traffic including, but not limited to, the traffic coming from
the SA Series appliance.

Figure 56: Coordinated Threat Control Deployment Diagram: Split Deployment

Figure 57 on page 178 shows an internal deployment, where only encrypted SSL traffic
terminated at the SA Series appliance has access to the protected network and the
IDP Series appliance is deployed to inspect only traffic coming through the SA Series
appliance.

Figure 57: Coordinated Threat Control Deployment Diagram: Internal Deployment

For information on configuring an SA Series appliance to communicate with the IDP
Series appliance, see the SA Series appliance documentation.

Related Topics The following related topic is included in the IDP Concepts and Examples Guide:

■ Coordinated Threat Control Overview on page 177

The following related topic is included in the IDP Administration Guide:

■ Generating a One-Time Password for Communication with SA Series SSL VPN
and IC Series Unified Access Control Appliances (ACM Procedure)
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Chapter 21

Deploying a User-Role-Based Policy
Solution

This chapter explains how to deploy IDP Series and Juniper Networks IC Series Unified
Access Control (UAC) appliances to implement user-role-based policies. It includes
the following topics:

■ Understanding Communication Between IDP Series and IC Series
Appliances on page 179

Understanding Communication Between IDP Series and IC Series Appliances

Figure 58 on page 180 illustrates the communication between IDP Series and IC Series
appliances.
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Figure 58: Communication Among User-Role-Based Policy Components

We assume you have configured communication between the IC Series appliance
and NSM and between the IC Series appliance and the IDP Series appliance. The IC
Series sends user role information to the NSM via the IC Series — NSM connection.

When an endpoint client authenticates to the network through the IC Series appliance,
the IC Series appliance assigns a role to the authenticated user and sends session
information to the IDP appliance. Session information includes IP address, username,
and the roles to which the user is assigned:

If the user IP address changes, user role changes, or the session is deleted, the IC
Series appliance sends updates, and the IDP Series appliance updates its session
table.

You use NSM to configure policy rules that match user roles and then push the policy
from NSM to the IDP appliance.

When the user traffic traverses a network segment where the IDP Series appliance
is deployed, the IDP system inspects the session to see if there is a match. The IDP
system looks up the IP address in the session table to see if the IP address is a match
for any role. If any role matches, the IDP system uses the role and other matching
criteria to attempt to match user-role-based rules. If no user-role-based rule matches,
the IDP system attempts to match the IP address-based rules.
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If you have enabled logging, the IDP Series appliance sends logs to both the IC Series
appliance and NSM.

Related Topics The following related topic is included in the IDP Concepts and Examples Guide:

■ User-Role-Based Policy Feature Overview on page 94
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Part 5

Index

■ Index on page 185

Index ■ 183
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